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Note: Authors notified of unanimity, and reviews not in order (3 external to USFWS (Joshua Schmidt, 
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3/26/14 – Protocol revision received from authors. 
 
4/22/2014 – Final decision (accepted). 
 
 
 
Letter From Dr. Harris: 
 
22 April 2014 
 
Dear Dr. Butler: 
 
I have carefully reviewed the “Whooping Crane Winter Abundance Survey Protocol” and the response to 
reviewers.  Clearly, the reviewer comments were addressed thoroughly.  By doing so, this protocol 
revision has improved in content and clarity. 
 
The work done by you and the co-authors is much appreciated by the United States Fish and Wildlife 
Service, and will advance the understanding and conservation of this whooping crane population. 
 
Please consider this protocol accepted and finalized. 
 
Regards, 
 
 
Grant Harris 
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Letter to Dr. Harris: 
 
26 March 2014 
 
Dear Dr. Harris, 
 
We have completed revision of the Inventory and Monitory protocol entitled “Whooping Crane Winter 
Abundance Survey Protocol”.  Below we have attached the reviews and our response to questions, edits, 
or suggestions raised by each of the Reviewers.  All comments from the reviewer have been addressed 
in this document (see blue text) or within the protocol. 
 
We have included some R code in appropriate places to help demonstrate analyses (see Reviewer 1, 
comment 2) or support simulation efforts to better demonstrate the behavior of Generalized HDS 
models (see Reviewer 2, comment 14).  The R code throughout this rebuttal is in Lucida Console font. 
 
We believe this critique has helped us craft a better protocol.  We appreciate and thank each Reviewer 
for their time and effort. 
 
Sincerely, 
 
 
Matthew J. Butler 
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Letter From Dr. Harris: 
 
23 September 2013 
 
Dear Dr. Butler: 
 
I have received 3 external reviews and 2 internal reviews of your protocol titled “Wintering Whooping 
Crane Abundance Survey”.  All Reviewers identified points worth addressing in a revision.  Notably, I 
think more effort could be placed on the following: 
 


1) Further justification and description regarding implementation of the distance sampling 
technique. 


 
We have provided a new section in Element 1 entitled “Justification of objectives.”  We have 
also provided additional discussion of the distance sampling technique throughout the protocol 
in appropriate places. 


 
2) Reducing some discussion of the former method, keeping only the salient deficiencies; namely 


those necessary to describe why a revision and new approach was required. 
 
Some description and critique of the traditional survey technique is all we provided (i.e., less 
than 4 pages of a document containing over 150 pages).  As we began addressing the Reviewers’ 
comments, we have begun to wonder if we spent enough time critiquing the traditional 
technique since many of the Reviewers’ comments have highlighted their misunderstanding of 
the traditional technique which further emphasizes the need for critiquing it (we point out each 
of those comments below).  Many of the Reviewers revealed several misconceptions about the 
traditional technique.  Therefore, we have chosen to include the description and critique of the 
traditional survey technique.  In a few cases we had to expand the critique to address some of 
the Reviewers’ questions (e.g., misconceptions about the enumeration of mortalities during the 
traditional surveys). 
 


3) Please increase size of text in Figure 1. 
 
We have made all map-based figures larger (e.g., Figs. 1, 5, 6, and 8).  Originally these figures 
were only 4.5 inches wide but now they are 6.5 inches wide.  We are unable to increase the font 
size associated with the background layers within these figures because those fonts are 
embedded as part of a basemap in ArcGIS.  However, by increasing the size of the figures, the 
text is much larger.  After increasing the size of the map-based figures, we decided to increase 
the size of all figures. 


 
Reviewers provided general and specific comments.  Please respond to each line by line, and identify 
where you modified the protocol as/if necessary. 
 
Below we address all comments from the Reviewers in blue and note the section in the protocol in 
which changes (if necessary) were made. 
 
Once this document and revised protocol are returned, I will evaluate your responses and revision.  At 
that point, the protocol may be declined, accepted or further reviews sought. 
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Sincerely, 
 
Grant Harris 
Chief Biological Sciences 
United States Fish and Wildlife Service, Region 2 
Albuquerque, NM 87103 
 
 
 
REVIEWER #1: 
 
Overall, this is a much-needed, thorough and excellent upgrade to the survey methods for whoopers at 
Aransas.  I am impressed with the amount of effort and thoughtfulness evident in this review draft. 
 
Thank you for your thoughtful review; we value your comments and appreciate your efforts.  We want 
to note upfront that this survey extends well beyond the borders of Aransas National Wildlife Refuge 
and covers over 1,200 km2 of the winter grounds.  There seems to be a misunderstanding that whooping 
crane ostensibly overwinter only on Aransas National Wildlife Refuge.  However, 55.3% of new primary 
sampling frame covers areas beyond the boundaries of Aransas National Wildlife Refuge.  We have 
included the boundaries of Aransas NWR in Figure 6 to help illustrate this point. 
 
General comments: 
 
1. Too much time spent critiquing the former survey method; this is evident in the description multiple 


times of the new methods as “defensible”, “scientific”, etc. 
 


We felt it important to make clear that the new technique is “defensible” and “scientific.”  The 
previous methods were not, hence the need for this protocol.  We have removed some of this 
language as it was repetitive. 


 
Some description of the deficiencies is needed, as a platform for describing this method which will 
improve upon it, but the important point is the demonstrating the features, validity and benefits of 
the proposed method. 


 
Some description and critique of the traditional survey technique is all we provided (i.e., less than 4 
pages of a document containing over 150 pages).  As we began addressing the Reviewers’ 
comments, we have begun to wonder if we spent enough time critiquing the traditional technique 
since many of this Reviewers’ comments have supported the need for critiquing the traditional 
survey technique (there seems to be much misunderstanding about it).  We point out each of those 
comments below.  Other Reviewers had similar misconceptions about the traditional survey 
technique.  Therefore, we have chosen to include the description and critique of the traditional 
survey technique as was originally included in the protocol.  In addition, we have had to include 
some more information to dispel misconceptions about the enumeration of mortalities during the 
traditional surveys. 


 
2. Related to (1), is the need to use the numbers derived from the former methods as we go forward 


with the conservation of whooping cranes.  So those numbers cannot be described as useless, and 
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indeed they are useful (just not useful enough).  A section is needed somewhere on how the data 
from the new methods can be compared properly to the numbers from the former methods. 


 
We have never described the estimates derived from the traditional survey technique as useless and 
in fact we have used them to help better understand the dynamics of this population (see Butler et 
al. 2013).  We undertook revision of the survey because the traditional technique needed 
improvements because 1) it was not repeatable and lacked standardization, 2) it provided no 
description of the uncertainty of abundance estimates, and 3) it was contingent upon an assumed 
ability to uniquely identify unmarked individual whooping cranes.  Since the traditional estimates 
were not provided with SEs nor can those SEs be calculated, all one can do to compare new 
estimates with the old estimates is to continue to assume the old technique produced a complete 
census.  We understand this is unsatisfactory, but there was no way to replicate the traditional 
technique with new observers to create some sort of correction factor. 
 
Since the abundance estimates from the traditional technique have always be treated as if they are 
exact counts and unfortunately will likely continue to be treated that way, comparison between 
estimates from the two techniques is conceptually simple.  For example, in 2010, the traditional 
estimate was 283 whooping cranes.  In 2011, the new technique resulted in an estimate of 254 
whooping cranes (0.126 CV).  A simple z-test can be used to test if the 2011 estimate is different 
from the 2010 estimate (z = –0.906, p = 0.182; pnorm((254-283)/(254*0.126))).  However, since 
we do not know how whooping cranes outside of the sampling frame were incorporated into the 
traditional survey technique, comparison with the new technique may be problematic since the new 
technique only applies to the primary sampling frame. 
 
Finally, if we continue to assume the traditional technique produced exact abundances, then for 
trend analysis, weighted regression would be appropriate (Gerrodette 1991).  The weights used 
would be the inverse of variance estimate for each abundance estimate; for the estimates from the 
traditional technique, 1 would be used as the weight (assuming no uncertainty in traditional 
estimates).  Of course this makes many uncomfortable, but how else can uncertainty about the past 
estimate be incorporated when uncertainty was not quantified.  Perhaps, assuming no uncertainty 
in the traditional estimates is a poor assumption but we have no other estimate of the uncertainty.  
We could be more conservative, and give them less weight by assuming a CV of 15% or some other 
value, but that would be an arbitrary decision. 


 
3. Figures are excellent; very helpful (although Fig 1 would be better larger…). 
 


Thank you, we strove to provide useful figures that described the issues.  We have made all map-
based figures larger (e.g., Figs. 1, 5, 6, and 8).  Originally these figures were only 4.5 inches wide but 
now they are 6.5 inches wide.  We are unable to increase the font size associated with the 
background layers within these figures because those fonts are embedded as part of a basemap in 
ArcGIS.  After increasing the size of the map-based figures, we decided to increase the size of all the 
figures in the protocol. 


 
4. A couple of references were made to later revisions of the protocol; did I miss a calendar for 


revision?  
 


We considered including a calendar for protocol revision but decided protocol revision should occur 
on an “as needed basis” as recommended in the Survey Protocol Handbook (U.S. Fish and Wildlife 
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Service 2013).  We added some additional description of the revision process to the “Revision 
History” section. 


 
Related to that there are likely to be practical limitations on carrying out some of the specifics; those 
kind of could/should be changed before the date of a more complete revision. 


 
We are unsure what “practical limitation” is being referred to.  The protocol, as it is currently 
designed, can be carried out as planned.  It would be poor design on our part if the protocol could 
not be implemented in the field. 


 
5. Definition of transect; it seems to be used as both the flight path of the aircraft and the width of 


territory sampled by the flights: choose one, define it and stick to it (I suggest the width of territory 
sampled…). 
 
Just as with any other line-transect based survey, the transects are the lines from which the survey 
is conducted.  The transects are fixed-width strip transects.  Therefore, the transect refers both to 
the line and the 500-m strip on either side of the line.  It is very much appropriate to use the word 
transect for the flight path or the strip around the flight path.  We defined the transect in “Element 
3, Sampling units” section and “Element 3, Transect spacing”.  The transect is the flight-path and the 
survey area is a fixed-width around each transect.  The transect configuration is independent of 
whooping crane territories. 


 
Specific comments: 
 
1. P2, L19 – I was under the impression that the flight paths were a more consistent distance apart… 
 


Though erroneously so, apparently many were under the impression that flight paths were closer 
together and more consistent during the traditional survey.  Perhaps this was because Stehn and 
Taylor (2008) reported that transects were spaced 400 to 500 m apart.  However, GPS track data 
from the 2010 surveys indicated transect spacing varied between 250 to 800 m.  Unfortunately, no 
GPS track data were saved by observers during the previous years.  The traditional surveys were 
much less systematic than portrayed in Stehn and Taylor (2008) and were more targeted to areas 
known to be occupied by whooping cranes.  We believe this is a good example of why we needed to 
critique the traditional survey technique. 


 
2. P2, L24 – define briefly ‘survey blocks’ in this sentence. 
 


We have changed the sentence to read:  “Survey duration was typically between 5–6 hours with a 
rest break approximately half-way through the survey during which the flight crew returned to the 
Aransas County Airport.”  We see no reason to define the concept of a survey block at this point 
since the traditional technique did not have survey blocks delineated and defined as the new 
technique does. 


 
3. P4, L35 – consider deleting this; I suspect that Tom could identify many of the cranes. 
 


The statement in question is “The observer assumed ability to uniquely identify unmarked individual 
whooping cranes.”  It is true the observer assumed he had this ability though he provided no 
evidence that he could.  We consider an assumed ability to identify unmarked birds without any 
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uniquely identifying characteristics untenable.  In our professional experience, defensible 
identification of free-ranging individuals requires the use of unique markers.  While some believe 
that Tom Stehn could consistently identify unmarked whooping cranes there are no data available 
to support this belief.  As such, we feel our comment is accurate.  This forms another good example 
of why we needed to critique the traditional survey technique. 


 
4. P4, L39 – is there a citation for this detection function, in another birds or situation? 
 


On this line we stated that “group size was likely positively related to the probability of detection.”  
Size-biased detection is very common in these types of surveys and has been noted in many species, 
both birds and mammals.  We have provided some citations where detection probability was related 
to group size. 


 
5. P4, L42 and L43 – are you sure this is true, at the transect width that was used formerly?  I was 


under the impression that the transect width was narrow enough that detection did not vary across 
it… maybe not. 


 
Yes, we are sure this is true.  See Strobel and Butler (2014) for detailed analysis of detection 
probabilities from the traditional survey technique.  They show that detection probability of a 
whooping crane group within 500 m of the survey line was 0.558 (SE = 0.031).  We summarized 
these results in “Element 2, Winter 2010–2011 surveys” section.  Even if the traditional survey 
technique used 400 m wide transects (200-m half-width), detection probability was still less than 
1.0.  The detection function in Strobel and Butler (2014) shows that the detection probability within 
200 m of the survey line was 0.69.  Narrowing the transect does not ensure complete detection.  
Again, this emphasizes the need for critiquing the traditional survey technique. 


 
6. P5, L21 – define ‘surveyed area’, or refer to the later section where it is defined, and precision is a 


VERY important aspect of this or any survey; a review of the justification of “...enough  precision to 
detect a 10-15% decline over 3 years” is needed, and probably warrants a separate section;  I am not 
sure that is adequate (although it may be all that is practical), but I could be convinced; I am sure 
that some on the WCRT will object to that criterion as too lax, and I am also sure that there is a 
decidedly false and overblown sense of precision in the numbers form the current methods.  This 
issue needs to be met head on, and can be discussed usefully with reference to the costs outlined 
later in the document. 


 
We added a reference to the later section for the “survey area.” 


 
We added a new section to summarize the justifications provided in Butler et al. (2013) for 
developing a survey with enough precision to detect a 10–15% annual population decline over 3- to 
4-year period.  See new section, “Justification of objectives” in Element 1. 


 
We agree that “there is a decidedly false and overblown sense of precision in the numbers form 
the” traditional technique.  That is why we believe the critique of the traditional technique is so 
important.  We do not think there is an overblown sense of precision with the new technique.  Early 
on precision has been lower than we wanted (12% to 19% CV) but now that all the kinks have been 
worked out of the protocol, we expect better precision from future surveys (see discussion of 
Internal Reviewer #2’s general comment #2). 
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7. P5, L24 – I realize you don’t want to imply breeding pair, or any other biological interpretation to 
these associations, so create operational definitions of paired birds, and recruitive pairs (an 
awkward term), and leave out the quotes. 


 
An operational definition was already provided parenthetically after each term.  We removed the 
quotes from these two terms. 


 
8. P9, L6 – good section: what about the type of aircraft (airspeed, nose, comfort, etc.) 
 


We have added some additional information about the type of aircraft required for this protocol to 
“Element 4, Aircraft type” section.  Aircraft speed is specified in “Element 4, Field data collection 
methods” section and was based on the traditional survey technique. 


 
9. P11 – very nice table and figure. 
 


Thank you.  We have made all the map-based figures larger. 
 


10. P12, L8 – here might be a place to indicate how the data collected with this new method will or 
should be compared to past numbers… 


 
See response to Reviewer’s general comment #2.  We have added a note about comparison of 
estimates from the two techniques to “Element 3, Comparison with estimates from the traditional 
technique.” 


 
11. P12, L22 – do you mean PSF…? 
 


The sentence in question is “Eventually, additional areas will need to be added to the SSF as the 
population expands.”  We do not mean PSF, we mean SSF.  The SSF regions will be promoted into 
the PSF when criteria outlined in “Element 3, Sampling frame” section are met.  Then new regions 
will be added to the SSF once SSF regions are promoted to PSF regions.  We reworded this sentence 
to clarify: “As SSF regions are promoted into the PSF as the population expands, additional areas will 
need to be added to the SSF.” 


 
12. P12, L21 and L22 – also should use anecdotal information to add areas for formal survey 


(secondary); one does not want the methods designed to survey birds where they are now, to 
constrain the places one looks for cranes as they expand: the birds may get to very different areas 
(this applies to the habitat modeling efforts too, probably more so). 


 
We speak to this in the “Element 3, Sampling frame” section.  “Because the Aransas-Wood Buffalo 
population is growing at ≈4% per year, we will address how to add more SSF regions when this 
monitoring plan is due for revision.  For example, the spatially-explicit models of habitat use could 
be used to predict areas composed of the best potential habitat.”  We did not suggest other 
anecdotal information could potentially be used as well so we have added this sentence.  “Ancillary 
information gained from internal and external sources (e.g., fortuitous public or staff observations; 
Texas Whooper Watch) could potentially be used to identify new SSF regions as well.” 


 
13. P13, L18 – I suggest the numbering/lettering system go from the shore north: it is easier to add 


survey regions/blocks which will probably be inland. 
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Survey blocks are lettered with the survey blocks initials (i.e., Blackjack Peninsula is labeled with BJ).  
Since there is no plan to add additional transects to specific survey blocks but instead add new 
survey blocks as the population expands then we see no reason to change the way in which transect 
are numbered within a survey block.  Besides, since all survey information is now spatially explicit 
unlike before, we can simply add new transects as needed and renumber them appropriately.  Since 
all the transects are displayed on the computer during the survey, renumbering them if additional 
transects were added would not cause confusion. 


 
14. P13, L30 – the term peak abundance is a very poor one, and should be discarded in favor one 


without interpretation imbedded in it; I am very interested in what the greatest number of birds at 
Aransas may be, but there may be/are many opinions on how to get that number; it is interesting 
that numbers from past survey methods are the highest in Dec, but that might not be the case with 
the new method; better might be to define the period intense survey with reference to the dates of 
migration (it might be some function of departure date, arrival dates, etc.); this would allow the 
dates of intensive surveys to vary with the birds; I can imagine that seasonal differences may alter 
the date of ‘peak abundance’ and indeed climate change may well alter the phenology of crane 
migrations over the years; call it the “early resident period”?? 


 
We agree that the peak abundance term may be imbedded with too much interpretation and have 
removed it from the protocol.  There is no reason to expect this method to result in higher 
abundance later in the winter.  To ensure comparability from one year to the next, surveys need to 
be conducted during the same time period.  To facilitate comparison with the traditional technique, 
which aimed to provide estimates of “peak” abundance (i.e., abundance post fall-migration prior to 
any winter mortality), then December is the most appropriate time period. 
 
We know of no way to rigorously tie survey timing to anecdotal observations of migration 
phenology.  Based on the historic data, we felt that surveys probably could begin either the second 
or third week of November.  However, we delayed starting surveys until December just in case 
migration was delayed some years.  We agree that if we see that migration is delayed in a particular 
year, then we as program managers need to delay surveys a little while for that year.  In fact, that is 
part of the reason we allowed surveys to be conducted anytime during a 1-month period (as long as 
they are blocked together into a 2-week window).  If a trend of later migration dates becomes 
apparent, then of course we would need to re-evaluate the survey dates for future surveys. 


 
15. P14, L28 – I can well imagine (but do not know firsthand) that habitat use will vary thought the 


season, and especially for the birds of the year; hence spatially explicit models relevant to Feb-Mar 
might be very revealing. 


 
We agree that the spatially-explicit models of abundance might provide interesting insights into 
whooping crane habitat use during different periods of the winter.  That is why we have provided a 
mechanism for developing such models during the secondary survey periods if the Refuge or 
stakeholders chooses to pursue surveys during January, February, or March.  However, as outlined 
in “Element 3, Survey timing,” surveys conducted during the secondary periods are optional and will 
only occur if clear objectives are identified by the stakeholders.  We do not consider a passing 
curiosity about changes in habitat use through time a clear enough objective.  Frankly, there are 
much better ways to understand temporal trends in habitat use such as satellite-telemetry. 
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16. P16, L3 – see general comment (4) above. 
 


See our response above concerning revisions of the protocol. 
 
17. P17, L15 – very interesting…. And relevant to the discussion about precision, etc.;  the numbers at 


Aransas can help us learn about life history during migration south, as well as help inform 
management needs at Aransas proper. 


 
Actually, the numbers at Aransas cannot inform us about life history during the southern migration 
because little information is available from the flock during the breeding season.  Assuming the 
precision of estimates is tight enough, the work in Butler et al. (2013) shows that biennial 
monitoring would likely provide the information necessary to detect the kind of declines that would 
cause significant delays in time to recovery.  But moreover, the discussion in Nicol and Chadès 
(2012) really reveals intensive monitoring when the policy decisions regarding downlisting are 
imminent is most important but other times are much less relevant. 


 
18. P17, L31 – Unclear: is the TESC too coarse grained? 
 


It depends on the question one wants to ask of the data.  If we wished to determine how whooping 
crane abundance responds to varying densities of blue crab across the landscape, then of course the 
TESC vegetation map is inappropriate.  However, if all we wish to characterize is how whooping 
cranes distribute themselves among saltmarsh and upland habitats, then the TESC vegetation map is 
appropriate.  So all we were trying to convey is that the spatial layer used in the analysis must be 
compatible with the question being asked.  We find this idea is outlined clearly in the following 
paragraph from “Element 3, Environmental covariates” section of the protocol: 


 
“Hierarchical distance sampling results in spatially-explicit models of abundance that explicitly 
consider relationships between population density and environmental covariates while controlling 
for detectability (Royle et al. 2004, Chandler et al. 2011, Sillet et al. 2012).  Currently, environmental 
covariates are derived from the Texas Ecological Systems Classification Project 
(http://www.tpwd.state.tx.us/gis/gallery/), Phase 3 (Ludeke et al. 2012; Appendix E).  The percent of 
each 1-km2 transect segment is determined for 6 general vegetation types: saltmarsh, open water, 
wetland, saltmarsh-shrubland, upland, and urban (Appendix E).  Though these covariates are only 
rudimentary, strong relationships with whooping crane abundance has been demonstrated with 
some of them (Strobel et al. 2012).  As managers, biologists, and policy makers begin to recognize 
the value and potential of spatially-explicit models of resource use and develop more detailed 
hypotheses about whooping resource use, specific resource maps can be tailored to answer more 
specific management or policy questions.  Maps from which environmental covariates are derived 
will need to be periodically updated with the most current data.” 


 
We also note in “Element 4, Environmental covariates” section of the protocol: 
 
“As additional maps of vegetation layers, other whooping crane resources (i.e., salinity, blue crab 
abundance, etc.), or management actions (i.e., time since prescribed burn, fresh water provisioning, 
etc.) become available and more detailed hypotheses of whooping crane abundance relationships 
are developed, additional environmental covariates will be derived and incorporated into the 
hierarchical models of abundance.” 
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19. P18, L19 – good; can an ID test be developed like is done for BBS observers?  This would be useful.  
BTW, the emphasis on training and practice (later section) is excellent, but should be strengthened:  
you might consider requiring practice using the computer recording method, coordinating with the 
other observer (I like the idea of practice in a car..), and with identification; the BBS has shown very 
clearly how much difference experience, and hence training means to the quality of the data. 


 
We like the idea of an ID test but currently have no plans to implement such a test.  We believe the 
training requirement that new observers must participate as a non-observer in the fourth seat of the 
aircraft during a minimum of 3 surveys is adequate training. 


 
We strengthened the language about practicing using the equipment from an automobile.  Staff 
have implemented this practice session prior to beginning the surveys each year. 


 
20. P19, L17 – is there detection variability by habitat of HY birds?  (white birds are a bit easier..) 
 


There is likely some detection variability by habitat for all whooping cranes not just juveniles.  
However, as indicated in the section in question, groups with juvenile birds will have slightly higher 
detection probability than groups without juveniles simply because those groups with juveniles are 
larger groups. 


 
21. P19, L36 – yes, good; and keep in mind that we have been consistently surprised by the habitat 


selection of the re-introduced whopping cranes, so as they expand in S. Texas, I now expect cranes 
in unexpected locations. 


 
Agreed, we already have seen unusual habitat selection as this population has grown (e.g., Granger 
Lake).  By the way, we included a section in Appendix C entitled “More on prediction” that discusses 
prediction beyond the bounds of inference and possible uses of those predictions. 


 
 
 
REVIWER #2: 
 
General comments: 
 
1. While I agree there is a potential for bias in the past estimates, the intensity and frequency of the 


surveys, combined with the small population size (with a large number marked during many years), 
suggests that the max estimates are probably pretty close to the true number of individuals, or at 
least a very good index.  The relatively low annual variability in the estimates (Fig 2, page 3) suggests 
that this is the case.  A poor index would result in a more ‘jagged’ graph due to sampling error. 


 
Unfortunately this Reviewer has little knowledge of the past intensity and frequency of the 
traditional surveys.  No one but the previous observers even knew the intensity (i.e., what areas 
were surveyed) of their surveys since only information about detections were recorded (i.e., past 
observers did not record where they surveyed and did not detect birds).  Further, the frequency of 
the traditional survey varied widely.  The number of surveys conducted between December 1st and 
March 31st per year varied from 4 to 21 (mean = 12.7, SD = 4.2) indicating little consistency in survey 
effort from year to year (Butler et al. in prep). 
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Wild whooping cranes were not individually marked until 1975.  In fact, only 132 marked birds have 
been in the population spanning the period of 1977 through 2004 (Gil-Weir et al. 2012).  There were 
not “a large number of marked birds during many years.”  Sure, nearly 60% of birds were marked 
during winter 1988–1989 (Stehn 2004) but the proportion of marked cranes was typically much 
lower.  Over 40% of the years in which the traditional survey was conducted (1950–2011), no color 
marked birds were in the population.  By the winter of 2010–2011, only 7.8% of the flock was 
marked (Stehn 2011).  It is also important to note that many of the banded cranes were not marked 
with uniquely identifiable color marks but with aluminum bands (Stehn 2011). 


 
It seems that this Reviewer misunderstood the point of figure 2.  Figure 2 shows how the traditional 
technique somehow resulted in an estimate that was often greater than the maximum number of 
birds observed but sometimes resulted in an estimate that was smaller than the maximum number 
of birds observed.  This is disconcerting.  If the observer observed 100 birds on a survey but only 
reported an estimate of 97 birds, we wonder what happened to those 3 birds.  As we noted in the 
protocol, “this inconsistency may be attributed to the observer’s interpretation or perception of 
double counts.  However, we cannot know…since rules governing how data from separate surveys 
were combined or how public reports of whooping cranes from outside of the ‘censused’ area were 
incorporated was largely determined by the observer’s opinion.”  We have developed this protocol 
to get away from a technique largely based on expert opinion and experience to something that can 
be replicated by staff that do not have many years of experience working on the species.  As current 
staff move on to new jobs, we now have a technique that can be replicated by anyone. 


 
Fundamental problems with the traditional technique can be illustrated easily.  For example during 
the winter of 2008–2009, the traditional technique reported 270 birds on the wintering grounds 
with 23 of them dying during the winter.  During the winter of 2009–2010, the population was 
reported to be 264 birds with 22 juveniles which would mean there were 242 adults in the 
population.  However, the maximum count during the winter 2009–2010 was 270 birds which would 
presumably mean there were 248 adults in the population.  If 23 mortalities occurred during the 
winter of 2008–2009, there could only be 247 adults in the population during the winter of 2009–
2010 (270–23=247; assuming no mortality during other parts of the year).  Where did that extra 
adult come from?  Did the maximum count of 270 during the winter of 2009–2010 include 6 birds 
that were counted twice?  Was mortality during the breeding- and migration-periods only 2% ( 
(247–242)/247 )?  This is an illustration of the fundamental danger of a technique that portends to 
deal in absolute truth when there is really much uncertainty in the estimates. 


 
2. I wonder if the approaches described in these 2 papers would be more appropriate for the existing 


and future whooping crane data since the cranes appear to be territorial on the wintering grounds? 
 


Chandler, R.B. and J.A. Royle.  Spatially explicit models for inference about density in unmarked or 
partially marked populations.  Annals of Applied Statistics 7:936-954. 


 
Sollman et al.  2013.  Using multiple data sources provides density estimates for endangered Florida 
panther.  Journal of Applied Ecology DOI: 10.1111/1365-2664.12098 


 
Particularly with a partially marked population, you could employ these methods across all the 
historic data to produce corrected density estimates (assuming the field maps/data are still 
available?).  You could also then quantify the level of bias in past estimates and determine the 
amount of effort needed going forward.  A spatially explicit approach to density estimation may also 
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be useful for jointly addressing your habitat use objectives (e.g., Royle et al. 2013.  Spatial capture-
recapture models for jointly estimating population density and landscape connectivity.  Ecology 
94:287-294.)  These are just suggestions.  If there are reasons that distance sampling would be more 
appropriate or efficient than these newer methods, please provide additional explanation. 


 
Detecting and identifying color marks on whooping cranes from aerial surveys is a dangerous 
proposition requiring low level flights at low airspeeds (i.e., a landing-type approach; Stehn 2001).  
Mark-resight based techniques are not feasible from the fixed-wing aircraft platform.  Ground or 
boat based approaches might be possible.  However, undue disturbance from a close ground-level 
approach might bring undue stress on this highly endangered species. 


 
Finally, the presumption of territoriality does not induce some special ability to identify unmarked 
individuals.  We will not assume we have the ability to identify unmarked birds as was done by the 
previous observers.  Also, unfortunately, little of the raw data from the traditional technique is still 
available (hence the need to standardize the technique and provide for data archiving as this 
protocol does). 


 
3. Although a distance sampling approach would theoretically work, I am unsure that it would be much 


of a logistical improvement given the level of precision required to meet your stated objectives, the 
small population size, and the level of survey effort that would be required. 


 
We are unsure why this Reviewer suggests that distance sampling would not be much of an 
improvement over the traditional technique.  We have provided many reasons why the traditional 
technique was deficient including it was unstandardized, likely could not be repeated by new 
observers, and lacked formal measures of uncertainty.  The new technique provides a repeatable, 
standardized method that allows for rigorous statistical analysis.  Distance sampling is very 
appropriate for a transect-based aerial survey and frankly, we do not understand why such 
techniques were not implemented earlier.  As we note in the protocol, many robust techniques 
“have been available for decades.” 


 
If I understand your power analyses correctly, it appears that you would need to conduct 15-20 
surveys per year to meet your objective of detecting a 10-15% decline over 3 years?  Is that level of 
effort reasonable? 


 
As for the power analysis and justification of the objectives, we did not provide enough detail.  
Thank you for catching that.  Butler et al. (2013) identified scenarios that would significantly reduce 
abundance from the current trajectory and delay reaching the downlisting goal of 400 birds by >5 
years.  Those scenarios were >3 consecutive years of –9.5% annual decline or >2 consecutive years 
of –14% annual decline.  To estimate one growth rate, 2 years of abundance estimates are needed.  
Therefore, we need to be able to detected a –9.5% annual decline over a 4-year period or a –14% 
annual decline over a 3-year period.  We have now provided this information in the new section, 
“Justification of objectives” in Element 1.  We have also reworded the objective to better reflect 
this.  “Provide an estimate of whooping crane abundance within the surveyed area (see Element 3, 
Sampling frame) with enough precision to detect a 10–15% annual population decline over a 3- to 4-
year period (see justification provided in Butler et al. 2013).” 


 
To detect a –15% annual decline over a 3-year period, a CV of 6% is needed and to detect a –10% 
annual decline over a 4-year period, a CV of 9% is needed.  Based on the winter 2010–2011 pilot 
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work, we estimated 6 surveys would result in a CV of 7%.  Based on the surveys conducted during 
January 2012, we estimated 5 to 6 surveys would result in a CV of 9% and 10 to 13 would result in a 
CV of 6%.  We show a range in Table A1 because the number of surveys needed to reach a given CV 
depends on whether data are analyzed using HDS or CDS (see new note in Table A1).  We have also 
updated Table A1 with additional effort estimates.  We are recommending that at least 6 surveys be 
conducted (see “Element 3, Survey repetition and sample size” section); this does not mean more 
surveys cannot be conducted.  However, our experience suggests that 7 or 8 surveys per year is 
about the logistical limit that can be accomplished in the 2-week window. 


 
Note, that Butler et al. (2013) recommended being able to detect a –15% annual decline over a 2-
year period or a –10% annual decline over a 3-year period to allow enough time to respond to the 
scenarios.  This would require 4% to 6% CV which can be easily obtained by pooling data from 
multiple years as this Reviewer recommended in comment #20. 


 
However, realize that the scenarios outlined in Butler et al. (2013) have only occurred once in 73 
years of monitoring this population.  This population has grown at an average of 3.9% per year since 
winter 1938–1939, and has exhibited a 10-year cycle in population growth (Boyce and Miller 1985, 
Boyce 1986, Butler et al. 2013).  Therefore, a meaningful alternative to detecting the scenarios 
outlined in Butler et al. (2013) might be to detect a 3–5% annual decline over a 10-year period. 


 
It also seems that because you are covering the entire area, you would not be able to address 
temporary emigration, correct?  If I misunderstood these issues, please clarify. 


 
The Reviewer does misunderstand the appropriate use of the gdistsamp function in unmarked.  As 
long as complete detection on the line occurs, temporary emigration can be estimated.  If 
temporary emigration is not occurring, then incomplete detection on the line can be accounted for.  
However, if both temporary emigration and incomplete detection are occurring then the parameter 
φ is confounded and uninterpretable.  We discuss this issue in “Appendix C, A note about 
generalized HDS” and we address additional components of this Reviewer’s concerns about 
temporary emigration below. 


 
4. Overall, it seems like it would be worthwhile exploring the potential for utilizing both the mark-


resight information and the spatial location/territory information to adjust past estimates.  Going 
forward, I would expect that any method should utilize spatial location, knowledge of territories, 
and mark-resight of banded individuals to improve estimates.  Distance sampling could be used as 
one component of this process if the probability of detecting a bird given it was present and 
available was of particular interest, but it seems the gains in precision may be much greater if the 
rest of the available information were incorporated as well. 


 
We will not assume we have the ability to identify unmarked birds as was done by previous 
observers.  Some of the birds are marked in the population but we will not attempt risky flight 
procedures in an attempt to identify those marks from the air.  We like the idea of using mark-
resight data from the traditional survey in an attempt to improve historic estimates.  However, 
much of that information is not available anymore. 


 
5. In general the protocol reads well, although some key information is only available in the 


appendices.  More detail on the relationship between the stated objectives and the ability of the 
proposed methods to meet them is needed.  In my reading the stated objectives required much 
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more intensive sampling than the recommended ~6 surveys in order to detect a 10-15% change over 
3 years.  Based on the power analyses, sampling would need to be much more intensive.  Please 
clarify how the sampling effort will meet the objectives as stated. 


 
It would have been helpful if this Reviewer identified what key information is only available in the 
appendices.  Without specifics, addressing this is difficult.  We have provided a new section 
justifying the objectives and have inserted additional details throughout the protocol where needed 
based on the other Reviewers’ recommendations.  We have provided clarification of the power issue 
in response to this Reviewer’s comment #3.  


 
Specific comments: 
 
Element 1: Background and Objectives 
 
1. Fig. 1: font map is too small. 
 


We have made all map-based figures larger (e.g., Figs. 1, 5, 6, and 8).  Originally these figures were 
only 4.5 inches wide but now they are 6.5 inches wide.  We are unable to increase the font size 
associated with the background layers within these figures because those fonts are embedded as 
part of a basemap in ArcGIS.  The font sizes displayed in the larger figures will have to suffice.  After 
increasing the size of the map-based figures, we decided to increase the size of all the figures in the 
protocol. 


 
2. Sampling Objective 1:  Is this reasonable?  Based on Appendix A it looks like you would need to 


conduct >20 surveys per year to meet your objective.  It seems this is as many or more flights than 
have been conducted in the past. 


 
We have provided clarification of the power issue in response to this Reviewer’s comment #3.  
During the traditional technique, the number of surveys conducted between December 1st and 
March 31st ranged from 4 to 21 (mean = 12.52, SD = 4.288; Butler et al. in prep).  Again, another 
reason why the critique of the traditional technique is needed. 


 
Element 2: Pilot Studies 
 
3. It may be important to require a specific type and configuration of aircraft for these surveys.  As 


alluded to, the Kodiak has poor visibility in some areas and travels at a much higher rate of speed 
than planes used in the past.  Tandem aircraft generally have better visibility for the observer and fly 
at slower speeds.  Have you considered tandems (e.g., SuperCub, Husky) or are they not available? 


 
We have considered other aircraft but none of them are available.  We have added the following 
sentence to “Element 4, Aircraft type.”  “We recommend using an aircraft similar to a Cessna 206.”  
However, we recognize that logistics and aircraft availability may limit which aircraft is used during 
the survey.  This is unfortunate, but often out of our control. 


 
4. In the past surveys it appears that the pilot and observer surveyed out opposite sides of the plane 


correct?  If so, if transect spacing was 400-500m (Stehn and Taylor 2008), then each ‘strip’ was 
covered twice, once by the pilot (partially) on the first transect and then again by the observer on 
the next pass.  Under this scenario, detection would be much higher than that of your pilot work. 







Page | 16  
 


Our pilot work replicated the traditional technique (last year of surveys conducted using the 
traditional technique provided the data to estimate detection probabilities from the traditional 
technique). 


 
The pilot did not participate as an observer but did occasionally detect whooping cranes.  The 
observer attempted to survey both sides of the aircraft but primarily observed only one side (left-
side).  Stehn and Taylor (2008) reported that transects were spaced 400 to 500 m apart.  However, 
GPS track data from the 2010 surveys indicated transect spacing varied between 250 to 800 m.  
Unfortunately, no GPS track data were saved by observers during the previous years.  The traditional 
surveys were much less systematic than portrayed in Stehn and Taylor (2008) and were more 
targeted to areas known to be occupied by whooping cranes.  We believe this is a good example of 
why we needed to critique the traditional survey technique.  Further, as we show in the pilot work 
(Strobel and Butler 2014), detectability within 500 m of the survey line was only 0.558 (SE = 0.031).  
One might think detection was higher during the traditional survey because of the so called “double 
pass” by the observer.  However, some areas would get a “double pass” while other areas would not 
get observed at all (see diagram below, assumes one observer on left-side of aircraft). 


 


 
 
5. The high error rate for distance categories suggests that GPS locations may be required for each 


group.  You mention this as an option, but I think the language should be stronger in ‘lessons 
learned #4’. 


 
This is not in “Lessons learned #4” but #3; we strengthened the language.  In “Element 4,” we 
specified a technique to avoid having to categorize distances into bins. 


 
6. Is there a reason that the plane does not leave the transect line to mark and count each group?  It 


seems like this would reduce or eliminate both measurement and counting errors.  I see later this 
will be corrected by the heads-up display? 


 
Deviating from the transect line to mark and count each group would reduce potential 
measurement and counting errors but it would also increase the duration of the survey 
substantially.  If it requires 1 deviation from the transect for each group and the deviation is a circle 
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with a diameter similar to transect width (1,000 m) each deviation would add >3 kilometers.  If 100 
groups were detected it would increase the survey duration by approximately 2.25 hours to the 
survey.  The value of reducing measurement and counting errors would need to be weighed against 
the cost of observer fatigue and safety.  Further, whooping crane group density is high enough in 
many parts of the primary sampling frame that diversion from the transect to flyover each detected 
groups might cause other groups to be missed.  However, occasionally observer do divert the plane 
from the transect to confirm a detection if necessary. 


 
7. I disagree somewhat with lesson 6.  Your pilot work demonstrated that detection is likely <1 in a 


single pass survey, not that it is an appropriate technique in this situation. 
 


Our pilot work specifically demonstrated that the traditional technique had a detection rate within 
500 m of the survey line of 0.558 (SE = 0.031).  It seems that this Reviewer misunderstands the 
traditional technique and is misrepresenting it as a double-pass survey.  As shown above (see 
comment #4), it is not. 


 
Yes, our pilot work does show distance sampling is an appropriate technique in this situation.  We 
do not, however, exclude the possibility of other techniques with our pilot work.  Please take a look 
at Strobel and Butler (2014). 


 
The way I read the results of your power analyses, you’d need quite a few surveys to reach your 
objectives.  Is that level of effort reasonable and sustainable as the population expands? 


 
See response to this Reviewer’s general comment #2 for discussion of the power issue.  We can 
meet precision objectives with 6 surveys per winter. 


 
Would spatial approaches provide more information and increases in precision? 


 
Yes, spatial approaches do provide more information and increases in precision, that is why we are 
using the spatially-explicit hierarchical distance sampling methods. 


 
Could you combine distance sampling with the spatial and mark-resight information to increase 
precision? 


 
Focusing on mark-resight techniques will not be productive since so little of the population was 
marked in most years.  Further, detecting and identifying color marks on whooping cranes from 
aerial surveys is a dangerous proposition requiring low level flights at low airspeeds (e.g., a landing-
type approach; Stehn 2001). 


 
Element 3: Sampling Design 
 
8. The plan for expanding the sampling frame seems appropriate. 
 


We agree that a plan for adding new areas to the secondary sampling frame is needed.  However, it 
is not needed immediately.  This population is only growing at about 3.9% per year.  It will likely be 
many years before many of the secondary sampling frames are promoted into primary sampling 
frames.  Only then will we need to determine additional areas for secondary sampling frames.  As 
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we allude to in the protocol, the spatially-explicit maps of abundance can be used in the future to 
identify new secondary sampling frames. 


 
9. Page 16, lines 1-7: Your objectives state that you need to be able to detect a 10-15% decline over 3 


years, but that is not what is implied here.  The number of required repeat surveys increases 
dramatically at CVs below 0.10, and it appears that 20 surveys may be required to meet your stated 
objectives.  Please clarify you recommended sample size here or modify the objectives above. 


 
We have provided clarification of the power issue in response to this Reviewer’s general comment 
#3. 


 
10. Group size estimator: I am not certain how unmarked models group size, but it might be worth 


assessing the fit of the group size model to the observed data.  In some cases the Poisson model 
does not represent the observed data well and can cause fairly substantial bias in estimates.  It may 
be worth exploring simpler models for group size (e.g., individuals vs. groups). 


 
We are not modeling group size.  As outlined in Appendix C, we use hierarchical distance sampling 
to estimate the number of groups in the population.  We then test for size-biased detection.  If size-
biased detection is apparent, we adjust mean group size accordingly.  We then multiply group 
abundance by mean group size (or adjusted group size if needed) to estimate total abundance.  This 
is standard practice for conventional distance sampling. 


 
11. Page 18, lines 6-15: Another alternative would be to left truncate the data to account for the 


partially observable strip under the aircraft if there is continued evidence of <100% detection on the 
line.  This effectively moves the ‘line’ to the tire of the aircraft and as long as all groups are seen 
close to the plane, no bias should occur.  This would help deal with individuals missed that were 
under the plane.  It would also allow the front seat observer to search more intensively over the rest 
of the transect. 


 
Generally the idea of left truncation does not solve this problem because detectability is usually not 
100% at 20 or so meters out from the line (the half-width of the band blocked by the aircraft).  We 
have found with forward observation, detection on the line is possible in most Cessna aircraft.  
Further, distance sampling does not require intensive searching over the rest of the area, it just 
requires 100% detection on the line.  Therefore, changing the technique to increase detection at 
greater distances from the aircraft does little to improve estimates. 


 
Element 4: Field Methods 
 
12. Have you considered wiring a cigarette plug into the aircraft?  We have had good luck using small 


inverters to power laptops in small planes, eliminating the concerns about battery life.  All our DOI 
planes have them, as well as our contractors, so I don’t think permitting would be an issue. 


 
We do use a small inverter in the aircraft.  Battery issues still sometimes occur because of mistakes 
by observers or other reasons.  We likely have corrected this issue by changing to ipad-like tablets 
for data collection. 
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Element 5: Data Management 
 
13. The data management and backup procedures seem appropriate. 
 


Thank you. 
 
Element 6: Data Analysis 
 
14. Pages 28-29: I’m not sure you can use the repeated surveys to estimate temporary emigration in the 


way that Chandler et al. (2011) did because groups are likely move among adjacent sample units 
between surveys.  Chandler et al. (2011) spaced their points so that individuals wouldn’t be 
detected on 2 different points during repeated surveys allowing separate estimation of the two 
detection components.  In your situation, I think this potential for movement between units 
between surveys would cause positive bias even if detection on the line was 1.0 because you 
essentially have a full coverage survey.  Under that scenario, I think you’d be estimating something 
like the superpopulation or the amount of ‘use’ each sample unit gets.  If I am mistaken, please 
clarify/discuss. 


 
We find nowhere in Chandler et al. (2011) that they spaced survey points so that individuals would 
not be detected on different points during different survey reps.  Movement to different cells 
between surveys does not cause any problems with the generalized HDS model.  In fact, the point of 
the generalized HDS model is to characterize that movement through the estimation of a temporary 
emigration parameter (φ).  Regardless of the scenario (i.e., spacing of the survey locations), 
abundance from this model will be biased high, as demonstrated by Chandler et al.’s (2011) 
equation 4, unless it is adjusted by φ.  Following the ideas outlined in the simulation study of 
Chandler et al. (2011), we show that a so called “full-coverage survey” such as ours can be used to 
generate unbiased estimates of abundance using the generalized HDS model of Chandler et al. 
(2011). 


 
We simulated a landscape of 100 cells that were 100 x 100 m.  We divided the landscape into to 2 
habitat types with each habitat type being assigned to 50 cells.  The first habitat type was assigned 
an average abundance of 2 (based on Poisson distribution, λ = 2.0) and the second habitat type was 
assigned an average abundance of 0.5 (based on Poisson distribution, λ = 0.5).  For each iteration of 
the simulation, we selected the abundance for each cell based on these Poisson distributions.  We 
also randomized the arrangement of the habitat types across the landscape for each iteration.   
During each iteration, the home range center of each animal in a cell was randomly selected.  Then 
each animal was allowed to move between surveys (movement was dictated by a multivariate 
normal distribution allowing animals to move in and out of their cells of origin; variance-covariance 
matrix = [500, 0; 0, 500]).  We placed a “full coverage survey design” over our simulated landscape 
which resulted in 10, 100-m wide transects that were 1,000 m long.  For each iteration of the 
simulation, we conducted 6 replicate surveys between which animals were allowed to move.  For 
each animal location, we measured its distance to the transect line and estimated its detection 
probability assuming a half-normal detection curve (σ = 30).  We simulated the detection process 
with a binomial distribution (where p was the detection probability).  We conducted 1,000 iteration 
of the simulation and estimated 95% CIs as the 2.5 and 97.5 percentiles of the simulated 
distribution.  We have proved the R code we used below (see attached Appendix). 
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The landscape we simulated had a true population size of 125 animals.  The generalized HDS model 
estimated abundance as 200.1 animals (95% CI = 159.0–247.8) but once it was adjusted for 
temporary emigration (φ), then estimated abundance was 130.9 (95% CI = 104.5–161.0).  The 
adjusted abundance estimate was unbiased (mean =–3.9%; 95% CI = –25.6% to 19.5%).  Therefore, 
to correctly use the generalized HDS model, abundance must be multiplied by probability of 
temporary emigration (φ).  In the protocol, we already discussed this issue in “Appendix C, A note 
about generalized HDS.” 


 
As mentioned above, I think you could deal with the partially observed strip beneath the plane 
through left truncation. 


 
Generally the idea of left truncation does not solve the problem of incomplete detection on the line 
because detectability is usually not 100% at 20 or so meters out from the line (the half-width of the 
band blocked by the aircraft).  We have found with forward observation, detection on the line is 
possible in most Cessna aircraft.  This was only an issue in the Kodiak with pontoons. 


 
In general, I think the density estimates from each survey will be interpretable on their own and 
could be thought of as analogous to the historic counts adjusted for incomplete detection.  It is 
somewhat unclear to me how you will be using the multiple surveys/estimates other than maybe 
considering the highest one as the max population size estimate? 


 
The data will be pooled across the surveys from the 28 November–26 December.  This will result in 
one estimate of abundance, HY:AHY ratio, number of adult pairs, and number of recruitive pairs, 
and one spatially-explicit model of abundance.  Though we believe this is clearly articulated in the 
methods outlined in Appendix A and C, we add a note to “Element 6, Analysis methods” section.  
Realize, the Elements are really just summaries and the details abound in the SOPs and Appendices.  
We are a little disappointed this reviewer did not examine Appendix C closer. 


 
(I see that many of these issues are addressed in Appendix C, page 97, but I think it should be made 
more clear in the main text that the temporary emigration piece will probably not be usable under 
the proposed design.) 


 
We have added the following statement to “Element 6, Data analysis” section.  “Currently, we plan 
to pool all the surveys from the 28 November and 26 December survey period and use the model 
configuration that ignores temporary emigration (see Appendix C–A note about generalized HDS).” 


 
15. For clarity, abundance estimates for each survey will represent the portion of the population using 


the survey area the day of the survey (i.e., birds temporarily located in areas outside the primary 
sampling units are not accounted for). 


 
For clarity, all surveys are pooled for analysis.  We emphasize that our estimates will only pertain to 
the primary sampling frame in multiple places throughout the protocol (e.g., “Element 1, 
Objectives” and “Element 7, Summary statistics of interest”).  We limit the survey to a 2-week 
window in order to provide as much population closure as possible. 


 
16. How are you accounting for the spatial autocorrelation induced by your small (1 km) subunits?  


When all are sampled sequentially, there will be a fair bit of autocorrelation present.  Will this 
information only be used for the habitat component? 
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Spatial autocorrelation or lack thereof has nothing to do with the size of the subunits.  Spatial 
correlation could occur regardless of the size of the subunits.  Spatial correlation could affect the 
standard errors of the parameter estimates but the magnitude of effect would be minimal.  Thus, 
the inferences gained from our models about the effects of habitat on whooping crane abundance 
would not change if potential spatial correlation was accounted for.  Further, there is not currently a 
tractable way to deal with spatial correlation in these already complex models. 


 
Element 7: Reporting 
 
17. The reporting requirements seem appropriate.  Requiring at least an annual report that is placed in 


a government series is a good idea in my opinion.  One suggestion would be to include periodic 
publication of results in the peer-reviewed literature (e.g., every 5 years).  Over time this would 
establish your methods and results as scientifically defensible and would help support future 
delisting decisions. 


 
Thank you, we agree annual reporting is important and have provided for it in “Element 7: 
Reporting.”  We agree that periodic publication is important and we will be pursuing publication of 
our results.  We added the following sentence to “Element 7, Reports” section.  “Also, we 
recommend periodic publication of survey results in the peer-reviewed scientific literature.” 


 
Element 8: Personnel Requirements and Training 
 
18. These seem appropriate. 
 


Thank you. 
 
Element 9: Operational Requirements 
 
19. These seem appropriate. 
 


Thank you. 
 
Appendix A: Power Analysis 
 
20. These analyses seem appropriate given the limitations of TRENDS and the basic assumptions made.  


Multiple sources of heterogeneity could reduce the power to detect trends, but the approach used 
is reasonable.  Have you considered the increase in power that might be possible either through 
analyzing multiple years’ data together or using a Bayesian approach with informed priors on the 
detection function?  That should increase your precision over time assuming the detection process is 
similar through time. 


 
Yes we have considered this and will likely implement some sort of data pooling in the future to 
bolster our power.  Thank you for the suggestions. 
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Appendix B: Indexing Recruitment 
 
21. As long as this is treated as an index rather than abundance the methods seem appropriate. 
 


Agreed, thank you.  However, we are not talking about abundance but a ratio. 
 
Appendix C: Data Analysis 
 
22. Page 97: As described above, I don’t think temporary emigration is estimable under your current 


full-coverage design.  If you disagree, please explain. 
 


See our responses to other comments regarding this issue (see Reviewer #2, comment 14).  
Temporary emigration is estimable under a so called “full-coverage design.” 


 
 
 
REVIEWER #3: 
 
It is clear that a considerable amount of work went into this protocol.  The techniques and analyses used 
within this protocol seem appropriate and logical. 
 
Thank you.  Indeed much work has gone into developing this protocol. 
 
This is a sound protocol but needs, in my opinion, more details with explicit statements and discussion.  
You make many implied statements or cover specific topics but they need to be brought together in a 
clear and concise manner.  I make specific comments below. 
 
We thank you and the other Reviewers for their comments.  Those comments have allowed us to fill in 
details in import places throughout the protocol. 
 
Specific comments: 
 
1. There are several grammatical edits needed throughout the document.  I will provide two examples: 
 


A) Element 1, Page 1, Lines 5-6: The focus is the crane and not the “endangered species.” I suggest 
the following change. 


 
Whooping cranes (Grus americana), an endangered species, declined to near extinction by 1941 
(Canadian Wildlife Service [CWS] and U.S. Fish and Wildlife Service [USFWS] 2007). 


 
Agreed, changed as recommended. 


 
B) Element 1, Page 1, Line 10: Delete the “s” in “…..breeds on and around Wood Buffalo National 


Park ….. .” 
 


Agreed, changed as recommended. 
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2. The authors make implied statements in the document on how their study design and pilot studies 
demonstrate how the surveys will meet the assumptions of Distance Sampling.  It is my opinion that 
you need a section dedicated to that information.  You must explicitly state how your study design 
and pilot studies have shown or how you will meet those assumptions.  A good place may be in 
Element 3. 


 
We agree that assumptions must be addressed and we did address them.  “Element 3, Sources of 
biases” section explicitly addressed the assumptions of our techniques. 


 
3. You need to make a statement as to why the plane does not alter the movement or behavior of the 


cranes.  It may be obvious to you but not to others.  
 


We added the following paragraph to “Element 3, Sources of biases” section: 
“Movement of whooping crane groups in response to the aircraft prior to detection could bias 
estimates of abundance.  Movement that is independent of the aircraft causes no problems and 
movement after detection is not a problem as long as the initial location can be accurately 
determined (Buckland et al. 2001).  Movement towards the aircraft by whooping cranes would 
result in positive bias but evasive movements would result in abundance being biased low (Buckland 
et al. 2001).  However, attraction to or avoidance of the aircraft by whooping cranes is not an issue.  
During previous surveys, we observed the immediate response of hundreds of whooping cranes 
groups to the aircraft.  We did not observe any whooping cranes being flushed into flight or make 
movements of >100 meters in response to the passage of the aircraft.  Further, initial locations of 
whooping crane were easily established.  When visibility allowed the detection of groups from the 
next transect, groups were often detected in the same location, suggesting movement away from 
the aircraft was not substantial.” 


 
4. You need to discuss randomness of line transect placement.  Having a random start point or time is 


great to account for temporal bias but does nothing for spatial bias.  Random transects provide 
unbiased coverage of landscape heterogeneity and distribution of focal wildlife species.  I 
understand that you may survey the entire area but you need to explicitly state how that justifies 
the nonrandom placement of transects.  It is even more important to explain given your statement 
on Page 12….”However, as more regions are added to the PSF as the whooping crane wintering 
grounds 46 expand, complete sampling will likely become infeasible.”  You then must justify, with 
less than full coverage of the study area, why you did not use randomly placed transects. 


 
We agree that sampling strategy is a very important consideration influencing the rigor of any 
survey.  Hedley and Buckland (2004) indicate that spatial distance analyses such as those we use are 
not as dependent upon random sampling because environmental covariates are incorporated 
directly into the model and thus do not need to be controlled through randomization.  This allowed 
us to place transects anywhere we wanted across the survey blocks because the environmental 
covariates are used to control any potential bias.  We chose to place transects so that coverage of 
each survey block was maximized.  Transects were systematically placed 1,000 meters apart. 


 
“Spatial modelling does not require that the lines or points are located according to a formal survey 
sampling scheme” (Hedley et al. 2004:48). 


 
5. I assume that “groups” are “clusters?”  Per the Distance Sampling lingo.  You might want to make a 


reference early in the document that groups are your clusters. 
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In our experience most readers are more confused by the term cluster than they are by group.  
Usually when cluster is used it is followed by parenthetic phrase like “i.e., a group of birds.”  We 
added a note in “Element 3, Sampling units” that groups is referring to the cluster lingo used in 
Buckland et al. (2001). 


 
6. I would make a quick statement somewhere as to why it is important to measure perpendicular 


distance to the center of the cluster or group.  The statement on page 52 is not enough. 
 


We are glad you pointed this out since the protocol does not specify that distances need to be 
measured to the center of the group (except in SOP1).  We have now added information regarding 
measuring distance to the group center to “Element 3, Sources of biases” and “Element 4, Field data 
collection methods.”  As for explaining why, SOP 1 is not the appropriate place to explain why since 
it is a step-by-step explanation of what the observers are to do. 


 
7. It is important to explicitly state and discuss what will be considered a group or cluster and what are 


the criteria (e.g., behavior, separation distance, etc.) used to separate those groups.  I know you 
make implied statements, “a group is greater than 1 crane” and “any crane within 100 m is counted 
within the group,” but that is not enough.  You must justify that criterion with data or citations.  This 
will strengthen the value of your abundance estimate. 


 
Groups of whooping cranes are primarily 1, 2, 3, or 4 individuals (usually a family group) and the 
occasional larger group of subadults.  We added this statement to “Element 3, Sampling units” 
section. 


 
8. Determining size bias is not the only important item when it comes to group size.  A consistent size 


from group to group will improve or strengthen your CV.  A consistent size from group to group can 
be controlled sometimes with a good, a priori, definition of what a group is and a procedure to 
separate groups. 


 
Groups of whooping cranes are primarily 1, 2, 3, or 4 individuals (usually a family group) and the 
occasional larger group of subadults.  It is not possible to control group size; it is what it is.  
However, group size is a minor part of the total variance of abundance estimates from these surveys 
and, therefore, has a minor impact on the CV. 


 
9. Being a little facetious, but is a survey the act of traversing a transect or is it the amalgamation of all 


transects being flown.  The author needs to explicitly state what a survey is.  The use of the term 
survey is loosely used throughout the document.  The description/definition of a survey, segment, 
and transect need to be tightened up.   Segments make up transects and transects make up a 
survey.  A completed survey is when all segments of all transects are flown.  You mentioned at least 
two surveys will be flown during peak times.  The explicit definition of what you are calling a survey 
is vital here.   


 
A survey is all transects within the sampling frame under discussion.  We provided clarification 
throughout the protocol that 6 surveys of the PSF means that all transects will be surveyed 6 times 
and that 2 surveys of the SSF means that all transects will be surveyed 2 times. 


 
10. Suggestion: I would fly each transect at least twice (on separate days, preferably back to back) and 


define that as 1 survey.  If you fly each transect 4 times (4 separate days) then you would have 2 
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complete surveys.  By flying each transect (alternate directions) twice per survey, you strengthen 
the abundance estimate and CIs by attempting to capture the inherent variation (e.g., crane 
behavior, environmental factors, etc.) that is present. 


 
Thank you for the suggestion.  We are flying the survey (all transects in the primary sampling frame) 
at least 6 times.  We never start a survey with the same survey block.  Transects are usually flown in 
different directions than the last time. 


 
11. Please don’t combine objectives when providing information, such as on Page 14/Line 20.  Discuss 


objectives individually. 
 


When discussing the reasons for selection of survey timing or other protocol constraints, we 
combined objectives when the reason was similar.  This is simply more efficient and reduces the 
overall length of the protocol.  Thank you for your suggestion but we opted for efficiency here. 


 
12. Regardless of plotting locations on a map within a GIS, I imagine you will still need to bin your 


perpendicular distances.  Perpendicular distances must be precise and human error will still be very 
much present with hand plotting.  I would discuss that binning will still be part of the data analysis 
as exact distances can’t be made. 


 
Beyond binning because of potential errors associated with distance measurements, we must bin 
our data for analyses because the hierarchical distance sampling model we are using is the 
multinomial-Poisson mixture model of Royle et al. (2004).  This multinomial part of this model 
requires data to be binned.  Binning does not necessarily fix problems with measurement error. 


 
13. Will binning be used to create the all imperative shoulder on the detection probability histogram.  


You should probably discuss how the data will be handled if an apparent shoulder is not found in the 
data. 


 
Our data have exhibited a shoulder in the past for this survey and there is no reason to expect it not 
to in the future.  Therefore, we chose not to discuss this issue in the protocol.  If users are interested 
in this issue, we suggest they consult Buckland et al. (2001). 


 
14. Element 1, Page 1, Lines 26-27:  This sentence is confusing.  Are you monitoring the metrics or are 


you stating the quantitative population metrics from monitoring are important for achieving 
criteria?  I suggest rewording this sentence to be clearer. 


 
The sentence in question states, “Monitoring quantitative population metrics is important for 
determining if the population has achieved downlisting criteria.”  We do not see how this is 
confusing.  The population must be monitored in order to know if the downlisting criteria have been 
achieved.  We choose not to change the sentence since the Reviewer provided no suggestions on 
how to improve or clarify the sentence. 


 
15. Element 1, Page 2, Line 1: I suggest the following addition “…..ensure population closure (e.g., 


emigration, immigration; Lancia et al. 2005, Morrison et al. 2008, Stehn and Taylor 2008, Conroy and 
Carroll 2009).” 


 
Agreed, changed as recommended. 
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 Element 1, Page 2, Lines 2-5: I suggest the following additions “…..individuals is usually less than 
100% (i.e., <1) and 2 detectability is influenced….” 


 
Agreed, changed as recommended. 


 
 Element 1, Page 2, Lines 9-10: I suggest the following modification “Therefore, an robust alternative 


method that does not….” 
 


Agreed, changed as recommended. 
 
16. Element 1, Page 3, Lines 3-4: I suggest the following addition, “….location on a paper copy of a 


1:46,080 Digital Orthophoto Quarter Quadrangle (DOQQ).” 
 
 We added “Digital Orthophoto Quarter Quadrangle” as suggested. 
 
17. Element 3, Page 9, Line 27:  I would suggest deleting this secondary heading, “Sampling Design.” 
 
 Element 3, Page 9, Line 35:  This is a very odd heading.  I would suggest changing the heading from 


“Target universe” to “Target inference” or something a little more descriptive. 
 
 Thank you for your recommendation.  However, we choose not to change these headings since they 


are part of the I&M Protocol Template. 
 
 
 
INTERNAL REVIEWER #1: 
 
First of all, many thanks to you and your staff for undertaking the monumental task of getting a protocol 
in place.  I know first-hand how time consuming and difficult this was, particularly with ongoing staffing 
changes, etc.  I think the protocol puts us in an excellent position moving forward as we evaluate metrics 
needed for species recovery, Refuge acquisition decisions, etc.  I am excited about the upcoming season 
and the opportunity that the well-thought out protocol and additional staffing capacity provides us, 
ensuring that we get things "right".  Attached are some of my initial thoughts and comments, I wanted 
to get you something as quickly as possible so we can continue the upcoming season's planning efforts.  
Let me know if you have questions about any of my comments. 
 
Thank you for your thoughtful review; we value your comments. 
 
Specific comments: 
 
1. Pg. 1, line 37: remove “the” 
 


Agreed, changed as recommended. 
 
2. Pg. 2, line 3: change “influence” to “influenced” 
 


Agreed, changed as recommended. 
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3. Pg. 4, line 15: consider adding “reliably” to “aerial surveys cannot be used to reliably imply 
mortality.” 


 
Agreed, changed as recommended. 


 
It may be worth pointing out that there were marked individuals during a portion of the 1950-2010 
surveys and the marked individual’s presence and location was used to establish observer 
knowledge of territoriality, etc.  For the most part, this is no longer the case and detection of 
marked individuals from an aerial survey is nearly impossible given the protocol for flight speed and 
altitude. 


 
We added additional discussion of the potential problems associated with the traditional estimates 
of winter mortality.  We also added a note about territoriality and site fidelity were derived from 
limited observation data from marked birds. 


 
Wild whooping cranes were not individually marked until 1975.  In fact, only 132 marked birds have 
been in the population spanning the period of 1977 through 2004 (Gil-Weir et al. 2012).  Over 40% 
of the years in which the traditional survey was conducted (1950–2011), no color marked birds were 
in the population.  By the winter of 2010–2011, only 7.8% of the flock was marked (Stehn 2011).  It 
is also important to note that many of the banded cranes were not marked with uniquely 
identifiable color marks but with aluminum bands (Stehn 2011). 


 
4. Pg. 4, line 36: Consider stating that “mark-recapture models using information from marked 


whooping cranes to estimate mortality may be explored in future.” 
 


We are unsure mark-recapture based estimates of mortality are possible given the difficulty of 
detecting marks during the aerial survey.  However, we did add the statement, “mortality estimates 
are better derived from radio- or GPS-telemetry based monitoring of a sample of the population.” 


 
5. Pg. 5, line 20: Suggest conducting surveys annually until this precision goal is achieved over 3 yrs. 
 


We recommended annual monitoring in “Element 3, Monitoring frequency” section.  But we discuss 
the potential of biennial monitoring which could meet the survey’s objectives if the precision of 
surveys is adequate. 


 
6. Pg. 7, line 17: Might want to emphasize that the decoy study was conducted when WHCRs were not 


present at Aransas, eliminating confusion with live birds. 
 


Agreed.  We added the sentence, “the experiment was conducted during September prior to the 
arrival of whooping cranes to eliminate potential confusion with live birds” for clarification. 


 
7. Pg. 10, line 20: add “primary” to “apply to the primary sampling frame” 
 


Good catch; changed as recommended. 
 
8. Pg. 12, line 20: Should consider some type of density estimate to serve as a threshold for including 


SSF into PSF.  The way it is structured now, relatively small SSFs (i.e., Holiday Beach) have the same 
threshold applied for inclusion into PSF as those that are much larger (i.e., Guadalupe Delta).  Given 
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this fact, some small SSFs may never be included into the PSF even after several years of consistent 
WHCR use.  Consider analyzing what the average WHCR density is in the PSF and using that to 
determine an inclusion threshold. 


 
Great idea!  We have now estimated a threshold of number of detections for promotion of each SSF 
to PSF based on minimum density estimated in the PSF regions.  New text in protocol is: 


 
“Previously collected data indicated that whooping cranes have sporadically used several areas 
outside of the PSF.  The SSF will be used to monitor expansion of the whooping crane wintering 
grounds.  We determined a minimum number of whooping cranes groups that must be detected in a 
SSF region, before that SSF region will be included in the PSF for future surveys.  The minimum 
number of groups ( ) for SSF region   was determined based on the following formula: 


 
        (      ) 


 
where   was the minimum PSF region-specific density of whooping crane groups estimated during 
the winter 2013–2014 surveys (≈0.1 groups/km2),    was the area of SSF region  , and   was the 
average detection probability during the 2013 surveys (0.7 detection probability within 500 m of 
transect).  We rounded each    down to the nearest integer.  The estimated threshold (  ) of groups 
for a SSF region must be detected >2 times within a survey year before that SSF region will be 
promoted into the PSF for future surveys (beginning the next year).  The minimum number of 
whooping crane groups needed to promote a SSF region into a PSF region varied from 1 to 9 (Table 
2).” 


 
We also add a new table to summarize the new thresholds. 


 
9. Pg. 13, line 25: May want to note that surveys in WBNP are primarily used to estimate WHCR nests 


and fledged chicks, not abundance.  I can see what protocols CWS has if you would like. 
 


Please check on those protocols, if any exist, and let us know how CWS’s surveys are currently 
conducted and for what purposes.  We believe integration of information from the abundance 
surveys on the wintering grounds with information about reproductive output on the breeding 
grounds could provide valuable insight into the limiting factors for this population.  


 
10. Pg. 14, line 2: The 2-wk window may be too narrow once weather and logistical issues (plane 


maintenance) are considered.  Consider changing to 3-wk window. 
 


We have decided to keep the 2-week window for now and see how things work out for winter 2013.  
We do not necessarily consider the 2-week window an absolute.  It emphasizes the importance of 
getting the surveys done in as short of a window as possible.  And a 2-week window is realistic.  
However, if it takes 16 days to complete the 6 surveys instead of 14 days, that is alright. 


 
11. Pg. 14, line 13: Seems as though a clear objective for surveys done in secondary periods has already 


been established (“to document temporal changes in resource use”).  May want to clarify this and 
note that surveys during secondary periods are optional and will be conducted only if primary 
objectives have been met and resources allow. 
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We do not consider “to document temporal changes in resource use” as a sufficient objective.  
During the first year of the new survey, we conducted surveys in a few different time periods during 
winter.  Though there were slight changes in habitat use through time, the primary driver of all the 
models remained percent saltmarsh.  We agree that surveys during secondary periods are optional 
and did note this in “Element 3, Survey timing” section.  The primary reason for conducting the 
surveys is to estimate abundance, not quantify temporal changes in resource use.  Models of 
resource use are a useful byproduct of the statistical analyses but resource use is best studied using 
other means, such as GPS-telemetry. 


 
12. Pg. 15, Figure 9: Given the historical nature of this graph, I am concerned that we could be starting 


primary surveys too early in the year, potentially not capturing peak abundance in the early surveys. 
Should later migration events be accounted for? 


 
Based on the historic data we felt that surveys probably could begin either the second or third week 
of November.  However, we delayed starting surveys until December just in case migration was 
delayed some years.  We agree that if we see that migration is delayed in a particular year, then we 
should delay surveys as appropriate for that year.  In fact, that is part of the reason we allowed 
surveys to be conducted anytime during the 1-month period (as long as they are blocked together 
into a 2-week window).  If a trend of later migration dates becomes apparent, then we should re-
evaluate the survey dates for future surveys. 


 
13. Pg. 17, line 4-5: As stated previously, this threshold seems somewhat arbitrary considering the SSFs 


vary greatly in size and habitat quality. 
 


Agreed and we have addressed this issue in this Reviewer’s comment #11. 
 
14. Pg. 17, monitoring frequency: Need to explain how sampling objective 1 (“enough precision to 


detect a 10-15% population decline over 3 yrs”) can be met without annual sampling. 
 


The paragraph in question is a discussion beyond objective 1.  It broaches the issue current 
monitoring may be unnecessary until the population is closer to reaching the downlisting goal.  We 
feel it is appropriate to discuss this point of view since it is an alternative to the objective outlined in 
the protocol.  At current levels of precision, biennial monitoring probably could not meet current 
objectives.  However, as the kinks are worked out in the new protocol, precision may improve. 


 
15. Pg. 18, line 17: Is it worth saying that if an observer has any doubts as to the species ID during a 


survey, the bird should not be recorded? Or come up with a similar rule? 
 


Yes, this is worth saying.  We had assumed that observers would only record detections they were 
certain to be whooping cranes.  We have made this explicit in the protocol in the section in question 
and we added “if an observer has any doubt as to the species, that detection should not be 
recorded” to SOP1. 


 
16. Pg. 20, line 29: Note that full Nomex fire clothing (shirt and pants) can be substituted for a flight suit 


per regs. 
 


The Reviewer is correct.  See ALSE Handbook.  We added a reference to the ALSE Handbook to the 
protocol and changed from “Nomex flight suit” to “Nomex flight suit or other fire-resistant clothing.” 
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17. Pg. 20, line 30: I have not seen Nomex gloves identified as a PPE requirement, need to check on this. 
It would make data recording much more difficult. 


 
The Reviewer is correct; leather gloves maybe used instead of Nomex gloves.  See ALSE Handbook.  
We changed “Nomex gloves” to “Nomex or leather gloves.” 


 
18. Pg. 20, Table 2: We should check to see if voice-activated voice recorders are available.  This would 


reduce data loss associated with on/pause toggle issue. 
The Refuge Biologist was looking into this as a possibility; also, one observer has switched to simply 
writing down their observations.  We encourage observers to use whatever technique works for 
them without compromising the survey’s integrity. 


 
19. Pg. 21, line 19: This list should be created prior to survey season and used accordingly by pilot and 


observers. 
 


Yes it should.  Thanks for emphasizing the importance of making this list prior to the start of surveys.  
We have added this to SOP1. 


 
20. Pg. 21, line 38: Per our experience last year, it takes about 4.5 hrs to conduct the survey (PSF). The 


stated time allotment doesn’t leave any time to conduct SSF as suggested earlier in the document. Is 
it okay to conduct SSF flights outside of 10:00 to 15:00 hrs? 


 
We should attempt to keep all surveys inside the 10:00 to 15:00 timeframe.  However, some 
deviance is probably acceptable. 


 
21. Pg. 23, line 22-24: I still think we should explore a drop-down menu available via DNR Garmin or 


other software that would allow instantaneous data recording of group size/type.  This would 
eliminate the need to voice record location and #/type of crane group detected and lowers potential 
data loss associated with this step.  Each observer would still use a voice recorder for notes. 


 
We agree alternative data recording options need to be explored in the future.  As mentioned 
before, we encourage observers use whatever technique works for them without compromising the 
survey’s integrity. 


 
22. Pg. 32, line 19-20: Need to state who is responsible for the annual report. Refuge biologist in 


conjunction with I&M, WHCR coordinator? 
 


Thank you for catching that oversight.  We have added the following sentence to the “Element 7, 
Reports” section and the “Element 8, Roles and responsibilities” section.  “Compilation of interim 
and annual reports will be a collaborative effort among the Lead Biologist, Regional Biometrician, 
Regional Data Manager, and Whooping Crane Recovery Coordinator (see Element 8–Roles and 
responsibilities).  Update reports are the responsibility of the Lead Biologist with assistance from 
other observers.” 


 
23. Pg. 33, line 4-9: Is it worth stating that at least one alternate observer should be trained if possible in 


case one of the primary observers is not able to conduct the survey.  This is particularly important 
given the survey’s time constraints. 
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Good idea.  We added the following to “Element 8, Training” section.  “At least one alternate 
observer should be trained in case one of the primary observers is not able to conduct a survey.” 


 
 
 
INTERNAL REVIEWER #2: 
 
I would like to thank the authors for giving me the opportunity to review the whooping crane 
abundance survey protocol.  Below are my line by line comments followed by general overall comments. 
 
Thank you for taking the time to evaluate and critique our protocol.  We appreciate your efforts. 
 
Specific Comments: 
 
1. Cover Page:  Insert “(Protocol)” after the word “Survey” 
 


Agreed, changed as recommended. 
 
2. Page x, Line 11-13.  Rewrite to:   Stehn and Taylor (2008) briefly described the aerial survey methods 


employed from 1982-2011 and identified multiple factors that affect detection of whooping cranes. 
 


We disagree.  Stehn and Taylor (2008) identified more than just factors that affect detectability.  For 
example, they discussed problems associated with not predefining flight paths, whooping crane 
movements during surveys, upland use by whooping cranes, etc… 


 
3. Page x, Line 17-18.  Rewrite to:  Regional and refuge staff then launched a multifaceted effort to 


develop a statistically rigorous survey method. 
 


Thank you for the suggestion, we reworded the sentence as “Regional and refuge staff then 
launched a multifaceted effort to improve the survey methods and develop a statistically rigorous 
technique.” 


 
4. Page x, Line 40.  Rewrite to:  The survey methods in this protocol provide a statistically rigorous 


means to estimate the annual peak abundance, and associated degree of confidence, of whooping 
cranes wintering within the sampling frame.  Furthermore, the survey methods provide estimates 
of…. 


 
Thank you for the suggestion, we reworded the sentence as “The survey methods provided in this 
protocol are a defensible, statistically rigorous means to estimate the annual abundance, and 
associated degree of confidence, of whooping cranes wintering within the sampling frame.” 


 
5. Page 1, Line 11.  “Gulf” should be capitalized. 
 


We disagree.  Texas gulf coast is not a proper noun.  The Gulf of Mexico is a proper noun.  The 
grammar is similar to “south Texas.”  The words “south Texas” does not indicate a state like West 
Virginia and therefore, should not be capitalized.  The same applies to the Texas gulf coast. 


 
6. Page 1, Line 28.  Replace “defensible and creditable” with “statistically rigorous”  
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The sentence in question reads, “monitoring also provides a tool to measure recovery and bolster 
conservation efforts by providing defensible and creditable data that can be used to inform 
decisions affecting whooping crane conservation and management.”  This sentence is discussing 
monitoring in general terms, not a specific monitoring technique.  We believe it would be better to 
exclude either phrases from this general sentence and reserve such phrases for discussing a specific 
monitoring technique.  Therefore, we have reworded the sentence as “Monitoring also provides a 
tool to measure recovery and bolster conservation efforts by providing data that can be used to 
inform decisions affecting whooping crane conservation and management.” 


 
7. Page 2, Line 5-8.  Rewrite to:  Stehn and Taylor (2008) recognized these sources of potential bias and 


also indicated that population increases and range expansions would decrease the accuracy of the 
census. 


 
Thank you for the suggestion, we reworded the sentence as “Stehn and Taylor (2008) recognized 
these sources of bias but they did not address them.  They also indicated that as abundance 
increases and the whooping crane’s wintering grounds expand, the accuracy of their “census” 
attempts would decrease.” 


 
8. Page 2, Line 9-12.  These two sentences should be moved to just above “Objectives” on Page 5. 
 


Thank you for your suggestion but these two sentences are appropriate in their current location. 
 
9. Page 3.  Delete blank line 7 and move Line 8 (sentence beginning “Each”) up to line 6. 
 


We agree that this sentence should be part of the previous paragraph. 
 
10. Page 3.  Delete line 10-31 (sentence beginning The “peak population size” and ending with the graph 


and Figure 2 caption).  This paragraph has nothing to contribute to the understanding of why the 
Service is changing methods.  The “Traditional census estimate and Maximum count during the 
survey year” are clearly correlated.  The use of a T-test to statistically show the minor difference 
between the two does not seem appropriate and to report a 3 bird difference as significant seems 
absurd.   


 
The section in question reads, “The reported winter abundance was presumably obtained from the 
survey with the most individuals detected but was rarely replicated in subsequent surveys.  
However, the survey with the most individuals detected rarely corresponded with the winter 
abundance reported in the International Recovery Plan (CWS and USFWS 2007) and Aransas NWR 
annual reports (Stehn 2009, 2010, 2011; Figure 2).  In fact, the reported abundance was ≈3.7 birds (t 
= 3.754, df = 30, P < 0.001) more than the maximum count observed during the 1980–2010 surveys.  
This likely occurred because birds observed outside of the survey area by the public or other parties 
were included in the reported abundances.  Interestingly, during 1980–2010, the maximum number 
of individuals detected during a survey was greater than the reported abundance for 6 of the survey 
years (Figure 2).  This inconsistency may be attributed to the observer’s interpretation or perception 
of double counts.  However, we cannot know the sources of these inconsistencies since rules 
governing how data from separate surveys were combined or how public reports of whooping 
cranes from outside of the “censused” area were incorporated was largely determined by the 
observer’s opinion.  This shows the traditional “census” was not an absolute enumeration of the 
population but instead a relative index of abundance.” 
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Understanding the limitations of the historic data only strengths our ability to use those data; this 
section is important to help readers understand those limitations.  We believe the inability to 
discern exactly how numbers were derived is a fundamental issue associated with the traditional 
technique.  Instead of assuming those data are absolute, we think it is better to couch our 
inferences within the data’s limitations and avoid risking drawing conclusions that are beyond the 
scope of the historic data. 


 
Discussing a 3 bird difference is not absurd.  Three birds can fundamentally change the 
interpretation of these data since they have been treated as absolute truth.  For example during the 
winter of 2008–2009, the traditional technique reported 270 birds on the wintering grounds with 23 
of them dying during the winter.  During the winter of 2009–2010, the population was reported to 
be 264 birds with 22 juveniles which would mean there were 242 adults in the population.  
However, the maximum count during the winter of 2009–2010 was 270 birds which would 
presumably mean there were 248 adults in the population.  If 23 mortalities occurred during the 
winter of 2008–2009, there could only be 247 adults in the population during the winter of 2009–
2010 (270–23=247; assuming no mortality during other parts of the year).  Where did that extra 
adult come from?  Did the maximum count of 270 during the winter of 2009–2010 include 6 birds 
that were counted twice?  Was mortality during the breeding- and migration-periods only 2% ( 
(247–242)/247 )?  This is an illustration of the fundamental danger of a technique that portends to 
deal in absolute truth when there is really much uncertainty in the estimates. 


 
11. Page 4, line 1-7.  Move up to page 3 line 6 just ahead of current line 8 on page 3. 
 


Since we chose not to delete the previous paragraph, these lines should remain where they are. 
 
12. Page 4, line 7-15.  Sentence beginning “Group structure” start as a new paragraph.   Rewrite to:  In 


the past, group structure and location data was also used to assist in quantifying mortality of 
individuals.  For example, subsequent observations of a group of 1 adult and 1 chick where previous 
surveys located a group of 2 adults and 1 chick could result in the presumption that 1 adult had died.  
However, the “unusual movements and behaviors of color-banded whooping cranes” observed by 
Stehn (1992), such as extra-territorial excursions, rapid pair formation after mate mortality, pair-
bonded individuals overwintering apart, and occasional departure from the wintering grounds 
during the winter period, in addition to incomplete detection of individuals makes using group 
structure and location data of unmarked birds from aerial surveys problematic. 


 
We added more information to this paragraph in order to help readers better understand the 
problems associated with the mortality estimates derived from the traditional technique.  The 
section is now split into 3 paragraphs: 


 
“Wintering whooping cranes are thought to demonstrate territoriality and site fidelity within and 
across winters (based on limited observation data from marked birds; Stehn and Johnson 1987, 
Stehn 1992, Bonds 2000).  The fidelity of whooping cranes to their wintering territory has been used 
in conjunction with group structure as a surrogate for individually marked birds.  Groups of equal 
size found in similar areas on subsequent surveys were assumed to be the same individuals.  These 
data were used to identify circumstances where distinct groups, or individuals within groups, were 
not detected and therefore additional search efforts were conducted (Stehn and Taylor 2008).” 
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“Group structure and location data was also used to assist in quantifying the mortality of individuals 
(Stehn and Strobel 2012, Pugesek et al. 2013).  For example, subsequent observations of a group of 
1 adult and 1 chick where previous surveys located a group of 2 adults and 1 chick resulted in the 
presumption that 1 adult had died.  However, the “unusual movements and behaviors of color-
banded whooping cranes” observed by Stehn (1992), such as extra-territorial excursions, rapid pair 
formation after mate mortality, pair-bonded individuals overwintering apart, and occasional 
departure from the wintering grounds during the winter period, in addition to incomplete detection 
of individuals indicates that group structure and location data of unmarked birds from aerial surveys 
cannot be used to reliably imply mortality.” 


 
“The technique for enumerating mortalities assumed that if an individual whooping crane was not 
observed for 2 or more surveys, that individual was dead (Stehn and Strobel  2012).  For this 
technique to produce consistent results, the number of surveys conducted per winter needed to be 
relatively constant.  However, the number of surveys conducted between December 1st and March 
31st of each year ranged from 4 to 21 (mean = 12.52, SD = 4.288; Butler et al. in prep).  This 
deficiency in the technique manifested itself in an inverse relationship between winter mortality 
estimates and the number of surveys conducted between December 1st and March 31st (binomial 


regression: odds ratio = 0.932,  ̂ = –0.071, SE = 0.028, W = 6.595, P = 0.010; Butler et al. in prep).  
Hence, more surveys resulted in less mortality because temporary emigrants had more chances to 
return and be re-observed on their territories.  For example, imagine that 5 consecutive surveys 
were conducted and a whooping crane was missing from its territory on the third and fourth survey 
occasions.  If the last survey had not been conducted, that whooping crane would have been 
considered dead.” 


 
13. Page 4, line 35.  Delete entire bullet. 
 


The bullet in question is “The observer assumed ability to uniquely identify unmarked individual 
whooping cranes.”  This is a true statement, and relevant, so we are unsure of the request for 
deletion.  While some believe that previous observers could consistently identify unmarked 
whooping cranes, there are no data available to support this belief.  In our professional experience, 
defensible identification of free-ranging individuals requires the use of unique markers.  As such, we 
feel our comment is accurate.  This point forms an added example of why we needed to critique the 
traditional survey technique. 


 
14. Page 4, Line 37.  Stop the sentence after the word “tested.”  Delete “and is likely untenable.” 
 


The statement in question is “The suitability of using group structure and territory location as a 
surrogate for individually marked birds to measure mortality rates has not been quantified or tested 
and is likely untenable.”  We have changed this sentence to “The suitability of using group structure 
and territory location as a surrogate for individually marked birds to measure mortality rates has not 
been tested and is likely untenable.”  We have provided additional information in a previous 
paragraph to explain the problems associated with estimating winter mortality from the traditional 
survey technique. 


 
15. Page 5, line 1-3.  Delete entire first two sentences 
 


The sentences in question are “Many technological and statistical advances have resulted in 
improvements in data collection and analysis techniques that were not readily available when aerial 
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surveys began in the 1950s.  However, many of these advances have been available for decades 
(e.g., Burnham et al. 1980).”  These statements are valid and they make us wonder why previous 
biologists did nothing to address problems with the traditional technique when much better 
techniques have been available for decades.  We are updating the survey, and the methods we use 
are tested and established. 


 
16. Page 5, line 6.  After the sentence ending “data.”  Add the two sentences from Page 2 Line 9-12 
 


We edited as suggested. 
 
17. Page 5, line 7.  Replace “rigorous, defensible” with “statistically rigorous” 
 


We removed the word defensible. 
 
18. Page 5, Line 9.  Add another paragraph with this text:  Quantifying winter mortality will not be a 


stated objective of this monitoring protocol due to the multiple factors previously identified 
regarding group structure and location data of unmarked birds.  Estimates of mortality will require 
an additional protocol. 


 
We refrained from adding this sentence because we will not be developing an additional protocol to 
estimate winter mortality.  Winter mortality has little influence on population change but 
recruitment and mortality during migration have large influence on population change (Butler et al. 
in prep.).  This protocol indexes recruitment but radio- or GPS-telemetry based monitoring are 
probably the only ways to better understand the causes of mortality (this is an ongoing research 
project). 


 
We did add the statement, “mortality estimates are better derived from radio- or GPS-telemetry 
based monitoring of a sample of the population,” to the “Element 1, Traditional “census” effort” 
section. 


 
19. Page 5, line 14.  Replace “defensible” with “robust” 
 


Ok, thank you. 
 
20. Page 5, line 17.  Delete “including the delineation of critical habitat”  Critical habitat has already 


been established and until such time that the Service formally decides to modify the critical habitat 
units I would refrain from stating that this will be one of the uses of the data. 


 
Good catch; we did not intend for this to mean “critical habitat” in the legal sense of the term.  We 
have changed term to “important habitat.” 


 
21. Page 5, line 20-22.  I think being able to statistically show a 10 to 15% decline over a three year 


period is exactly what we should be striving for.  This would be a 3-5% decline annually.  This does 
not seem to match the text in Butler et al. 2013 which is used as a reference here.  


 
We did not provide enough detail for the power analysis and justification of the objectives.  Thank 
you for catching that.  Butler et al. (2013) identified scenarios that would significantly reduce 
abundance from the current trajectory and delay reaching the downlisting goal of 400 birds by >5 
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years.  Those scenarios were >3 consecutive years of –9.5% annual decline or >2 consecutive years 
of –14% annual decline.  To estimate one growth rate, 2 years of abundance estimates are needed.  
Therefore, we need to be able to detected a –9.5% annual decline over a 4-year period or a –14% 
annual decline over a 3-year period.  We have now provided this information in the new section, 
“Justification of objectives” in Element 1.  We have also reworded the objective to better reflect 
this.  “Provide an estimate of whooping crane abundance within the surveyed area (see Element 3, 
Sampling frame) with enough precision to detect a 10–15% annual population decline over a 3- to 4-
year period (see justification provided in Butler et al. 2013).” 


 
To detect a –15% annual decline over a 3-year period, a CV of 6% is needed and to detect a –10% 
annual decline over a 4-year period, a CV of 9% is needed.  Based on the winter 2010–2011 pilot 
work, we estimated 6 surveys would result in a CV of 7%.  Based on the surveys conducted during 
January 2012, we estimated 5 to 6 surveys would result in a CV of 9% and 10 to 13 would result in a 
CV of 6%.  We show a range in Table A1 because the number of surveys needed to reach a given CV 
depends on whether data are analyzed using HDS or CDS (see new note in Table A1).  We have also 
updated Table A1 with additional effort estimates.  We are recommending that at least 6 surveys be 
conducted (see Element 3, section Survey repetition and sample size); this does not mean more 
surveys cannot be conducted.  However, our experience suggests that 7 or 8 surveys per year is 
about the logistical limit that can be accomplished in the 2-week window. 


 
Note, that Butler et al. (2013) recommended being able to detect a –15% annual decline over a 2-
year period or a –10% annual decline over a 3-year period to allow enough time to respond to the 
scenarios.  This would require 4% to 6% CV which can be easily obtained by pooling data from 
multiple years as Reviewer #2 recommended in comment #20. 


 
We think it is worth noting that detection of a 5% annual decline over the course of 2 years would 
require a CV of approximately 1.5%.  Such precision is rather impossible; thus, suggesting that the 
revised survey detect a 3 to 5% decline annually is also unreasonable.  However, detection of a 3–5% 
annual decline over a 10-year period, instead of a 2-year period, would require a CV of 14–26%.  This 
might be a meaningful alternative to detecting the scenarios outlined in Butler et al. (2013) since 
this population has grown at an average of 3.9% per year since winter 1938–1939, and has exhibited 
a 10-year cycle in population growth (Boyce and Miller 1985, Boyce 1986, Butler et al. 2013). 


 
22. Page 6, Line 36-42.  Including figure 3.  It might be better to show the plot of the raw data as 


opposed to the selected cut-intervals of 100 m.  I assume this was done to improve the model fit but 
maybe there needs to be some explanation here. 


 
Frequency data are never shown as raw data but histograms.  This Reviewer implies that the model 
we used to determine detection probability during the winter 2010-2011 surveys was based on 
binned data but it was not (see Strobel and Butler 2014).  Since the draft protocol was reviewed, a 
Wildlife Society Bulletin paper (Strobel and Butler 2014) has been published that describes the pilot 
work in great detail.  We have added the citation to appropriate places throughout the protocol. 


 
23. Page 6, line 40-42.  I think I know what the authors are trying to say here but this seems a case of 


mixing “apples and oranges”.  This would be true if the traditional survey technique had fixed 
transects but because the traditional technique varied transect width and intentionally made 
excursions off transect to verify bird identification the observer could have counted all the birds and 
then sum.  Because there is no way of quantifying the error associated with the traditional survey 
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technique it is not correct to say that the detectability was < 1.  I think I would recommend deleting 
lines 40-42 and replace it with a statement like “Because distance from the transect line clearly 
affects detection then a distance modeling approach is necessary to statistically estimate the 
number of whooping crane groups that were not detected along the transect.”  


 
This comment is incorrect.  We show that detectability was less than one (see Strobel and Butler 
2014).  The assumption that the observers made during the traditional technique was that they 
could, after multiple surveys, figure out all the individuals in the population (even though most were 
unmarked).  Clearly detectability was less than 100% during an individual survey.  Figure 2 shows 
that for many years the maximum number of whooping cranes counted was often less than the 
reported abundance; hence, detection less than 100%.  For example, the population was reported to 
have been comprised of 264 birds in 2009, but surveys from that year reported from 201 to 268 
birds.  Again, there are a lot of misconceptions about the traditional technique and that is why the 
critique is so important. 


 
24. Page 8, line 1-2.  Why would the authors try and gauge distance based on marks on the struts?  Even 


in the traditional census groups were marked on paper DOQQ’s.   
 


The use of marks on struts to measure distance from transect during aerial surveys is a common 
technique (e.g., Caughley et al. 1976, Guenzel 1997, Butler et al. 2007).  That is why we considered 
it. 


 
25. Page 8, line 21-24.  Rewrite to:  “Angle of the sun significantly affected detection of whooping crane 


decoys in our pilot study.  Stehn and Taylor (2008) also noted that sun angle affected detection of 
whooping cranes during the traditions census.  To minimize the effect of sun angle we 
recommend…..” 


 
The sentences in question are “The traditional census was conducted during the morning and 
afternoon with a break for lunch (Stehn and Taylor 2008).  Therefore, much of the survey effort was 
accomplished when the sun was at lower angles resulting in high detectability on one side of the 
aircraft but low detectability on the other.   We recommend…”  We edited those sentences as 
follows, “The angle of the sun significantly affected detection of whooping crane decoys in our pilot 
study.  Though Stehn and Taylor (2008) also noted that sun angle affected detection of whooping 
cranes, the traditional census was conducted during the morning and afternoon with a break for 
lunch.  Therefore, much of the survey effort was accomplished when the sun was at lower angles 
resulting in high detectability on one side of the aircraft but low detectability on the other.  We 
recommend…” 


 
26. Page 9, line 20.  Replace “defensible” with “rigorous” 
 


Change made. 
 
27. Page 11, line 6.  Delete the last sentence in the Figure 6 caption.  This sentence is not germane to 


the methods. 
 


The caption of Figure 6 was “Figure 6.  The sampling frame for monitoring whooping crane on their 
wintering grounds along the Texas gulf coast, USA.  These were not formally defined during the 
traditional “census” effort.”  We retained this sentence because we want to be clear that a formally 
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defined sampling frame is new to the revised technique.  We believe this sentence is important for 
the reader to understand how the revised technique compares with the traditional technique.  
Further, our critique of the traditional technique must be open and transparent in order to increase 
understanding for why we established the new technique. 


 
28. Page 12, line 2.  Delete “scientifically defensible” and replace with “statistically rigorous”  
 


We deleted “scientifically defensible.” 
 
29. Page 12, line 8-12.  I understand what the authors are saying here; however, I think reports should 


include not only those estimates made from the PSF but also legitimate counts from areas well 
outside of the sampling frame.  In addition if qualified observers can verify that they were watching 
a group of cranes that are outside the sampling frame the entire time a survey was taking place the 
reports should also add these birds to the peak count. 


 
We added the following to the new section, “Element 7, comparison with estimates from the 
traditional technique.” 


 
“Whooping cranes observed outside of the primary sampling frame will be reported separately and 
identified according to the source of the observation (e.g., Texas Whooper Watch, satellite 
transmitter, or secondary sampling frame during aerial survey efforts).  However, adding these 
reported birds to the estimate presents potential problems.  For example, we cannot ever be 
completely certain that whooping cranes observed outside the primary sampling frame on one day 
did not move to or from the primary sampling frame before the surveys were completed.”   


 
30. Page 12, line 28.  I am not sure what relevance this sentence has to the analyses.  In fact, I cannot 


tell from Appendix C how regions are treated. 
 


The sentence in question reads, “The sampling units for this design can be considered in a 
hierarchical or nested sense (Figure 7).”  This sentence is simply an introductory sentence to a 
paragraph that explains how the sampling design was constructed in a hierarchical manner.  The 
regions, primary and secondary sampling frames, are treated differently in that data from the 
secondary sampling frame are not included in the analysis since so few whooping cranes currently 
inhabit it.  Please refer to the “Element 3, Sampling frame” section among other places throughout 
the protocol. 


 
It looks to me like each 1km2 along the transects are treated as independent samples and all used in 
the quantification of groups within the PSF. 


 
Yes, the 1-km2 grid cells are used as the sampling unit for abundance of groups.  However, the 
groups themselves are the sampling unit for detection probability.  Thus, the hierarchical nature of 
this sampling design. 


 
31. Page 12, lines 32, 38 and 39.  The 1-km2 segments, how will they be characterized?  I assume that 


the entire segment will be given one vegetation class.  If this is correct then the 1-km2 may be too 
large.  I think the TPWD classification effort had a 10-m resolution. (I found later that each 1-km2 will 
have 6 classes).  This language should be inserted here. 
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No, each 1-km2 grid cell will not be given one vegetation class.  This is not the appropriate place to 
discuss the environmental covariates used since this section is about the sampling design not 
modeling.  We inserted a note to refer readers to “Element 4, Environmental covariates” section for 
more information on the environmental covariates used. 


 
32. Page 15, Box Plot.  The authors give good rational for conducting peak abundance surveys during the 


4 week period beginning November 28th; however by looking at the box plot it looks like it doesn’t 
matter as long as the surveys are conducted between November 28th and March 27th. 


 
If we allowed surveys to be conducted over a 4-month period instead of a small temporal window, 
surveys would be less comparable from year to year.  For example, if surveys were conducted during 
December one year resulting in an estimate of 270 then March the next year resulting in an 
estimate of 260, one might be tempted to suggest that the population declined between those two 
years.  However, the second estimate accounts for winter mortality (or emigration) whereas the first 
estimate does not.  To ensure comparability from one year to the next, surveys need to be 
conducted during the same time period.  To facilitate comparison with the traditional technique 
which aimed to provide estimates of “peak” abundance (i.e., abundance post fall-migration prior to 
any winter mortality), then December is the most appropriate time period. 


 
33. Page 16, line 2-3.  I think this sentence is missing something.  Maybe it should stay “3-6 surveys will 


be required to obtain a CV(N) low enough to detect a 10% decline.”  In addition the stated goal is to 
be able to detect a 10-15% decline over 3 years that would be a 3-5% decline each year.  According 
to figure A2, regardless of time (2 year or 3 years) the method should be able to detect a 10-15 
decline which will require a CV(N) of between .035 and .053. 


 
See our response to Reviewer’s comment #21; we have rewritten the section as per our response in 
comment #21. 


 
34. Page 17, line 8-21.  The statement that the population is approximately 15 years from reaching 400 


birds does not seem to be supported by (Butler et al. 2013).  By looking a Figure 1 in this citation it 
looks to me like 400 birds could be attained as soon as 2017 and at the latest 2027.  Even the text 
gives a 50% chance of reaching 400 birds by 2023.  It seems likely that we could have 400 birds in 
the next 7 years; therefore to suggest that monitoring be conducted every other year seems 
inappropriate.  I would say that reaching a potential downlisting criterion in as few as 4 years seems 
pretty imminent. 


 
The recovery probability (i.e., probability of reaching 400 birds) did not exceed 80% until 2025.  The 
15 years out was from winter 2010 (last year of the data used in Butler et al. 2013).  We have 
revised this statement to read “this whooping crane population is ≈12 years from reaching 400 
individuals.”  The Reviewer is correct that we have a 50/50 chance of reaching 400 birds by 2023.   
However, reaching 400 birds by 2017 is by no means imminent (4% probability). 


 
I would suggest this section be rewritten to simply state that the monitoring will be conducted 
annually and that frequency will be revisited with each major revision of this document. 


 
We choose to keep this discussion about the utility of annual monitoring since it is an important 
topic one must consider given limited budgets and much priority work.  If the precision of 
abundance estimates from the new technique reach the levels predicted by Appendix A (now that 
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the bugs have been worked out of the protocol), biennial monitoring must be considered given the 
reasons discussed in the section. 


 
35. Page 17, line 28.  The web link does not work.  I suggest you remove the link. 
 


We have corrected the web link.  TPWD recently moved the data.  Thank you. 
 
36. Page 17, line 41.  Delete the sentence “Tests of marks on struts…..”  I am not sure why marks on 


struts was ever explored, even the traditional technique used DOQQ’s. 
 


The use of marks on struts to measure distance from transect during aerial surveys is a common 
technique (e.g., Caughley et al. 1976, Guenzel 1997, Butler et al. 2007).  That is why we considered 
it.  We choose not to delete this sentence. 


 
37. Page 18, line 30.  Sentence beginning “However,….” needs a citation, or change the word “will” to 


“should” 
 


We have provided citations, thank you. 
 
38. Page 20, line 30.  The use of gloves is probably not practical. 
 


Leather gloves maybe used instead of Nomex gloves; see ALSE Handbook.  We changed “Nomex 
gloves” to “Nomex or leather gloves.” 


 
39. Page 21, line 1-7.  General Comment:  Having a ridged standardized protocol and a good repeatable 


survey design means that just about anybody should be able to conduct the survey and get similar 
results.  If this is true it might open the door to have the surveys contracted out.  I am certainly not 
advocating this approach now, but down the road once all the kinks are worked out, significant cost 
savings could be realized. 


 
Perhaps contracting the survey in the future is possible.  However, regardless of the future potential 
for contracting the work, at least any USFWS employee with a little training will be able to conduct 
the survey. 


 
40. Page 24, line 24.  Change the word “follow” to “following” 
 


Corrected, thank you. 
 
41. Page 24, line 45.  Web link does not work. 
 


We have corrected the web link.  TPWD recently moved the data.  Thank you. 
 
42. Page 24, line46-Page 25, line 7.  Incorporate this language into Page 17 line 23-33 and Page 12 line 


36-42. 
 


Good idea.  We add “The percent of each 1-km2 transect segment is determined for 6 general 
vegetation types: saltmarsh, open water, wetland, saltmarsh-shrubland, upland, and urban 
(Appendix E).  Though these covariates are only rudimentary, strong relationships with whooping 
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crane abundance has been demonstrated with some of them (Strobel et al. 2012).” to the “Element 
3, Environmental covariates” section. 


 
43. Page 44, Appendix C.  Conduct data analyses and prepare reports.  Appendix C Makes no mention of 


reports and who is responsible for them.  Somewhere in this document it should specifically state 
who will be writing the reports. 


 
You are correct that preparing reports is not discussed in Appendix C.  We have corrected this in the 
“Overview of the Whooping Crane Abundance Protocol” section.  We have also added “Compilation 
of reports will be a collaborative effort among the Lead Biologist, Regional Biometrician, Regional 
Data Manager, and Whooping Crane Recovery Coordinator (see Element 8, Roles and 
responsibilities).” to the “Element 7, Reports” section and the “Element 8, Roles and 
responsibilities” section. 


 
44. Page 87, Appendix C:  General comment:  This appendix is well written with the exception of a typo 


on Page 92, line 2. 
 


Thank you, the sentence now reads “If a significant (typically α = 0.15 is used) negative slope is 
found, this suggests larger groups tend to be detected at greater distance than smaller ones.” 


 
In the paragraph starting on line 30 of Page 97 the authors recommend pooling data from repeated 
surveys prior to running the model.  Because cranes are territorial groups detected along repeated 
transects are likely to be correlated.  I am not sure how this correlation affects model results but I 
would think you would want to look at how closely repeated transects are correlated prior to 
pooling them; however, I am not a statistician. 


 
We are unsure what the comment is trying to get at.  Pooling data from transects is standard 
practice for distance sampling-based surveys (see Buckland et al. 2001).  We pool repeated transects 
to avoid treating them as if a repeated survey is an independent sample.  We do not treat additional 
surveys of a transect as independent surveys.  Instead, we pool data from repeat visits of a transect 
and treated it as one transect which is the correct way to account for the dependence described in 
the comment.  This ensures we are not inflating the sample size at the transect level. 


 
General Comments: 
 
1. Overall, I am pleased to see the Service move to a standardized method that allows for quantifying 


error associated with estimating crane abundance. 
 


Thank you.  We are glad to see this Reviewer understands the importance of standardizing survey 
techniques for whooping cranes. 


 
I have made numerous suggested changes within this document in regards to the use of the term 
“scientifically defensible”.  Although the authors are technically correct to use this language, in this 
situation, I would refrain from it.  In my opinion, the authors spent an inordinate amount of time 
pointing out flaws in the original census method that were presumably used to justify changing 
methods.  A simple short paragraph detailing that the original census technique lacked a formal 
repeatable protocol and did not provide quantitative estimates of error would suffice.  After all, this 
is intended to be a written standardized protocol not a justification for changing methods. 







Page | 42  
 


 
We disagree that too much of the protocol was spent on critiquing the traditional technique.  As 
stated before, less than 4 pages of a document containing over 150 pages was devoted to critiquing 
the traditional technique.  Many Reviewer comments revealed misconceptions about the traditional 
technique which has further emphasized the need for critiquing it.  Therefore, we have chosen to 
include the description and critique of the traditional survey technique.  We feel that to “justify 
changing methods” is an important component of any new survey protocol. 


 
The new protocol is without doubt statistically rigorous, so there is no need to use the term 
“scientifically defensible”.  The repeated use of this language throughout this document seems to 
convey to readers that past practices were not defensible. This is a mistake that should be avoided 
because the Service is not only judged in courts of law but also in the court of public opinion.   


 
The term “scientifically defensible” was only used twice in the review draft and the term 
“defensible” was used 6 times.  The term “defensible” now only appears twice.  The new technique 
is “scientifically defensible” whereas the old technique was not.  It is not a mistake to point out 
deficiencies in our methods so we can understand them and make corrections.  We hope future 
efforts improve the new techniques when needed. 


 
It is ironic that the very data in question with all its unquantifiable flaws was used by the authors to 
publish Butler et al 2012 and that publication used in this document to determine precision and 
suggest less frequent monitoring.  This irony will not be lost on other readers. 


 
The traditional technique resulted in 4 to 21 surveys per year (mean = 12.7, SD = 4.2; Butler et al. in 
prep).  We are planning on conducting 6 surveys per year.  Sure that is fewer, on average, than the 
traditional technique but we did not use data from the traditional technique to determine power.  
We based power decisions on our pilot efforts and the first year of surveys using the new technique.  
To determine the precision needed, we had to determine the amount of change that needed to be 
detected.  The Butler et al. (2013) paper used data from the traditional technique to better 
understand this population’s dynamics.  We are sure the Butler et al. (2013) authors would have 
preferred to have used data with fewer flaws but nothing else was available.  None the less, that 
work shows a 10 to 15% decline must occur for 2 to 3 years to substantially delay recovery.  In the 
absence of better survey data, we used the best available data to inform our monitoring objectives.  
Data were used cautiously, based on the assumptions used to acquire them. 


 
2. With any new technique there will be growing pains and, unfortunately, since this method has been 


used in the last two seasons it has yielded what should be considered unacceptable levels of 
variation.  I think that the CV(N) was around 0.12 in the first year and close to 0.13 in the second.  
Based on the table provided, on Page 83, it would take a 40 to 50% decline over a 4 year time period 
before a statistically significant difference could be shown.  This certainly does not approach the 
stated goal of detecting a 10 to 15% decline over 3 years.  Much effort should be expended to 
understand why the technique has performed so poorly.  As a person that has been in the plane I 
can positively state that I have contributed to this variation due to at least one instance of voice 
recording error.  This technique has many moving parts and does require a fair bit of training.  I 
concur with the authors’ recommendations for training of new counters and becoming very familiar 
with the equipment and software prior to conducting surveys.  Although training of counters will 
help decrease variation I do not think it will solve the whole problem. 
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The first year of the new survey resulted in a CV of 12% and the second year of the new survey 
resulted in a CV of 19%.  Due to unfortunate constraints during the first year, only 3 surveys were 
conducted that met the protocol criteria.  During the second year, new observers misunderstood 
some of the protocol requirements and data collection procedures which resulted in only one 
useable survey for that year.  Now that all the kinks have been worked out, the full survey effort of 6 
surveys should result in the precision discussed in Appendix A (CV < 8%) which is enough to detect 
the change outlined in sampling objective 1. 


 
A more rigorous and in-depth decoy study would help in understanding all of the sources of 
variation. 


 
The decoy study we conducted was elaborate and much was learned (see Strobel and Butler 2014).  
We see no reason at this time to conduct another decoy study since all the decoy study does is help 
us better understand the detection process.  Most of the variation in the estimate is due to variation 
in encounter rates not the detection process.  The variation in encounter rates (i.e., the spatial 
distribution of whooping crane abundance) cannot be effectively studied with a decoy experiment. 


 
3. The technique relies on being able to accurately develop a detection curve, but when there are two 


observers each may have different detection probabilities.  How are these reconciled when half of 
one transect and therefore, half of each 1 km2 have different detection probabilities? 


 
Distance sampling is pooling robust which means that it is extremely robust to variation in 
detectability due to factors other than distance, such as observers, habitat conditions, and weather 
(Thomas et al. 2006). 


 
4. Are all the transects of a given observer on the same day used to model the detection curve or are 


curves modeled for each transect? 
 


There are not enough detections on a given transect to model a detection curve for each transect 
nor is modeling transect-specific detection curves normal practice for distance sampling.  There are 
not enough detections on a particular survey day to model a detection curve for each survey either 
(though we could use survey day as a covariate in the detection model).  See discussion about 
pooling robustness above.  We are considering using habitat covariates in the detection models but 
doubt it will improve the precision of the final abundance estimates much. 


 
5. Were the decoy experiments conducted with two observers?  I think much could be learned through 


an elaborate decoy study. 
 


Yes, the decoy experiments were conducted with two observers.  We added a note in this section 
that two observers were used.  This was an elaborate decoy study and much was learned (see 
Strobel and Butler 2014). 


 
6. Are each of the 6 surveys within the two week window used as separate samples or is all the data 


pooled as seems to be suggested in Appendix C? 
 


All the data are pooled in the analysis which is appropriate since multiple surveys of the same 
transect cannot be treated as independent samples.  See page 79 in Buckland et al. (2001). 
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7. Finally I would like to commend the authors for developing such and in-depth protocol and series of 
standard operating procedures.  As biologists and ecologists, we should always strive to collect the 
most meaningful data possible and ensure that our techniques are properly documented and tested. 


 
Thank you for the complement; this protocol would not have been possible without the contribution 
of many others, as we now note in the acknowledgements section of the protocol. 
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Appendix.  R code to demonstrate generalized HDS for a “full-coverage design.” 


library("MASS") 
library("unmarked") 
 
R=10 # number of transects 
tr=6  # number of replicates 
sw=50 # Strip width (transect half-widt). 
tl=sw*2*R # Transect length. 
Q=tl/(sw*2) 
# This results in 10 transects that are 100 m wide over a landscape that 
# is 1,000 x 1,000 m.  Therefore, this landscape would be composed of 
# 100 grid cells that are 10,000 m². 
 
# Average abundance/grid cell for the two habitat types. 
lambda1=2.0 
lambda2=0.5 
 
sigma=30 # Half-normal shape parameter for the detection curve. 
 
# Home range shape. 
hr.shape=matrix(c(500,0,0,500),2,2) 
 
# So we want animals to be moving in and out of each cell. This plot 
# demonstrates the posible distances moved between surveys. 
plot(mvrnorm(1000,c(0,0),hr.shape)) 
 
# Function to locate each animal during a survey. 
location=function(n,center){mvrnorm(n,center,hr.shape)} 
 
it=1000 # Number iterations. 
 
# Make a data frame to hold results. 
A=as.data.frame(matrix(NA,it,6)) 
names(A)=c("phi","lambda1","lambda2","abun.pred","abun.est","abun.true") 
 
# Start the simulation loop. 
for (B in 1:it){ 
 
  # Make grid cell centers. 
  cell.centers=cbind(sort(rep(seq(sw,R*sw*2-sw,sw*2),R)),rep(seq(sw,tl-


sw,sw*2),R)) 
 
  # Split the landscape into 2 habitat types. 
  


cell.centers=cbind(cell.centers,sample(c(rep(1,floor((R*Q)/2)),rep(0,ce
iling((R*Q)/2))))) 


 
  # Make an empty column to add lambdas. 
  cell.centers=cbind(cell.centers,matrix(NA,R*Q,1)) 
 
  # Assign lambdas to their habitat types. 
  for (i in 1:(R*Q)){ 
    if (cell.centers[i,3]==1) 
      cell.centers[i,4]=lambda1 
    else 
      cell.centers[i,4]=lambda2 
  } 
 
  # Make cell.centers a data frame and name variables. 
  cell.centers=as.data.frame(cell.centers) 
  # Add an empty column to add the randomly selected abundance for each cell. 
  cell.centers=cbind(cell.centers,matrix(NA,R*Q,1)) 
  names(cell.centers)=c("c.x","c.y","type","lambda","n") 
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  # Randomly select abundance for each cell based on Poisson distribution. 
  for (i in 1:(R*Q)){ 
    cell.centers$n[i]=rpois(1,cell.centers$lambda[i]) 
  } 
 
  # Make a data frame to hold the home range centers for each animal in the 


population. 
  home.center=as.data.frame(matrix(NA,1,5)) 
  names(home.center)=c("c.x","c.y","type","lambda","n") 
 
  # Fill up the home range centers data frame. 
  for (i in 1:(R*Q)){ 
    if (cell.centers$n[i]>0) 
      for (j in 1:cell.centers$n[i]){ 
        home.center=rbind(home.center,cell.centers[i,1:5]) 
      } 
    else 
      home.center=rbind(home.center,cell.centers[i,1:5]) 
  } 
  home.center=home.center[-1,] 
 
  # Make two empty columns to hold the x and y for the home range centers. 
  home.center=cbind(home.center,matrix(NA,length(home.center$n),2)) 
  names(home.center)=c("c.x","c.y","type","lambda","n","hr.x","hr.y") 
 
  # Randomly select the home range centers. 
  for (i in 1:length(home.center$n)){ 
    if (home.center$n[i]>0) 
      home.center$hr.x[i]=home.center$c.x[i]+runif(1,-45,45) 
    else 
      home.center$hr.x[i]=NA 
    if (home.center$n[i]>0) 
      home.center$hr.y[i]=home.center$c.y[i]+runif(1,-45,45) 
    else 
      home.center$hr.y[i]=NA 
  } 
 
  # Make a plot to visualize where the animals in the population live. 
  # 


plot(home.center$c.x[home.center$type==1],home.center$c.y[home.center$t
ype==1],pch=18,col="red",xlim=c(-50,R*sw*2+sw),ylim=c(-50,tl+sw)) 


  # 
points(home.center$c.x[home.center$type==0],home.center$c.y[home.center
$type==0],pch=18,col="blue") 


  # 
points(home.center$hr.x[home.center$type==1],home.center$hr.y[home.cent
er$type==1],pch=4,col="red") 


  # 
points(home.center$hr.x[home.center$type==0],home.center$hr.y[home.cent
er$type==0],pch=4,col="blue") 


 
  # A data frame to hold animal locations during each survey. 
  movement=cbind(home.center,matrix(NA,length(home.center$n),tr*2)) 
 
  # Just some code to name the columns. 
  x=factor(seq(1,tr,1)) 
  aa=NA 
  for (i in 1:length(x)){ 
    aa=c(aa,paste("x.",x[i],sep=""),paste("y.",x[i],sep="")) 
  } 
  aa=aa[-1] 
  names(movement)=c("c.x","c.y","type","lambda","n","hr.x","hr.y",aa) 
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  # Randomly select each animals location during a survey; location based on 
home range center and shape. 


  for (i in 1:length(movement$n)){ 
    for (t in 0:(tr-1)){ 
      


movement[i,(t+t+8):(t+t+9)]=location(1,c(movement$hr.x[i],movement$hr.y
[i])) 


    } 
  } 
 
  # Make a plot to visualize where the animals in the population live and 


their movement. 
  # 


plot(home.center$c.x[home.center$type==1],home.center$c.y[home.center$t
ype==1],pch=18,col="red",xlim=c(-50,R*sw*2+sw),ylim=c(-50,tl+sw)) 


  # 
points(home.center$c.x[home.center$type==0],home.center$c.y[home.center
$type==0],pch=18,col="blue") 


  # 
points(home.center$hr.x[home.center$type==1],home.center$hr.y[home.cent
er$type==1],pch=4,col="red") 


  # 
points(home.center$hr.x[home.center$type==0],home.center$hr.y[home.cent
er$type==0],pch=4,col="blue") 


  # for (i in 0:(tr-1)){ 
  #   points(movement[,(i+i+8)],movement[,(i+i+9)],pch=20) 
  # } 
 
  # Remove all locations that are outside of the sampling frame. 
  


movement[cbind(matrix(TRUE,length(movement$type),7),(movement[,8:(7+tr*
2)]>0))==FALSE]=NA 


  
movement[cbind(matrix(TRUE,length(movement$type),7),(movement[,8:(7+tr*
2)]<(sw*2*R)))==FALSE]=NA 


  for (i in 0:(tr-1)){ 
    movement[is.na(movement[,(i+i+8)]),(i+i+9)]=NA 
    movement[is.na(movement[,(i+i+9)]),(i+i+8)]=NA 
  } 
 
  # Make a plot to visualize where the animals in the population live and 


their movement. 
  # 


plot(home.center$c.x[home.center$type==1],home.center$c.y[home.center$t
ype==1],pch=18,col="red",xlim=c(-50,R*sw*2+sw),ylim=c(-50,tl+sw)) 


  # 
points(home.center$c.x[home.center$type==0],home.center$c.y[home.center
$type==0],pch=18,col="blue") 


  # 
points(home.center$hr.x[home.center$type==1],home.center$hr.y[home.cent
er$type==1],pch=4,col="red") 


  # 
points(home.center$hr.x[home.center$type==0],home.center$hr.y[home.cent
er$type==0],pch=4,col="blue") 


  # for (i in 0:(tr-1)){ 
  #  points(movement[,(i+i+8)],movement[,(i+i+9)],pch=20) 
  # } 
 
  # Make a data frame to hold distance data. 
  locs=as.data.frame(matrix(NA,1,5)) 
 
  # Fill that data frame. 
  for (i in 0:(tr-1)){ 
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    x=(findInterval(movement[,(i+i+8)],seq(0,tl,sw*2))-
findInterval(movement$c.x,seq(0,tl,sw*2)))*100 


    y=(findInterval(movement[,(i+i+9)],seq(0,tl,sw*2))-
findInterval(movement$c.y,seq(0,tl,sw*2)))*100 


    x[is.na(x)]=0 
    y[is.na(y)]=0 
    


locs=rbind(locs,(cbind(movement$c.x+x,movement$c.y+y,i+1,movement[,(i+i
+8)],movement[,(i+i+9)]))) 


  } 
  names(locs)=c("c.x","c.y","time","x","y") 
  locs=locs[-1,] 
 
  # Assign habitat types. 
  for (j in 1:length(locs$c.x)){ 
    


locs$type[j]=cell.centers$type[(cell.centers$c.x==locs$c.x[j])&(cell.ce
nters$c.y==locs$c.y[j])] 


  } 
 
  # Calulate distance from transects. 
  locs$dist=abs(locs$c.x-locs$x) 
 
  # Estimate detection probability. 
  locs$p=exp(-locs$dist^2/(2*sigma^2)) 
 
  # Determine if it was detected or not. 
  locs$det=rbinom(length(locs$c.x),1,locs$p) 
  locs$det[locs$det==0]=NA 
  locs$det.dist=locs$det*locs$dist 
  # Make cell IDs. 
  locs$ID=paste(locs$c.x,locs$c.y,sep="") 
 
  # Get a list of unique cell IDs. 
  ids=unique(locs$ID) 
 
  # Distance breaks. 
  breaks=seq(0,50,by=10) 
 
  # An array to put the data in. 
  y=array(NA,c(R*R,length(breaks)-1,tr)) 
 
  # Fill the array. 
  for (t in 1:tr){ 
    for (i in 1:length(ids)){ 
      


y[i,,t]=table(cut(locs$det.dist[(locs$time==t)&(locs$ID==ids[i])],break
s,include.lowest=TRUE)) 


    } 
  } 
 
  # Convert array to matrix 
  y=matrix(y,nrow=R*R) # convert array to matrix 
 
  # Organize the data for analysis with unmarked. 
  


umf=unmarkedFrameGDS(y=y,survey="line",unitsIn="m",dist.breaks=breaks,t
length=rep(sw*2,R*R),numPrimary=tr,siteCovs=data.frame(type=cell.center
s$type)) 


 
  # Fit the generalized HDS model. 
  m1=gdistsamp(~type,~1,~1,umf,output="density") 
 
  # Get lambda estimates from the model. 
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  A[B,2:3]=exp(coef(m1,type="lambda")) 
 
  # Get phi estimate from the model. 
  A$phi[B]=(exp(coef(m1,type="phi"))/(1+exp(coef(m1,type="phi")))) 
 
  # Get predicted abundance (unadjusted) from the model. 
  A$abun.pred[B]=sum(predict(m1,type="lambda")$Predicted) 
 
  # Get predicted abundance (adjusted) from the model. 
  A$abun.est[B]=sum((predict(m1,type="lambda")$Predicted)*A$phi[B])  
   
  # Get true abundance of the population. 
  A$abun.true[B]=sum(cell.centers$n) 
 
} 
 
# True abundance. 
true.abundance=(lambda1*(R*Q)/2)+(lambda2*(R*Q)/2) 
 
# Estimate Bias. 
A$Bias=(true.abundance-A$abun.est)/A$abun.true 
mean(A$Bias) 
quantile(A$Bias,probs=c(0.025,0.975)) 
 
# Look at mean lambdas. 
mean(A$lambda1) 
quantile(A$lambda1,probs=c(0.025,0.975)) 
mean(A$lambda2) 
quantile(A$lambda2,probs=c(0.025,0.975)) 
 
# Look at the adjusted abundance estimates. 
mean(A$abun.est) 
quantile(A$abun.est,probs=c(0.025,0.975)) 
 
# Look at the adjusted abundance estimates. 
mean(A$abun.pred) 
quantile(A$abun.pred,probs=c(0.025,0.975)) 
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Executive Summary 


The annual abundance of the Aransas-Wood Buffalo whooping crane (Grus americana) flock, 


which overwinters along the Texas gulf coast, USA, has been enumerated using aerial surveys 


since 1950.  When aerial surveys began the flock consisted of fewer than 30 individuals that 


wintered on the Blackjack Peninsula and Matagorda Island of the Aransas National Wildlife 


Refuge (NWR).  Since that time the Aransas-Wood Buffalo flock has dramatically increased its 


population size and the area of its wintering grounds. 


 


Although whooping crane surveys have been conducted for over 60 years, a formal protocol, 


including survey objectives, survey methods, sampling frame, data analyses, and reporting 


procedures, was never completed.  Stehn and Taylor (2008) briefly described the aerial survey 


methods employed from 1982–2011 and they identified multiple factors that hampered the 


defensibility of survey methods including the imperfect detection of whooping cranes.  In 2011, 


the U.S. Fish and Wildlife Service (USFWS) re-evaluated the objectives and methods of the 


traditional aerial survey technique and determined that as the whooping crane population 


increases, the traditional methods would become increasingly insufficient at providing the data 


needed for conservation.  Regional and refuge staff then launched a multifaceted effort to 


improve the survey methods and develop a statistically rigorous technique. 


 


This protocol is primarily designed to provide a mechanism for monitoring trends in whooping 


crane abundance on their wintering grounds along the Texas gulf coast.  Secondarily, the 


protocol provides mechanisms for monitoring recruitment rates, the number of whooping crane 


pairs that recruited young into the winter flock, and whooping crane winter range expansion.  


Finally, this protocol is designed to augment planning and conservation efforts with information 


about the relationships among local whooping crane abundance and habitat or environmental 


characteristics. 


 


Imperfect detection of individuals present in the survey area will result in inaccurate estimates of 


abundance unless the resulting bias is corrected.  Distance sampling is a tractable, widespread 


approach used to correct for the bias that results from imperfect detection and has been used in 


aerial surveys to estimate density of many bird and mammal species.  Recent theoretical 


advances (i.e., hierarchical distance sampling models) have resulted in models that explicitly 


consider relationships between local abundance and environmental covariates (known as 


spatially-explicit models of abundance) while controlling for detectability.  Such models are 


attractive because they can be used to understand ecological relationships among whooping 


crane abundance and environmental conditions while accounting for imperfect detection.  This 


protocol exploits line transect-based distance sampling and hierarchical models of abundance for 


monitoring whooping cranes on their wintering grounds. 


 


The survey methods provided in this protocol are a defensible, statistically rigorous means to 


estimate the annual abundance, and associated degree of confidence, of whooping cranes 


wintering within the sampling frame.  Furthermore, the survey methods provide for defensible 


estimates of the number of whooping crane pairs and the number of pairs that recruited young 


into the winter flock, which are downlisting criteria identified by the International Recovery Plan 


for whooping cranes.  Finally, the use of hierarchical distance sampling provides spatially-
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explicit maps of whooping crane abundance.  The predictive models used to create these maps 


provide a better understanding of whooping crane resource use, which will guide whooping 


crane conservation efforts.  They also inform management, identify potentially important future 


whooping crane habitat, and direct land conservation and development initiatives.
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Survey Protocol Narrative 


Element 1: Background and Objectives 
 
Background 


Whooping cranes (Grus americana), an endangered species, declined to near extinction by 1941 


(Canadian Wildlife Service [CWS] and U.S. Fish and Wildlife Service [USFWS] 2007).  


Historically, whooping cranes existed at low densities throughout their range, until widespread 


habitat change coupled with unregulated shooting are thought to have caused the long-term 


population decline (Allen 1952, Johnsgard 1983).  The only remaining wild, migratory 


population of whooping cranes breed on and around Wood Buffalo National Park, Alberta and 


Northwest Territories, Canada, and overwinters along the Texas gulf coast centered on Aransas 


National Wildlife Refuge (NWR), Texas, USA (CWS and USFWS 2007).  This population is 


known as the Aransas-Wood Buffalo flock. 


In 1973, with the passage of the Endangered Species Act, the whooping crane was listed as an 


endangered species.  The U.S. Endangered Species Act allows for the development and 


implementation of species recovery plans including downlisting criteria.  The International 


Recovery Plan has established several downlisting criteria for whooping cranes based on 


population size and the number of breeding pairs (CWS and USFWS 2007).  The plan identified 


a short-term recovery goal of downlisting from endangered to threatened by 2035 (CWS and 


USFWS 2007).  One alternative downlisting criterion requires >1,000 birds in the Aransas-Wood 


Buffalo flock with >250 breeding pairs (Criterion 1B; CWS and USFWS 2007).  If an additional 


self-sustaining flock can be established, the downlisting criterion requires >400 birds in the 


Aransas-Wood Buffalo flock with >100 breeding pairs (Criterion 1A; CWS and USFWS 2007).  


If two additional self-sustaining flocks can be established, the downlisting criterion requires a 


minimum of 160 birds with >40 breeding pairs (Criterion 1; CWS and USFWS 2007). 


Monitoring quantitative population metrics is important for determining if the population has 


achieved downlisting criteria.  Monitoring also provides a tool to measure recovery and bolster 


conservation efforts by providing data that can be used to inform decisions affecting whooping 


crane conservation and management.  Therefore, it is incumbent upon the USFWS to frequently 


and objectively critique the methods we use to measure the effects of conservation or 


management actions, especially for endangered species such as whooping cranes.  Furthermore, 


it is USFWS policy to use the most appropriate, best available, high quality scientific and 


scholarly data and information to support the mission of the Department (Department of the 


Interior 2011). 


Traditional “census” effort 


The Aransas-Wood Buffalo whooping crane flock has been monitored on its wintering grounds 


surrounding Aransas NWR (Figure 1) via aerial surveys since 1950 (Stehn and Taylor 2008).  


Since establishment of Aransas NWR in 1937, the population has grown at an exponential rate 


and expanded onto approximately 22,000 ha of coastal marsh and bay (Stehn and Taylor 2008).  


Early surveys were assumed to be “censuses” that documented all individuals in the population 


(i.e., complete enumeration).  True population censuses for natural, free ranging wildlife 


populations are exceptionally difficult, if not impossible, to achieve for two primary reasons.  


First, most study areas are too large to sample completely within a short enough time frame to 







 


2 


 


ensure population closure (e.g., emigration, immigration; Lancia et al. 2005, Morrison et al. 


2008, Stehn and Taylor 2008, Conroy and Carroll 2009).  Second, the probability of detecting 


individuals is usually less than 100% and detectability is influenced by various factors including 


the behavior of individuals, vegetation density, observer fatigue, and field methodology (Krebs 


1999, Buckland et al. 2001, Williams et al. 2002, Morrison et al. 2008, Conroy and Carroll 


2009).  Stehn and Taylor (2008) recognized these sources of bias but they did not address them.  


They also indicated that as abundance increases and the whooping crane’s wintering grounds 


expand, the accuracy of their “census” attempts would decrease.  Therefore, a robust alternative 


method that does not assume complete enumeration of individuals and quantifies precision is 


needed.  This protocol provides a technique that accounts for incomplete detection and quantifies 


precision by employing line transect-based distance sampling and hierarchical modeling. 


 


 


Figure 1.  Aransas National Wildlife Refuge and surrounding areas typically inhabited by wintering 
whooping cranes; area includes portions of Aransas, Calhoun, and Refugio counties, Texas, USA. 


 


A brief description of previously used survey methods was written by Stehn and Taylor (2008).  


These surveys were conducted with 1 observer and a pilot.  The survey typically included San 


Jose Island, Matagorda Island, Blackjack Peninsula, Welder Flats-Dewberry Island, and the 


Lamar Peninsula-Tatton Unit (Figure 1).  Flight paths of the aircraft were flown parallel to the 


orientation of the landscape (i.e., parallel to the coast) to increase efficiency.  Subsequent flight 


paths were spaced approximately 250–800 m apart.  Transect spacing was not planned prior to 







 


3 


 


flights; it was determined subjectively by the observer in an attempt to detect all whooping 


cranes along the flight path given individual flight conditions (e.g., cloud cover, sun angle).  The 


flight path of the aircraft was diverted, if necessary, to distinguish between adult versus juvenile 


whooping cranes.  Survey duration was typically between 5–6 hours with a rest break 


approximately half-way through the survey during which the flight crew returned to the Aransas 


County Airport. 


 


Stehn and Taylor (2008) assumed that sun angle and visibility influenced the probability of 


detecting a whooping crane.  Therefore, the observer allocated their attention to the side of the 


aircraft away from the sun (Stehn and Taylor 2008).  Upon detecting a whooping crane, the 


observer would mark the individual’s location on a paper copy of a 1:46,080 Digital Orthophoto 


Quarter Quadrangle (DOQQ).  Whooping crane groups would be demarcated on the DOQQs 


based upon the number of white plumaged birds and juvenile birds (e.g., “2+1” indicated 2 white 


birds and 1 juvenile).  Each survey map was hand tallied after the completion of the survey and 


the total number of adults and juveniles on each map were summed and reported in publicly 


released flight reports. 


 


The reported winter abundance was presumably obtained from the survey with the most 


individuals detected but was rarely replicated in subsequent surveys.  However, the survey with 


the most individuals detected rarely corresponded with the winter abundance reported in the 


International Recovery Plan (CWS and USFWS 2007) and Aransas NWR annual reports (e.g., 


Stehn 2009, 2010, 2011; Figure 2).  In fact, the reported abundance was ≈3.7 birds (t = 3.754, df 


= 30, P < 0.001) more than the maximum count observed during the 1980–2010 surveys.  This 


likely occurred because birds observed outside of the survey area by the public or other parties 


were included in the reported abundances.  Interestingly, during 1980–2010, the maximum 


number of individuals detected during a survey was greater than the reported abundance for 6 of 


the survey years (Figure 2).  This inconsistency may be attributed to the observer’s interpretation 


or perception of double counts.  However, we cannot know the sources of these inconsistencies 


since rules governing how data from separate surveys were combined or how public reports of 


whooping cranes from outside of the “censused” area were incorporated was largely determined 


by the observer’s opinion.  This shows the traditional “census” was not an absolute enumeration 


of the population but instead a relative index of abundance. 


 


Wintering whooping cranes are thought to demonstrate territoriality and site fidelity within and 


across winters (based on limited observation data from marked birds; Stehn and Johnson 1987, 


Stehn 1992, Bonds 2000).  The fidelity of whooping cranes to their wintering territory has been 


used in conjunction with group structure as a surrogate for individually marked birds.  Groups of 


equal size found in similar areas on subsequent surveys were assumed to be the same individuals.  


These data were used to identify circumstances where distinct groups, or individuals within 


groups, were not detected and therefore additional search efforts were conducted (Stehn and 


Taylor 2008). 


 


Group structure and location data was also used to assist in quantifying the mortality of 


individuals (Stehn and Strobel 2012, Pugesek et al. 2013).  For example, subsequent 


observations of a group of 1 adult and 1 chick where previous surveys located a group of 2 adults 


and 1 chick resulted in the presumption that 1 adult had died.  However, the “unusual movements 
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and behaviors of color-banded whooping cranes” observed by Stehn (1992), such as extra-


territorial excursions, rapid pair formation after mate mortality, pair-bonded individuals 


overwintering apart, and occasional departure from the wintering grounds during the winter 


period, in addition to incomplete detection of individuals indicates that group structure and 


location data of unmarked birds from aerial surveys cannot be used to reliably imply mortality. 


 


 


Figure 2.  Comparison of the reported population size from the traditional “census” effort and the 
maximum count of whooping cranes observed during the traditional “census” effort during a 
survey year.  Surveys were conducted during winter 1980–2010 on and around Aransas National 
Wildlife Refuge, Texas, USA. 


 


The technique for enumerating mortalities assumed that if an individual whooping crane was not 


observed for 2 or more surveys, that individual was dead (Stehn and Strobel  2012).  For this 


technique to produce consistent results, the number of surveys conducted per winter needed to be 


relatively constant.  However, the number of surveys conducted between December 1
st
 and 


March 31
st
 of each year ranged from 4 to 21 (mean = 12.52, SD = 4.288; Butler et al. in prep).  


This deficiency in the technique manifested itself in an inverse relationship between winter 


mortality estimates and the number of surveys conducted between December 1
st
 and March 31


st
 


(binomial regression: odds ratio = 0.932,  ̂ = –0.071, SE = 0.028, W = 6.595, P = 0.010; Butler 


et al. in prep).  Hence, more surveys resulted in less mortality because temporary emigrants had 


more chances to return and be re-observed on their territories.  For example, imagine that 5 


consecutive surveys were conducted and a whooping crane was missing from its territory on the 


third and fourth survey occasions.  If the last survey had not been conducted, that whooping 


crane would have been considered dead. 
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In general, past methods were adapted to the daily weather conditions, personnel availability, and 


whooping crane abundance.  For example, the type of plane used, area-specific search effort, 


altitude and flight speed during the survey all varied within and across surveys and years.  These 


“metadata” likely influenced the results of traditional surveys but were infrequently recorded and 


therefore represent potential sources of bias.  Although some sources of variation are 


uncontrollable (e.g., year effects), many controllable sources were not addressed during previous 


survey methodology.  Identified sources of bias in the traditional “census” effort included: 


• Survey logistics lacked standardization (e.g., spacing between transects varied; transect 


locations vary between surveys; and survey altitude and ground speed were not 


standardized). 


• Allocation of surveying effort was inconsistent and not quantified within or across surveys 


(e.g., more allocation of effort searching for whooping crane groups with 2 chicks versus 


those with 1 chick; and more allocation of effort in consistently occupied territories versus 


sporadically occupied territories). 


• The order in which blocks were surveyed was not random, potentially introducing systematic 


bias. 


• Movement of individuals was recognized as occurring but was not accounted for in 


surveying methodology, data analysis, or reporting.  Therefore, reported winter abundance 


could represent double counted individuals or leave out undetected individuals. 


• The observer assumed ability to uniquely identify unmarked individual whooping cranes. 


• The suitability of using group structure and territory location as a surrogate for individually 


marked birds to measure mortality rates has not been tested and is likely untenable.  


Mortality estimates are better derived from radio- or GPS-telemetry based monitoring of a 


sample of the population. 


• Group size was likely positively related to the probability of detection (Buckland et al. 2001, 


Butler et al. 2007, Marques et al. 2007, Pearse et al. 2008, Strobel and Butler 2014) but was 


not accounted for.  In fact, more effort was applied to locating larger groups (i.e., groups with 


2 chicks) instead of smaller groups which are likely more difficult to detect. 


• Transect width was not fixed which allows transect-specific detections rates to vary since 


detection probability declines with distance. 


• Other potential sources of detection bias included: drab coloration of juveniles may reduce 


the probability of detecting them, and weather and light conditions may influence the 


probability of detection. 


 


Many technological and statistical advances have resulted in improvements in data collection and 


analysis techniques that were not readily available when aerial surveys began in the 1950s.  


However, many of these advances have been available for decades (e.g., Burnham et al. 1980).  


Further, objectives of the whooping crane monitoring program have not been clearly articulated 


and the traditional survey protocol lacks detailed documentation and standardization which limits 


the repeatability of future efforts and weakens inferences drawn from the data.  Therefore, a 


robust alternative method that does not assume complete enumeration of individuals and 


quantifies precision is needed.  This protocol provides a technique that accounts for incomplete 


detection and quantifies precision by employing line transect-based distance sampling and 


hierarchical modeling.  Below we outline the objectives of this monitoring program and provide 


rigorous techniques for meeting those objectives. 
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Objectives 


Management Objectives (in priority order): 


1. The International Recovery Plan for whooping cranes identified criteria for downlisting 


based on population abundance and number of breeding pairs (CWS and USFWS 2007).  


The primary objective of this protocol is to provide a robust means to quantify those 


metrics for downlisting. 


2. Create spatially-explicit resource selection models to facilitate land conservation for 


whooping cranes including the delineation of important habitat and the prioritization of 


land protection. 


Sampling Objectives (in priority order): 


1. Provide an estimate of whooping crane abundance within the surveyed area (see Element 


3, Sampling frame) with enough precision to detect a 10–15% annual population decline 


over a 3- to 4-year period (see justification provided in Butler et al. 2013). 


 


2. Estimate the number of paired whooping cranes (i.e., 2 white-plumaged birds) and 


recruitive pairs (i.e., a pair with at least 1 hatch-year [HY] bird) in the wintering 


population within the surveyed area.  This information provides an index for the number 


of paired birds that successfully recruited juvenile birds into the winter population. 


 


3. Estimate annual recruitment rate of hatch-year (HY) whooping cranes into the population 


wintering within the surveyed area. 


 


4. Create a spatially-explicit resource use model to predict abundance of whooping cranes in 


relation to local characteristics (e.g., vegetation type, patch configuration, water quality, 


food availability, etc.) for use in conservation planning efforts. 


 


5. Monitor expansion of the whooping crane population onto “new” areas by identifying 


and systematically searching areas of known or potential population expansion. 


 
Justification of objectives 


Monitoring abundance is important for determining if a population has achieved downlisting 


criteria and assessing the status of populations (Chadès et al. 2008, Lyons et al. 2008, Reynolds 


et al. 2011, Nicol and Chadès 2012).  Monitoring also provides a tool to measure recovery and 


bolster conservation efforts by providing data that can be used to inform decisions affecting 


whooping crane conservation and management.  However, no technique can provide abundance 


metrics without uncertainty in the estimates (Williams et al. 2001).  The traditional “census” 


technique provided estimates without measures of uncertainty.  However, the new technique will 


provide estimates of precision.  Precision of abundance estimates dictates our ability to detect 


changes in population growth through time (Thompson et al. 1998).  What magnitude of change 


is necessary for this survey to detect? 


 


Butler et al. (2013) addressed this issue by simulating this population’s trajectory and examining 


its sensitivity to periods of negative growth.  They identified scenarios that would significantly 


reduce abundance from the current trajectory and delay reaching the downlisting goal of 400 


birds by >5 years.  Those scenarios were >3 consecutive years of 9.5% annual decline or >2 
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consecutive years of 14% annual decline (Butler et al. 2013).  To estimate one growth rate, 2 


years of abundance estimates are needed.  Therefore, we need to be able to detecte a 9.5% annual 


decline over a 4-year period or a 14% annual decline over a 3-year period to discriminate the 


scenarios outlined in Butler et al. (2013). 


 


However, such scenarios have only occurred once in 73 years of monitoring this population 


(Butler et al. 2013).  This population has grown at an average of 3.9% per year since winter 


1938–1939, and has exhibited a 10-year cycle in population growth (Boyce and Miller 1985, 


Boyce 1986, Butler et al. 2013).  Therefore, a meaningful alternative to detecting the scenarios 


outlined in Butler et al. (2013) might be to detect a 3–5% annual decline over a 10-year period. 


 


The International Recovery Plan for whooping cranes (CWS and USFWS 2007) identified the 


number of productive pairs as one metric in which downlisting decisions will be based.  The 


International Recovery Plan defines a productive pair as “a pair that nests regularly and has 


fledged offspring” (USFWS and CWS 2007:xii) and distinguishes productive pairs from 


breeding pairs that are defined as “a pair that breeds or is intended to breed in the future” 


(USFWS and CWS 2007:38).  Regardless of the subjective nature of such definitions, 


identification of productive pairs on the wintering grounds is impossible since some juveniles die 


on the breeding grounds or during migration.  However, the number of whooping crane pairs can 


be estimated based on the proportion of detected groups containing crane pairs.  Also, the 


number of pairs that recruited a juvenile (i.e., recruitive pairs) into the wintering population can 


be estimated based on the proportion of detected groups containing juveniles.  Therefore, this 


protocol will provide estimates of the number of pairs and recruitive pairs to help decision 


makers assess whooping crane recovery. 


 


Recruitment of juvenile whooping cranes into the winter flock will be monitored because it is an 


important component of population growth.  In other crane populations, low annual recruitment 


can be a limiting factor to population growth (Drewien et al. 1995, Littlefield 2003).  For 


whooping cranes, simple linear regression of growth rate (λ) and available vital rates reveals 


recruitment accounts for 49.9% of the variation in population growth and mortality during the 


breeding- and migratory-periods accounts for 42.2% (Butler et al. in prep).  However, winter 


mortality only accounts for 14.4% of the variation in population growth (Butler et al. in prep).  


Monitoring recruitment will provide additional information that can help indicate population 


trends. 


 


Spatially-explicit models of abundance allow wildlife managers and biologists to relate 


landscape or habitat features with whooping crane abundance.  This advanced modeling 


technique increases our ecological understanding through descriptions of how abundance and 


detectability varies spatially resulting in predictive maps of abundance (Royle et al. 2004, 


Chandler 2011, Chandler et al. 2011, Sillet et al. 2012, Krementz et al. 2014, Timmer et al. 


2014).  These spatially-explicit maps of abundance are useful for conservation planning efforts 


such as land protection planning, policy decisions, and decision analyses. 


 
The new technique 


Strobel and Butler (2014) found detectability during the traditional survey technique was not 


100%.  The previous observers relied on experience and knowledge of whooping crane space-use 


on the wintering grounds to account for missed groups of birds over repeated surveys.  However, 
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the traditional technique provided no approach for quantifying the probability of missing 


whooping cranes nor did it ensure all whooping cranes were accounted for within the survey 


area.  In fact, the survey area was not even formally defined (Strobel and Butler 2014). 


 


Instead of attempting to physically enumerate all whooping cranes in the population, the new 


technique relies on methods that can estimate the number of whooping cranes missed during the 


survey.  Modern, rigorous approaches to estimating abundance do not attempt complete 


enumeration because it is nearly impossible due logistical constraints (e.g., survey area too large) 


and/or imperfect detection (Williams et al. 2001).  Techniques with rigor and validity must 


address partial detectability or resulting estimates will remain clouded in bias (Anderson 2001, 


2003).  Further, without formal definition of the sampling frame, inferential problems arise due 


to potential sample selection biases (Thompson et al. 1998).  This protocol provides formal 


definition of the sampling frame and deals with imperfect detection. 


Imperfect detection of individuals present in the survey area will result in inaccurate estimates of 


abundance unless the resulting bias is corrected (Anderson 2001, 2003).  Many techniques are 


available to correct for imperfect detection and include mark-resight methods (e.g., White 1996, 


McClintock and White 2012), capture-mark-recapture methods (e.g., Williams et al. 2001, 


Lancia et al. 2005, White 2008), observation probability models (e.g., sightability models; 


Samuel et al. 1987, Bodie et al. 1995, Lancia et al. 2005), and distance sampling-based surveys 


(Burnham et al. 1980, Buckland et al. 2001).  Techniques that are reliant upon recapture or 


resighting of previously marked individuals are limited when marked animals are unavailable or 


marks are inconspicuous.  Capture-based techniques are usually reserved for the most difficult to 


detect and observe species (e.g., carnivores, small mammals; Lancia et al. 2005).  Marked 


whooping cranes have existed in the population for many years (Stehn 1992).  However, 


detecting and identifying color marks on whooping cranes from aerial surveys is a dangerous 


proposition requiring low level flights at low airspeeds (i.e., a landing-type approach; Stehn 


2001).  


 


Distance sampling, however, is a tractable, widespread approach used to correct for the bias that 


results from imperfect detection (Burnham et al. 1980, Buckland et al. 2001).  Distance sampling 


does not rely on the capture and marking of animals and subsequent identification of those 


animals in successive surveys (Burnham et al. 1980, Buckland et al. 2001).  The conventional 


distance sampling (CDS) methodology that models a detection function using the key function + 


series expansion or key function + multiple covariate approach (Buckland et al. 2001, Buckland 


et al. 2004) provides a robust framework for estimating abundance for many wildlife species.  In 


fact, distance sampling has been used in the application of aerial survey techniques to estimate 


the density of many bird (e.g., Shupe et al. 1987, Johnson et al. 1989, Smith et al. 1995, Rusk et 


al. 2007, Ridgway 2010, McRoberts et al. 2011) and mammal species (e.g., White et al. 1989, 


Johnson et al. 1991, Jackmann 2002, Fewster and Pople 2008, Schmidt et al. 2012). 


 


Recent theoretical advances (i.e., hierarchical distance sampling [HDS] models) have resulted in 


models that explicitly consider relationships between population density and environmental 


covariates while controlling for detectability resulting in spatially-explicit models of abundance 


(Royle et al. 2004, Chandler et al. 2011, Sillet et al. 2012).  Such models are attractive because 


they can be used to understand ecological relationships among animal abundance and 


environmental conditions while accounting for imperfect detection.  The conventional distance 
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sampling models are easily implemented in Program Distance (Thomas et al. 2010) and the 


hierarchical distance sampling models are easily implemented in R package unmarked (Fiske and 


Chandler 2011).  Below we develop and outline a protocol that exploits line transect-based 


distance sampling and hierarchical models of abundance for monitoring whooping cranes on 


their wintering grounds. 


 


 


Element 2: Pilot Studies 
Though distance sampling is a tractable, widespread approach used to monitor many wildlife 


species, efforts to test and pilot the technique were employed (see Strobel and Butler 2014).  


These efforts provided useful insights for developing this protocol. 


 
Winter 2010–2011 surveys 


We conducted aerial surveys of whooping cranes along the Texas gulf coast during winter 2010–


2011 (Strobel and Butler 2014).  Surveys were conducted with 2 observers (T. Stehn and B. 


Strobel; typically only 1 observer was used in the past) in a Cessna Centurion 210-RG (Cessna 


Aircraft Company, Wichita, KS).  We followed survey protocols established by Stehn and Taylor 


(2008) except we recorded the aircraft’s track with a global positioning system (GPS) unit and 


digitized the mapped whooping crane locations in a geographic information system (GIS).  We 


measured distance from detected groups to the transect in the GIS.  We used those detections and 


distances in a conventional distance sampling analysis to estimate encounter rates and model 


detection probabilities (Buckland et al. 2001, Thomas et al. 2010). 


 


We found ≈95% of detected whooping crane groups were within 500 m of transects (Figure 3).  


We observed a whooping crane group encounter rate of 0.211/km (SE = 0.0199).  We found the 


detection function was best fit with a half-normal key function which indicated detection 


probability of a whooping crane group within 500 m of the survey line was 0.558 (SE = 0.031).  


Many have believed the traditional survey techniques of Stehn and Taylor (2008) resulted in a 


complete census of whooping cranes overwintering on and around Aransas NWR but these 


results clearly show detectability was <1 (note, these analyses were based on data obtained 


during the traditional census conducted during winter 2010–2011). 


 
Decoy experiment 


Several methods exist for determining how results from aerial surveys for wildlife are affected 


by their detectability (Pollock and Kendall 1987, Green et al. 2006, Conroy et al. 2008).  These 


methods include double sampling, comparison to ground based counts, use of a marked 


subpopulation, and comparison to locations of known individuals.  Alternatively, Smith et al. 


(1995) used waterfowl decoys as a surrogate to better understand how survey platform, habitat 


type, and group size influenced detection of waterfowl during aerial surveys.  Similarly, Pearse 


et al. (2007) used decoys to quantify the detection biases associated with group size and habitat 


type for wintering waterfowl in Mississippi, USA.  Howlin et al. (2008) used decoys to develop a 


predictive model of detection probability for whooping cranes in the central Platte River valley, 


Nebraska, USA.  Decoys have been used to quantify the detection biases for wild turkeys 


(Meleagris gallopavo) as well (Butler et al. 2007).  We used sandhill crane (Grus canidensis) 


decoys painted to resemble whooping cranes as surrogates (Figure 4; Howlin et al. 2008) to 


examine the impact of observer experience, sun position, distance from transect, and group size 


on the detection of whooping cranes.  The experiment was conducted during September 2011 
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prior to the arrival of whooping cranes to eliminate potential confusion with live birds (Strobel 


and Butler 2014).  This experimental test provided valuable information for survey design and 


implementation; we reference this material throughout the protocol and summarize results here. 


 


 
 


Figure 3.  Histogram of distances from transect to whooping crane groups observed during aerial 
surveys along the Texas gulf coast, USA, during the traditional census flights, winter 2010–2011. 


 


The experimental decoy surveys were conducted from an amphibious Kodiak (Quest Aircraft 


Company, Sandpoint, ID) fixed-wing airplane with 2 observers.  We conducted 4 surveys of 


decoys with an average of 104 decoy groups within 500 m of transects.  Results from the 


experimental decoy survey indicated decoy detectability increased with group size and exhibited 


a quadratic relationship with distance likely due to the pontoons on the aircraft.  We found 


detectability was 2.704 times greater (Wald statistic [W] = 6.812, df = 1, P = 0.009) when the sun 


was overhead and 3.912 times greater (W = 7.696, df = 1, P = 0.006) when the sun was at the 


observer’s back than when it was in the observer’s eyes.  Though observer experience did not 


seem to influence detection probability, we found the inexperienced observer misclassified non-


target objects more often than the experienced observer (χ
2
 = 8.543, df = 1, P = 0.004).  During 


the decoy surveys we used marks on the struts (e.g., Caughley et al. 1976, Guenzel 1997, Butler 


et al. 2007) to categorize distances into intervals but we found observers misclassified distances 


46.7% of the time (95% CI = 37.0–56.6%).  We accurately estimated decoy group size 86.9% of 


the time (n = 107; 95% CI = 79.0–92.7%).  In 14 instances, decoy group size was underestimated 


and during 8 of those instances, group size was only underestimated by 1 individual.  Also, we 


found detectability of individuals within detected groups was effected by group size (odds ratio = 


0.200; W = 11.573, df = 1, P < 0.001) and distance from transect (odds ratio = 0.996; W = 7.726, 


df = 1, P = 0.005).  Specifically, the number of decoys within a detected group was 


underestimated as group size increased and distance increased. 
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Figure 4.  Sandhill crane decoys (Carry-Lite Decoys, Alabaster, Alabama, USA) were painted to 
resemble whooping cranes.  Some decoys were painted white to resemble adults and some were 
painted tawny to represent hatch-year birds.  Though sandhill cranes are smaller than whooping 
cranes, their body form is similar resulting in good surrogates for examining factors that influence 
the detection process. 


 
Lessons learned from pilot studies 


Though results from the pilot studies were not particularly surprising, they provided useful 


insights for improving whooping crane monitoring efforts. 


1. The angle of the sun significantly affected detection of whooping crane decoys in our 


pilot study.  Though Stehn and Taylor (2008) also noted that sun angle affected detection 


of whooping cranes, the traditional census was conducted during the morning and 


afternoon with a break for lunch.  Therefore, much of the survey effort was accomplished 


when the sun was at lower angles resulting in high detectability on one side of the aircraft 


but low detectability on the other.  We recommend using two observers (instead of just 1) 


and conducting flights during midday to take advantage of the consistent and relatively 


high detectability on both sides of the aircraft which would allow for more efficient 


search effort and transect spacing. 


2. Our results emphasized that observer training was important in reducing misidentification 


of non-targets; some experience could be gained as a non-observer in the fourth seat of 


the aircraft. 


3. Although apparently useful in other aerial surveys (potentially with larger distance 


intervals, higher altitude, and less turbulence), sighting marks placed upon the aircraft’s 


struts did not provide accurate measurements of distances (e.g., Caughley et al. 1976, 
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Guenzel 1997, Butler et al. 2007).  Other techniques such as marking the location of 


detected groups with a GPS, the use of an inclinometer, or marking locations on a heads-


up display GIS would improve distance measurements (Buckland et al. 2001, Marques et 


al. 2006). 


4. We recommend avoiding the use of aircraft with pontoons or high instrument panels to 


maintain complete detection on the transect line.  If such aircraft cannot be avoided, other 


distance sampling-based techniques such as a double-observer approach could be 


employed to estimate detection probability at the line (Laake and Borchers 2004). 


5. Buckland et al. (2001) showed the use of regression of detection probability against 


group size to adjust expected group size will correct for both size-biased detection and 


underestimation of group size assuming that group sizes are estimated accurately on or 


near the transect.  The group size of all detections within 100 m of the transect were 


correctly counted during the decoy experiment.  However, observers should attempt to 


count group size as accurately as possible. 


6. The traditional technique provided no measure of precision which facilitated the 


presumption that it resulted in an absolute enumeration without error (i.e., a perception 


that there was little or no uncertainty in the estimates).  New techniques such as line 


transect-based distance sampling, however, will account for imperfect detectability and 


allow for a statistically rigorous estimate of whooping crane abundance.  Our pilot studies 


show that distance sampling would be an appropriate technique for estimating whooping 


crane abundance. 


 


 


Element 3: Sampling Design 
 
Sampling design 


This protocol is primarily designed to provide a mechanism for monitoring trends in whooping 


crane abundance on their wintering grounds along the Texas gulf coast, USA.  Secondarily, the 


protocol provides mechanisms for monitoring recruitment rates, the number of whooping crane 


pairs that recruited young into the winter flock, and whooping crane winter range expansion.  


Finally, this protocol is designed to augment planning and conservation efforts with information 


about the relationships among local abundance and habitat characteristics. 


 
Target universe 


The biological population in which inference is intended is the entire Aransas-Wood Buffalo 


whooping crane flock that overwinters in the central flyway.  However, the extent of the winter 


range (i.e., much of the Texas gulf coast, north into Kansas and even Nebraska; Wright et al. 


2014) and the extremely low density throughout much of the range, places extraordinary logistic 


constraints on monitoring the entire Aransas-Wood Buffalo flock.  Therefore, we focus 


monitoring efforts on the areas occupied consistently on and around Aransas NWR.  Additional 


effort will be conducted in other nearby areas where primary winter range expansion is expected. 


 
Sampling frame 


Whooping cranes are thought to exhibit high fidelity toward territories on their wintering 


grounds (Stehn and Johnson 1987, Stehn 1992, Bonds 2000).  In 1950, when the traditional 


aerial “census” efforts for whooping cranes began, most known territories were located on the 


Blackjack Peninsula with a few on Matagorda Island (Stehn and Johnson 1987).  During the 
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traditional “census” effort, a sampling frame was not strictly defined and the spatial extent of the 


search effort used for each “census” was not recorded.  However, the effort of “census” flights 


was allocated to areas where whooping cranes were either observed previously or where they 


were fortuitously observed by refuge staff or the public (Figure 5). 


 


Since 1950, whooping cranes have recolonized several adjacent areas (Stehn and Johnson 1987, 


Stehn and Prieto 2010).  Although no formal mechanism existed for expanding the “censused” 


area in recent years, flights were typically conducted over portions of the Blackjack Peninsula, 


Lamar Peninsula, Matagorda Island, San Jose Island, and Welder Flats-Dewberry Island (Figure 


5).  The boundaries of these areas are the basis for formally defining the sampling frame for this 


protocol. 


 


 


Figure 5.  Locations where whooping cranes have been observed during the traditional surveys 
on and around Aransas National Wildlife Refuge, Texas, USA, winter 1990–2010. 


 


The sampling frame is divided into two strata: Primary Sampling Frame (PSF) and Secondary 


Sampling Frame (SSF; Figure 6).  Each strata includes several “regions.”  Regions within the 


PSF were designated as such because recent data indicate they are occupied consistently by 


multiple groups of whooping cranes each winter (Figure 5).  Regions within the SSF are not 


currently used consistently by whooping cranes but have either been occupied recently or have 


apparently suitable whooping crane habitat and may become occupied consistently as whooping 
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crane populations increase (Figure 5).  Our estimates of annual abundance will only apply to the 


primary sampling frame, not the entire Aransas-Wood Buffalo whooping crane flock.  Absence 


of information in areas not surveyed should not be construed to imply the absence of whooping 


cranes. 


 


 


Figure 6.  The sampling frame for monitoring whooping crane on their wintering grounds along 
the Texas gulf coast, USA.  These were not formally defined during the traditional “census” effort. 


 


The Primary Sampling Frame contains 6 regions totaling 62,300 ha (Table 1; Figure 6).  The 


Secondary Sampling Frame contains 9 regions totaling 62,000 ha (Table 1; Figure 6).  Below we 


describe how SSF regions will eventually be included in the PSF (see Element 3–Sampling 


frame, Sampling Objective 5). 


 


The sampling objectives of this protocol (see Element 1–Objectives) are to 1) provide an 


estimate of winter whooping abundance; 2) index the number of whooping crane pairs that 


successfully recruited juveniles into the winter population; 3) estimate the age-ratio of wintering 


whooping cranes; 4) create spatially-explicit models of wintering whooping crane abundance; 


and 5) monitor whooping crane winter range expansion. 


 


Sampling Objective 1: 


Estimates of winter abundance for whooping cranes will only be based on surveys conducted in 


the PSF where the historic data indicated abundance of the population is consistently highest and 
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the traditional “census” effort was conducted.  We provide criteria below for adding regions 


from the SSF to the PSF as the population grows and the wintering grounds expand (see Element 


3–Sampling frame, Sampling Objective 5). 


 
Table 1.  The number of transects and survey effort (i.e., total transect length) for the regions 
within the Primary and Secondary Sampling Frames. 


 
Region Acronym Area (ha) No. transects Total length (km) 


Primary Sampling Frame 


 Blackjack Peninsula BJ 11,900   6 119 


 Lamar Peninsula-Tatton Unit LT   6,400   4   64 


 Matagorda Island, Central MIC   7,500   5   75 


 Matagorda Island, West Marsh WM 10,000   7 100 


 San Jose Island SJ 15,700   8 157 


 Welder Flats-Dewberry Island WF 10,800   6 108 


 Total  62,300 36 623 


Secondary Sampling Frame 


 Egery Flats EF   7,700  5    77 


 Guadalupe Delta GD 10,400 11 104 


 Holiday Beach HB   3,900   7   39 


 Mad Island MAD 13,200   5 132 


 Matagorda Island, North MIN   7,300   7   73 


 Matagorda Peninsula MP   3,900   1   39 


 Mission Bay MB   5,000   5   50 


 Port Bay PB   2,000   2   20 


 Powderhorn Lake PL   8,600   7   86 


 Total 
 


62,000 50 620 


 


 


Sampling Objectives 2–4: 


The data required to meet these sampling objectives will be obtained using the PSF. 


 


Sampling Objective 5: 


Previously collected data indicated that whooping cranes have sporadically used several areas 


outside of the PSF.  The SSF will be used to monitor expansion of the whooping crane wintering 


grounds.  We determined a minimum number of whooping cranes groups that must be detected 


in a SSF region, before that SSF region will be included in the PSF for future surveys.  The 


minimum number of groups ( ) for SSF region   was determined based on the following 


formula: 


 


        (        
 


where   was the minimum PSF region-specific density of whooping crane groups estimated 


during the winter 2013–2014 surveys (≈0.1 groups/km
2
),    was the area of SSF region  , and   


was the average detection probability during the 2013 surveys (0.7 detection probability within 


500 m of transect).  We rounded each    down to the nearest integer.  The estimated threshold 
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(  ) of groups for a SSF region must be detected >2 times within a survey year before that SSF 


region will be promoted into the PSF for future surveys (beginning the next year).  The minimum 


number of whooping crane groups needed to promote a SSF region into a PSF region varied 


from 1 to 9 (Table 2). 


 
Table 2.  The minimum number of whooping cranes groups that must be detected in a secondary 
region before that secondary region will be included in the primary sampling frame for future 
surveys. 


Secondary Sampling Frame No. Needed Secondary Sampling Frame No. Needed 


Egery Flats 5 Matagorda Peninsula 2 


Guadalupe Delta 7 Mission Bay 3 


Holiday Beach 2 Port Bay 1 


Mad Island 9 Powderhorn Lake 6 


Matagorda Island, North 5   


 


 


As SSF regions are promoted into the PSF as the population expands, additional areas will need 


to be added to the SSF.  Because the Aransas-Wood Buffalo population is growing at ≈4% per 


year, we will address how to add more SSF regions when this monitoring plan is due for 


revision.  For example, the spatially-explicit models of habitat use could be used to predict areas 


composed of the best potential habitat.  Ancillary information gained from internal and external 


sources (e.g., fortuitous public or staff observations; Texas Whooper Watch) could potentially be 


used to identify new SSF regions as well. 


  
Sampling units 


The sampling units for this design can be considered in a hierarchical or nested sense (Figure 7).  


The regions in the PSF are the primary sampling units.  Within each region, transects provide 


complete coverage of the region and are systematically spaced 1,000 m apart (e.g., fixed-width 


transects).  We established 623 km of transects in the PSF and 620 km in the SSF (Table 1, 


Figure 8).  Each transect is split into 1-km
2
 segments where landscape conditions are 


characterized (Element 4–Environmental covariates).  Within the transect segments, whooping 


crane groups are detected and each group is composed of 1 or more whooping cranes.  Groups of 


whooping cranes are primarily 1, 2, 3, or 4 individuals (usually a family group) and the 


occasional larger group of subadults. 


 


During a survey, the observers record attributes about whooping crane groups (i.e., group size, 


composition, and location coordinates).  After a survey, vegetative or environmental 


characteristics of each 1-km
2
 segments are characterized from remotely sensed data or other 


sampling efforts.  The 1-km
2
 transect segments are the sampling units for modeling relationships 


between local abundance and environmental characteristics, whooping crane groups are the 


sampling unit for the detection function (i.e., clusters; Buckland et al. 2001), and individual 


whooping cranes are the sampling unit for estimation of age-ratios. 


 
Sample selection 


Currently, all regions within the PSF and all transects within a PSF region will be sampled.  


However, as more regions are added to the PSF as the whooping crane wintering grounds 
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expand, complete sampling will likely become infeasible.  Eventually logistic constrains will 


dictate random sampling of regions, transects within regions, or a combination of both.  This 


issue will be addressed when this monitoring plan is due for revision. 


 


 
 


Figure 7.  The sampling design for whooping crane surveys on their wintering grounds has nested 
sampling units. 


 
Transect spacing 


The precision of abundance estimates obtained from conventional distance sampling (CDS) or 


hierarchical distance sampling (HDS) analyses is related to the number of whooping crane 


groups detected and how those groups are distributed across the sampling frame.  Analyses of 


data collected during winter 2010–2011 indicate ≈95% of whooping cranes were detected within 


500 m of transects (Figure 2).  Therefore, transects were established using 1-km spacing (Figure 


8).  Although the current method is not intended to provide a “census” of the population within 


the sampling frame, transects have been established at a density to provide a uniformly high 


search effort within each region while balancing the logistic constraints that can result from 


closer spacing.  Transects are identified with region-specific acronyms (i.e., BJ, SJ, WM, etc.; 


Table 1) and sequentially numbered from the mainland toward the Gulf of Mexico. 


 
Survey timing 


Presumably the Aransas-Wood Buffalo Population of whooping cranes reaches its annual 


maximum at the conclusion of the year’s nesting season.  However, due to the isolation of Wood 


Buffalo National Park and the low density at which whooping cranes nest, large-scale survey 


efforts at Wood Buffalo are not feasible at this time.  The high density of whooping cranes on 
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and around Aransas NWR during winter facilitates large-scale survey efforts.  Therefore, it is 


likely the most efficient opportunity to index the population size of the flock is shortly after their 


arrival on the wintering grounds but prior to winter mortalities.  Historical data indicated that this 


typically occurs at the end of November through the end of December (Figure 9).  Therefore, the 


annual winter whooping crane abundance estimate will be based on data collected during the 


time period between 28 November and 26 December.  We chose a month-long period to 


facilitate survey logistics (i.e., inclement weather and aircraft availability).  Multiple surveys will 


be conducted during this period (see Element 3–Survey repetition and sample size); we will 


attempt to conduct those surveys within a 2-week window to minimize changes in whooping 


crane resource use, dispersal from the PSF, and losses from winter mortality. 


 


 
 


Figure 8.  The sampling frame and survey transects for monitoring whooping cranes on their 
wintering grounds along the Texas gulf coast, USA.  Transects are spaced at 1-km intervals. 


 


 


Additional surveys can be conducted during the months of January, February, and March to 


document temporal changes in resource use.  Surveys conducted during these other periods will 


be conducted within a 2-week window during each period.  Surveys conducted during these 


other periods are optional and should only be conducted if clear, resource management 


objectives are identified. 
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Figure 9.  Box plots describing chronology of whooping crane arrival and departure on the Texas 
gulf coast, USA.  Data from periodic aerial surveys, centered on Aransas National Wildlife Refuge, 
conducted during the winters of 1950–2011.  Solid black lines represent the median proportion of 
the annual maximum count by date.  Boxes contain the 0.25 and 0.75 quantiles of data, while the 
lines span the entire dataset except outliers (black circles).  The red box represents the time of 
year during which effort will be exerted to estimate the whooping crane abundance, age-ratios, 
and number of recruitive pairs in the primary sampling frame (Sampling Objectives 1–3).  Blue 
boxes represent times in which additional survey effort could be exerted for other monitoring 
objectives. 


 


Sampling Objective 1: 


To estimate whooping crane abundance within the sampling frame, surveys will be conducted 


between 28 November and 26 December annually (Figure 9).  Surveys will be limited to a 2-


week window to maximize population closure. 
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Sampling Objectives 2–3: 


Winter mortality or dispersal from the wintering grounds will occur as the winter months 


progress and could bias estimates of the number of recruitive pairs and recruitment rates.  


Therefore, those estimates will be based on the surveys conducted during the same time period as 


sampling objective 1 (i.e., 28 November–26 December). 


 


Sampling Objective 4: 


Spatially-explicit models of abundance will be developed for the 28 November–26 December 


survey period.  Optionally, spatially-explicit models of abundance may be developed from data 


collected during other time periods (e.g., January, February, and March) if additional resource 


management objectives are identified and justified. 


 


Sampling Objective 5: 


All 6 regions of the SSF will be surveyed at least twice during the 28 November–26 December 


survey period.  This can be accomplished by sampling 3 of the SSF regions each time the PSF is 


surveyed (see Element 3–Survey repetition and sample size) or by devoting 2 days to conducting 


surveys of the SSF.  Optionally, SSF regions can be surveyed during the other survey periods if 


additional resource management objectives warrant such effort. 


 
Survey repetition and sample size 


Sampling Objectives 1, 2, and 4: 


Multiple conditions influence the precision obtained from a given survey using CDS or HDS 


analysis techniques, therefore a precise definition of the sample size required to meet this 


sampling objective is not possible.  However, a power analysis suggested that detection of an 


average annual decline of 10% over a 4-year period will require a coefficient of variation 


(  (  ) of 0.09 and a 15% decline over a 3-year period will require a   (   of 0.06 (Appendix 


A).  Analyses based on data collected during winter 2011–2012 indicated that 5–6 surveys will 


be required to obtain a   (   < 10% (Appendix A).  Therefore, at least 6 complete surveys of 


the PSF (all transects within the PSF) will be conducted each year between 28 November–26 


December.  These surveys will be limited to a 2-week window during this period to minimize 


changes in whooping crane resource use, dispersal from the PSF, or mortality (i.e., maximize 


population closure). 


 


As an alternative, a   (   < 20% (Appendix A) would be required to detect a 3–5% annual 


decline over a 10-year period.  This precision would require only 1–3 surveys per year 


(Appendix A). 


 


Sampling Objective 3: 


Recruitment of hatch-year (HY) whooping cranes into the wintering population will be indexed 


as the observed ratio of HY to after-hatch-year (AHY) birds obtained from survey flights 


conducted during 28 November–26 December.  Since multiple surveys will be conducted for 


estimating abundance on the wintering grounds, the most appropriate estimator of HY:AHY ratio 


is the multiple samples with replacement ratio estimator where each survey represents a sample 


(Skalski et al. 2005; Appendix B).  Analyses of previously collected data suggested variance of 


estimated HY:AHY age-ratios is low in most cases (Figure 10).  In most years, >3 surveys were 


conducted between 28 November–26 December resulting in tight confidence intervals (Figure 
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10).  This will allow adequate power to meet sampling objective 3 prior to having adequate 


power to meet sampling objective 1.  Therefore, specific sample size required to meet sampling 


objective 3 was not determined. 


 


 
 


Figure 10.  Ratio and 95% confidence intervals of hatch-year (HY) to after-hatch-year (AHY) 
whooping cranes observed during the traditional “census” effort from 1980–2010 on and around 
Aransas National Wildlife Refuge, Texas, USA.  We only used data from surveys conducted 
between 28 November–26 December.  The estimates were based on multiple samples with 
replacement ratio estimator where each survey represented a sample (Skalski et al. 2005).  During 
winter 2008–2009, only one survey was conducted between 28 November–26 December, so we 
used an estimator based on a single sample survey (Skalski et al. 2005). 


 


Sampling Objective 5: 


The regions within the SSF will be surveyed >2 times (2 complete surveys of all transects in the 


SSF) between 28 November–26 December, to monitor expansion of the whooping crane 


wintering grounds.  Once the predetermined number (see Element 3–Sampling frame–Sampling 


Objective 5; Table 2) of whooping crane groups are detected >2 times in a SSF region, that SSF 


region will be included in the PSF for future surveys (beginning the next year). 


 
Monitoring frequency 


The USFWS has monitored whooping crane abundance for over 7 decades, providing data to 


model and predict population trajectories and evaluate management triggers.  Maintaining 


continuity in this dataset remains important for understanding how this population changes over 


time.  However, this whooping crane population is ≈12 years (>0.8 probability by 2025) from 


reaching 400 individuals (downlisting criterion 1A; CWS and USFWS 2007) and abundance 
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estimates do not trigger most, if any management decisions (Butler et al. 2013).  For example, 


many management activities on Aransas NWR such as prescribed burning will continue to occur 


regardless of whether an abundance estimate is available.  This begs the question, why continue 


to monitor whooping crane abundance annually?  Annual monitoring may be more informative 


when the policy decisions regarding downlisting are imminent (Chadès et al. 2008, Lyons et al. 


2008, Reynolds et al. 2011, Nicol and Chadès 2012).  Perhaps a biennial-interval would still 


provide enough information for policy or management decisions (Butler et al. 2013).  However, 


meeting the public expectation of annual abundance estimates remains important.  Therefore, 


monitoring frequency for the Aransas-Wood Buffalo flock should be discussed to ensure survey 


costs and effort is commensurate with data utility. 


 
Environmental covariates 


Hierarchical distance sampling results in spatially-explicit models of abundance that explicitly 


consider relationships between population density and environmental covariates while 


controlling for detectability (Royle et al. 2004, Chandler et al. 2011, Sillet et al. 2012).  


Currently, environmental covariates are derived from the Texas Ecological Systems 


Classification Project (http://www.tpwd.state.tx.us/gis/gallery/), Phase 3 (Ludeke et al. 2012; 


Appendix E).  The percent of each 1-km
2
 transect segment is determined for 6 general vegetation 


types: saltmarsh, open water, wetland, saltmarsh-shrubland, upland, and urban (Appendix E).  


Though these covariates are only rudimentary, strong relationships with whooping crane 


abundance has been demonstrated with some of them (Strobel et al. 2012).  As managers, 


biologists, and policy makers begin to recognize the value and potential of spatially-explicit 


models of resource use and develop more detailed hypotheses about whooping resource use, 


specific resource maps can be tailored to answer more specific management or policy questions.  


Maps from which environmental covariates are derived will need to be periodically updated with 


the most current data. 


 
Sources of biases 


Sampling Objective 1: 


Imperfect detection of whooping crane groups occupying the survey area will result in inaccurate 


estimates of abundance unless the resulting bias is corrected (Anderson 2001).  To account for 


imperfect detection, perpendicular distances to detected groups will be measured during surveys.  


These distances will be used to model detection probabilities and adjust estimates of abundance 


(Buckland et al. 2001).  Distances need to be measured accurately and to the center of the group.  


Tests of marks on struts indicated that technique performed poorly during pilot studies.  


Therefore, we provide a new technique of marking locations on a heads-up display GIS (see 


Element 4–Field Methods). 


 


Movement of whooping crane groups in response to the aircraft prior to detection could bias 


estimates of abundance.  Movement that is independent of the aircraft causes no problems and 


movement after detection is not a problem as long as the initial location can be accurately 


determined (Buckland et al. 2001).  Movement towards the aircraft by whooping cranes would 


result in positive bias but evasive movements would result in abundance being biased low 


(Buckland et al. 2001).  However, attraction to or avoidance of the aircraft by whooping cranes is 


not an issue.  During previous surveys, we observed the immediate response of hundreds of 


whooping cranes groups to the aircraft.  We did not observe any whooping cranes being flushed 


into flight or make movements of >100 meters in response to the passage of the aircraft.  Further, 



http://www.tpwd.state.tx.us/gis/gallery/
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initial locations of whooping crane were easily established.  When visibility allowed the 


detection of groups from the next transect, groups were often detected in the same location, 


suggesting movement away from the aircraft was not substantial. 


 


Size-biased detection (i.e., larger groups have greater detection probability than smaller groups) 


and underestimation of group size will result in inaccurate estimates of abundance unless the 


resulting bias is corrected.  Buckland et al. (2001) shows the use of regression of detection 


probability against group size to adjust expected group size will correct for both sources of bias 


as along as group sizes are estimated accurately on or near the transect.  The group size of all 


decoy detections within 100 m of the transect were correctly counted (see Elemet 2–Lessons 


learned from pilot studies). 


 


Distance sampling assumes detection probability is 1.0 on the transect line (Buckland et al. 


2001).  This can be a problem for fixed-winged aircraft because it is often difficult to see directly 


below the aircraft (e.g., Buckland et al. 2001, Butler et al. 2007, McRoberts et al. 2011).  


However, despite the pontoons on the aircraft we used during the experimental decoy survey, the 


shortest distance to an undetected decoy group was 37 m; 5 other decoy groups had shorter 


distances and they were detected.  When we used the Cessna Centurion 210-RG during winter 


2010–2011, data indicated 100% detection on the transect line was likely (Figure 1).  A low 


instrument panel in the survey platform allows forward observation of the transect, reducing the 


probability of missing groups on or near the transect.  A description of the allocation of observer 


search effort is described below (see Element 4–Field data collection methods). 


 


Misidentification of other white birds as whooping cranes could bias estimates of abundance 


(Figure 11).  To minimize potential bias from misidentification, observers must have superior 


bird identification skills for Texas coastal waterfowl.  In addition to basic bird identification 


training, we recommend new observers participate as a non-observer in the fourth seat of the 


aircraft during at least 3 surveys with experienced observers before participating as an observer.  


If an observer has any doubt as to the species, that detection should not be recorded. 


 


Buckland et al. (2001) recommends orienting transects perpendicular to linear environmental 


features (i.e., the coastline) because they can result in density gradients.  Sampling parallel to the 


density gradient will result in inflation of the variance of the encounter rate when using CDS.  


However, incorporation of environmental covariates that cause the density gradient into 


hierarchical models of abundance will account for the density gradient when using spatial 


distance sampling (Johnson et al. 2010, Hedley and Buckland 2004, Hedley et al. 2004).  As 


Stehn and Taylor (2008) did, we chose to orient transects parallel to the coastline which greatly 


reduces the number of turns required which increases survey safety. 


 


Sampling Objective 2: 


The number of paired whooping cranes (i.e., 2 white-plumaged birds) must be estimated in order 


to estimate the number of recruitive pairs.  The number of whooping crane pairs can be estimated 


based on the proportion of detected groups containing AHY whooping crane pairs.  The number 


of pairs that recruited a juvenile into the wintering population can be estimated based on the 


proportion of detected groups containing HY birds.  These proportions are easily estimated from 


the observed data.  However, both estimates will likely be biased low due to group size-biased 
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detection and inability to identify some individuals to age-class resulting in biased estimates of 


the number of recruitive pairs in the flock.  Therefore, we consider this an index of the number of 


recruitive pairs. 


 


 


Figure 11. Multiple whooping cranes observed with species of other white birds during traditional 
winter surveys along the Texas gulf coast, USA.  Photograph taken by T. Stehn. 


 


Sampling Objective 3: 


Skalski et al. (2005) noted several assumptions of the HY:AHY ratio estimator.  Assumptions of 


primary concern are equal probability of detection of each age group and the survey period is 


short enough that both age groups have equal probability of survival during the survey period.  


The survey period will be limited to 2 weeks.  We currently have no evidence suggesting HY and 


AHY birds have differential detection probabilities.  Though HY birds are tawny-colored, they 


are rarely unassociated with AHY birds.  However, group size-biased detection could skew age-


ratios high but assuming any differential detection remained constant among years, the HY:AHY 


estimator remains a relative index of the age-ratio and juvenile recruitment into the winter flock. 


 


Sampling Objective 4: 


Spatially-explicit modeling of resource use will be based on available maps of vegetation, other 


whooping crane resources (i.e., salinity, blue crab abundance, etc.), or management actions (i.e., 


time since prescribed burn, fresh water provisioning, etc.).  Currently, only rudimentary 


vegetation characteristics are available limiting the scope of inference possible.  However, as 


managers, biologists, and policy makers begin to recognize the value and potential of spatially-


explicit models of resource use and develop more detailed hypotheses about whooping crane 


resource use, specific resource maps can be tailored to answer more specific management or 


policy questions. 
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Predictions beyond the sampling frame to other areas of interest can be made.  However, caution 


must be used in interpreting such predictions.  Such predictions cannot be used to infer 


abundance or resource use beyond the sampling frame but they can be useful for identifying 


areas likely to be inhabited by whooping cranes in the future (assuming those areas do not 


change).  For example, conservation planning efforts could use these predictions for land 


protection planning purposes or researchers could use them for evaluation of the potential 


impacts of sea level rise. 


 


Sampling Objective 5: 


Sporadic or occasional use of SSF regions by whooping cranes has little consequence on 


abundance estimates.  However, as these SSF regions become consistently occupied, their 


inclusion into the PSF becomes more important.  The SSF will be used to monitor expansion of 


the whooping crane wintering grounds.  Once the predetermined number (see Element 3–


Sampling frame–Sampling Objective 5; Table 2) of whooping crane groups are detected >2 


times in a SSF region, that SSF region will be included in the PSF for future surveys.  We chose 


the predetermined thresholds to reduce early inclusion of SSF regions into the PSF due to 


sporadic or occasional use by whooping cranes.  This sampling scheme is not designed to detect 


occupation of “new” areas beyond the counties surrounding Aransas NWR (i.e., Aransas, 


Calhoun, Matagorda, Refugio, and San Patricio counties, Texas, USA) due to logistic 


constraints.  Ancillary information gained from internal and external sources (e.g., fortuitous 


public or staff observations; Texas Whooper Watch) will be used to augment winter range 


expansion data. 


 


 


Element 4: Field Methods 
 
Logistics required before implementing each season’s field survey 


Data collection requires 2 observers, a Department of the Interior-Aviation Management 


Directorate certified plane and pilot, aviation safety plan, as well as all personal protective 


equipment (PPE) necessary for low-level flight.  Before each survey, the aviation safety plan will 


be reviewed by the Lead Biologist.  The Lead Biologist is responsible for initiating the flight 


planning and flight following procedures outlined in the aviation safety plan (Strobel 2011).  


 


Each observer will collect data on independent laptop computers (Table 3).  At a minimum, data 


collected will include the size of detected whooping crane groups, the spatial location of 


whooping cranes, the age-class of detected birds within the group (i.e., hatch-year, after-hatch-


year, or unknown age-class), and the track the aircraft flew.  Multiple techniques can be used to 


collect these data but any deviations from the equipment (Table 3) and techniques described 


below will be thoroughly vetted prior to its application to ensure ease of use, data integrity, and 


security.  The use of trade, firm, or product names is for reference only and does not constitute 


endorsement of any nature. 


 


Personal Protective Equipment: 


The personal protective equipment needed during low-level flight is aircraft dependent but 


generally includes (Department of the Interior 2008): 


1. Nomex flight suit or other fire-resistant clothing, 


2. Nomex or leather gloves, 
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3. aviation helmet, 


4. communication plug adapter, and 


5. close-toed leather footwear. 


 


Aviation Policy and Guidance: 


Consult the following policy and guidance when planning aerial survey activities: 


1. Office of Aviation Services, oas.doi.gov 


2. Federal Aviation Regulations, 14 CFR Part 91, www.ecfr.gov 


3. FWS Service Manual, Part 330, www.fws.gov/policy/manuals/ 


4. Aviation Life Support Equipment Handbook, www.iat.gov/docs/ALSE_2008.pdf 


5. DOI Department Manual, Part 352, oas.doi.gov/library/dm/index.htm 


 
Table 3.  Hardware needed to conduct aerial surveys for whooping cranes on their wintering 
grounds along the Texas gulf coast, USA. 


Equipment Purpose 


Phillips SpeechMike Pro – USB allows mouse-type interface with CPU and records audio files. 
Bluetooth GPS Receiver allows real-time position tracking through GIS. 
Panasonic Toughbook 19 displays and records spatial data via GIS. 
Spare Toughbook Battery ensures CPU runtime >5 hours. 
Garmin GPS 76 provides redundant data of aircraft’s flight path. 
Olympus Digital Voice Recorder records and stores audio files of observations. 


 


 
Aircraft type 


A Department of the Interior-Aviation Management Directorate certified plane and pilot are 


required.  The aircraft used during whooping crane monitoring should provide observers with as 


much visibility as possible.  A low instrument panel in the survey platform will allow forward 


observation of the transect, reducing the probability of missing groups on or near the transect.  


Further, use of aircraft with pontoons will likely reduce visibility along the line and their use will 


be avoided.  The aircraft selected should be comfortable for the observers.  We recommend using 


an aircraft similar to a Cessna 206. 


 
Establish and select sampling units 


 


Sampling Objectives 1–4: 


All PSF regions will be surveyed at least 6 times between 28 November–26 December.  As 


mentioned previously, CDS and HDS methods use the transects established within the PSF as the 


sampling units.  These sampling units are intended to remain static across surveys and years.  


Therefore, sampling units are predetermined and do not require selection on an annual or survey-


specific basis.  To ensure each region is sampled at various times of day (i.e., to avoid systematic 


bias), a randomly ordered list of the regions within the PSF will be used to determine the region 


in which each surveys will begin with (i.e., the first survey will begin with the first region on the 


list, the second survey will begin with the second region on the list, etc.).  Simple R code (R 


Development Core Team 2012) can be used to create this list (e.g., sample(c("BJ","LT","MIC", 


"WM","SJ","WF")) ).  After the randomly selected starting region, all regions will be surveyed in 


a clockwise fashion.  On a given survey flight, all transects within each region will be surveyed; 


however, safety and logistics may result in some transects or regions not being completed.  



http://oas.doi.gov/

file:///C:/A_USFWS/Whooping%20Crane%20Survey/WHCR%202012%20protocol%20development/www.ecfr.gov

http://www.fws.gov/policy/manuals/

http://www.iat.gov/docs/ALSE_2008.pdf

file:///C:/Users/bstrobel/Downloads/oas.doi.gov/library/dm/index.htm
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Transects within regions will be surveyed chronologically in ascending or descending order 


whichever is most efficient, safe, and logistically beneficial. 


 


Sampling Objective 5: 


All SSF regions will be surveyed at least twice between 28 November–26 December.  Use the 


transects established within the SSF as the sampling units.  These sampling units are intended to 


remain static across surveys and years.  Therefore, sampling units are predetermined and do not 


require selection on an annual or survey specific basis.  All transects within each SSF region will 


be surveyed at least twice between 28 November–26 December. 


 
Field data collection methods 


Stehn and Taylor (2008) postulated sun angle influenced the ability of observers to detect 


whooping cranes.  This was substantiated using experimental surveys of whooping crane decoys 


(Figure 12).  Data collected under high sun angles yielded more consistent detection curves 


which improved model performance and subsequent population estimates.  To avoid inconsistent 


detection rates, surveys will be conducted between 10:00 and 15:00 hours, or under high overcast 


conditions. 


 


 


Figure 12.  Predicted probability of detection for whooping crane decoy groups on Aransas 
National Wildlife Refuge, Texas, USA.  Predictions based on logistic regression of detection with 
covariates of group size, distance from transect (quadratic effect), and sun position.  Solid line is 
sun at observer’s back, dashed line is sun overhead, and dotted line is sun in observer’s face.  
The decoy experiment was conducted from a fixed-wing aircraft with pontoons resulting in 
reduced detection probability near the line.  Such aircraft will not be used in future surveys. 
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To ensure safe and consistent navigation along transects while in-flight, the location of transect 


endpoints will be entered into the aircraft navigation system.  Survey altitude and flight speed 


will be standardized to 60 m and 90 knots, respectively, as suggested by Stehn and Taylor 


(2008).  While in flight, the pilot’s primary responsibility is to safely navigate the aircraft along 


the transects.  Although the pilot is not an observer during the survey, the pilot is encouraged to 


communicate any incidental observations of whooping cranes they happen to detect.  Under most 


seating configurations the observer in the front seat is responsible for surveying forward of the 


aircraft and the starboard side.  The observer in the rear seat is responsible for surveying the port 


side of the aircraft.  While transects are being surveyed, each observer will allocate 90% of their 


attention ahead of a line perpendicular to the transect (i.e., 90°, Figure 13).  Since the aircraft is 


moving at 90 knots, cranes will only be visible for a few seconds.  Therefore, it is imperative that 


observers are constantly searching and scanning.  Observers must avoid staring themselves into a 


hypnotic state (Buckland et al. 2001).  Refer to section 7.6.2 in Buckland et al. (2001) for a good 


discussion on search protocol from aircraft. 


 


 


Figure 13.  Allocation of observer search effort for distance sampling-based survey methods for 
wintering whooping cranes along the Texas gulf coast, USA.  The gray area represents search 
effort by the front seat observer and the blue area represent search effort by the back seat 
observer. 


 


Complete detection of whooping crane along the line is imperative.  “Seeing everything close to 


the line is more important” than seeing as many whooping cranes as possible across the transect 
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width (Buckland et al. 2001:285).  To facilitate 100% detection on the line, the front seat 


observer should scan ahead of the aircraft for whooping cranes.  If the front seat observer is short 


and has difficulty seeing over the instrument panel, that observer will need to elevate their 


seating position (i.e., use a boat-seat cushion).  Also, the pilot often detects whooping cranes 


along the line; it is important that the pilot communicate those detections to the front seat 


observer.  


 


Observers will scan this area systematically, allocating less effort as distance from the aircraft 


increases.  Special attention must be made to ensure high, ideally perfect, detection on and near 


the transect.  To increase the detection rate of individuals on or near the transect, the observer in 


the front seat will be responsible for allocating effort ahead of the aircraft to detect cranes on or 


near the line.  Each observer will collect data independently in their own laptop computer.  


However, if the front seat observer detects whooping cranes on the port side of the aircraft, the 


front seat observer will immediately communicate that observation to the back seat observer and 


decide who is responsible for recording that detection. 


 


Each observer will mark the starting and ending location of each transect with a point in the 


feature class and use the digital voice recorder to record transect id (e.g., record point number, 


start or end of the transect, and transect id).  Upon detecting a whooping crane, the observer will 


determine whether the individual is a hatch-year (HY) or after-hatch-year (AHY) bird based 


upon its plumage coloration (Johnsgard 1983, Link et al. 2003).  If an observer has any doubt as 


to the species, that detection should not be recorded.  When the observer detects more than one 


whooping crane within 100 m of each other, the centroid of the group will be visually estimated 


and marked on the aerial image.  The observer then uses physical characteristics of the landscape 


(e.g., ponds, roads, shoreline, etc.) and the real-time GPS location of the aircraft to mark the 


location of the bird(s) in relation to a high resolution aerial image displayed on the laptop.  


Occasionally, flying whooping cranes will be observed.  If the location from which the group 


flushed is observed, that location will be marked.  If the location from which the group flushed is 


unknown, then observers will mark the location the group was first observed.  The label of the 


location will be displayed immediately upon the point being marked.  Using the digital voice 


recorder (make sure the microphone is turned on), the observer will then record the point number 


displayed on the GIS, and the number of whooping cranes of each age-class observed.  


Additionally, observers can record specific comments regarding the cranes (e.g., band 


information, feathers appear dirty, etc.) or the area they are using (e.g., salt marsh, hog rooting, 


pond with windmill, etc.).  After completing all transects within a region, each observer will 


“save edits” of the point feature class attribute table and verify the battery life remaining on the 


laptop.  If edits can be saved at other times, observers will do so.  It is important that data are 


saved as often as possible to ensure inadvertent data loss is avoided in the event of battery 


failure.  Check battery life often to avoid inadvertent data loss.  At the conclusion of a survey 


each observer should again “save edits” of the point feature class.  Any GPS unit collecting track 


data should be selected to save the track file and shut down.  As soon as observers return to the 


office, all data should be downloaded from the GPS units and laptops.  Data must be backed-up 


to an external hard drive or server drive before observers leave the office. 


 
Communication during survey 


Communication among the observers and the pilot during the survey is imperative.  Though the 


pilot is not an observer during the survey, the pilot should communicate any incidental 
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observations of whooping cranes.  The front seat observer, with assistance from the pilot, is 


responsible for detecting whooping cranes on and near the transect line including those under the 


aircraft on the port side.  The front seat and back seat observers can freely communicating their 


observations to one another while retaining their attention to the respective search areas (Figure 


13).  If the front seat observer detects whooping cranes under the port side of the aircraft, they 


need to immediately communicate that observation to the back seat observer in order to 


determine which observer will record that detection. 


 
Equipment failure 


Occasionally equipment failure during a survey will occur (e.g., laptop battery dies, recording 


device operated incorrectly, software glitch, etc.).  First, observers must do everything possible 


to avoid equipment failure (i.e., practice using all survey equipment prior to conducting surveys).  


If equipment failure occurs, observers will do the following: 


1. Observers will immediately stop the survey once problem is realized and begin flying 


outside the survey area. 


2. If the problem can be remedied in flight, observers will correct it. 


3. Once the problem is corrected, observers will determine where the data loss began and 


resume the survey at the beginning of the first transect in which data were lost. 


a. For example, if a laptop battery fails halfway through a PSF region and all data 


for that region are lost, observers will need to resurvey that entire PSF region 


once the battery is replaced. 


b. If microphone operation was an issue, the observer should examine the digital 


audio files and determine where the last detection was recorded.  Observers will 


need to restart the survey in that location. 


4. If the problem cannot be remedied in flight, observers should return to the airport. 


5. If enough time remains (i.e., surveys will be conducted between 10:00 and 15:00 hours) 


to complete the survey once the problem is corrected, observers should resume and 


complete the survey; otherwise, finish as much of the PSF as possible before 15:00 hours. 


a. Just as above, once the problem is corrected, observers will resume the survey at 


the beginning of the first transect in which data were lost. 


 
Environmental covariates 


Currently, environmental covariates are derived from the Texas Ecological Systems 


Classification Project (http://www.tpwd.state.tx.us/gis/gallery/), Phase 3 (Ludeke et al. 2012).  


The percent of each 1-km
2
 transect segment is determined for 6 general vegetation types: 


saltmarsh, open water, wetland, saltmarsh-shrubland, upland, and urban (Appendix E).  Though 


these covariates are only rudimentary, strong relationships with whooping crane abundance has 


been demonstrated with some of them (Strobel et al. 2012).  As additional maps of vegetation 


layers, other whooping crane resources (i.e., salinity, blue crab abundance, etc.), or management 


actions (i.e., time since prescribed burn, fresh water provisioning, etc.) become available and 


more detailed hypotheses of whooping crane abundance relationships are developed, additional 


environmental covariates will be derived and incorporated into the hierarchical models of 


abundance. 


 
End-of-season procedures 


At the conclusion of each field season all digital data collection or storage devices will be 


checked to ensure all data have been removed and archived and their memories are cleared.  In 



http://www.tpwd.state.tx.us/gis/gallery/
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addition, all electronic equipment will be stored in a cool and dry place with the batteries 


removed.  Verify the geodatabase (WHCR_SOP_yyyy-yyyy_ServCat) used to store that year’s 


data contains all required feature classes and tables properly labeled.  Complete the metadata 


(see Element 5–Metadata).  Archive the geodatabase on the Aransas NWR server, and contact 


the regional data management team for archiving in the Service Catalog (ServCat; see Element 


5–Data security and archiving; SOP 6).  Download the template geodatabases from the WHCR 


SharePoint to store the data collected for the next season. 


 


 


Element 5: Data Management 
 
Data entry, verification, and editing 


Step-by-step details for data collection, entry, verification, editing, and archiving can be found in 


the standard operating procedures (SOPs 1–6).  Some basic knowledge of ArcGIS and Program 


R are required.  Steps for pre-flight preparation and in-flight data collection are detailed in SOP1.  


SOP 1, along with Element 4, will be reviewed by each observer before each survey flight.  


General methods for data post-processing are described below (SOPs 2–5). 


 


At the completion of a given survey each observer should have a feature class (i.e., 


survey_mmddyy_obs1) with plotted locations of whooping crane observations as well as digital 


audio files containing the details of each observation.  Each observer will transcribe their own 


data (SOP 2) from their voice recordings into the corresponding fields in the feature class 


attribute table (i.e., WHITE, JUVEN, UNK) and archive the original audio files (SOP 6).  Each 


observer will also record the line transect from which each observation was made in the 


appropriate field in the feature class.  Once both observers have completed the data entry both 


feature classes shall be combined in the WHCR_SOP_mmddyy geodatabase. 


 


The design of the whooping crane survey is such that transects have been specified prior to the 


survey (i.e., ideal transects).  However, rarely can a pilot follow transects exactly.  Therefore, the 


track of the aircraft will be recorded during each survey with a GPS unit.  At the completion of a 


given survey, track data from the GPS should be imported into ArcMap as a line feature class.  


The “ideal transect” feature class and the track file will be used to create the survey-specific 


transect feature class (i.e., transects_mmddyy).  Each transect will be labeled in accordance with 


the labels of the “ideal transects” feature class (SOP 3). 


 


The terms fishnet and sampling frame are used interchangeably throughout this protocol as 


fishnet is a geospatial term and tool used to create a sampling frame.  In ArcMap, we will use the 


fishnet dissolved on region to clip the track file into transects and remove portions of the track 


file where surveys were not occurring (i.e., turns between transects, off transect forays, etc.).  


Once the track file is converted into a clean transect file, distance between observed whooping 


crane groups and transects will be calculated using SOP 3.  Once distances between detected 


whooping crane groups and transects are calculated, data will be summarized into text files (SOP 


4) and R objects (SOP 5) needed for data analyses. 


 


During post-processing intermediate feature classes and tables will be saved in the indicated 


geodatabases per the SOPs.  For daily back-up, the 2 observer geodatabases (i.e., 


WHCR_SOP_mmddyy_obs1 and WHCR_SOP_mmddyy_obs2) and the primary geodatabase 
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(i.e., WHCR_SOP_mmddyy) will be copied, renamed with an _bu suffix, zipped, and uploaded 


to the back-up folder on the WHCR SharePoint.  After post-processing the data (SOPs 2–4), the 


following objects should exist within the WHCR_SOP_mmddyy geodatabase, spreadsheets, and 


audio folders: 


• survey_mmddyy (point feature class) 


• cranes_mmddyy (point feature class) 


• transects_mmddyy (line feature class) 


• gen_near_tbl_mmddyy (database table) 


• track_mmddyy (line feature class) 


• CDS_mmddyy (database table) 


• CDS_mmddyy.txt (spreadsheets) 


• HDS_mmddyy (database table) 


• HDS_mmddyy.txt (spreadsheets) 


• SurveyAudio_mmddyy_obs1 (audio) 


• SurveyAudio_mmddyy_obs2 (audio) 


• track_mmddyy.txt (spreadsheets) 


 


The fishnets and ideal transects will remain in the WHCR_SOP_mmddyy geodatabase.  If new 


fishnets are need, see Appendix D.  If SSF regions become consistently occupied by whooping 


cranes and need to be promoted to PSF regions, see Appendix J. 


 
Survey-specific conditions data 


Information regarding survey conditions and logistics may be valuable for future analysis and 


interpretation of a survey’s results.  For example, weather conditions may influence the 


detectability of whooping cranes on a given survey or within a given sampling frame.  If these 


characteristics are recognized and recorded they can potentially be incorporated into multi-


survey analyses.  Therefore, immediately prior to departure from the airport one observer 


(responsibility of the Lead Biologist) should record the automated weather observation station’s 


(AWOS) report.  The AWOS broadcasts a loop of up-to-the-minute weather conditions at the 


airport and is commonly used by pilots.  Consult the pilot or airport personnel to obtain the 


frequency of the local AWOS (the Aransas County Airport AWOS can be found at 


http://w1.weather.gov/obhistory/KRKP.html).  Prior to taxiing, record the following information 


from the AWOS: 


1. wind speed, 


2. wind direction, 


3. sky conditions, 


4. visibility, and 


5. temperature. 


 


In addition to the information from the AWOS, record the following information: 


1. aircraft type (e.g., Cessna 182) and configuration (e.g., retractable gear, STOL kit), 


2. pilot’s name, 


3. name and seating location (Observer 1), 


4. name and seating location (Observer 2), and 


5. recent weather events (e.g., precipitation, drought, red tides, cold fronts, etc.). 


 



http://w1.weather.gov/obhistory/KRKP.html
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Metadata 


Appendix G lists and describes which files must be archived and provides a description of each 


data field in each dataset (i.e., data dictionary).  Metadata should be provided as part of the 


whooping crane geodatabase.  This geodatabase in final, end of season form is the 


WHCR_SOP_yyyy-yyyy_ServCat.gdb.  Metadata for the survey_mmddyy feature class should 


include information about equipment issues, search effort, and type of GPS unit used.  A 


database table will include information about each survey flight including aircraft type, AWOS 


data, and observers’ names and positions.  Metadata for the cranes_mmddyy and 


transects_mmddyy feature classes should indicate issues encountered in the post-flight data 


processing.  Each of the feature classes’ metadata shall reference this survey protocol’s ServCat 


ID number. 


 
Data security and archiving 


Prior to 2013, the aerial survey data was stored on the Aransas NWR server.  Per this protocol 


for future surveys, the aerial survey data will be stored both on the Aransas NWR Server and 


duplicated on the WHCR Aerial Surveys (TX Coast) SharePoint site (Figure 14). 


 


 


Figure 14. Overview of data management and data archiving for winter aerial surveys of whooping 
cranes on the Texas gulf coast, USA. 


 


After completing SOPs 1–4 for each survey date, the data shall be uploaded to the SharePoint 


site for duplication.  The WHCR Aerial Surveys (TX Coast) SharePoint contains a folder called 


WHCR_aerial_surveys_bu explicitly for redundancy to prevent data loss.  This SharePoint site 


has restricted permissions.  The Supervisory Biologist at Aransas NWR will ask the regional data 


management team to assign specific personnel access to this site (Appendix H).  After each flight 


year, Aransas NWR will upload the final data to SharePoint, inform the regional data 


management team that the data upload has occurred, and that the data is ready for ServCat.  The 


WHCR Aerial Surveys (TX Coast) SharePoint site is located at: 


https://fishnet.fws.doi.net/regions/2/nwrs/IM/WHCR/SitePages/Home.aspx. 


 


The regional data management team is responsible for uploading the data to ServCat, and 


providing the ServCat ID both to the refuge contact and in the metadata for the geodatabase.  


Survey Data: 


•Download from GPS. 


• Transcribe audio files. 


•Raw data (include rough metadata). 


•Post-Processed data. 


• Store on Aransas and on WHCR 
SharePoint (SP).   


WHCR Aerial Survey SP: 


•WHCR_aerial_survey_bu for 
redundancy. 


•WHCR_aerial_survey_ServCat for 
yearly final data. 


• Stored on SP for 3 years. 


• Templates - provide blank 
geodatabases for  Aransas NWR to 
assist with SOPs. 


• Environmental Covariates - provide 
one geodatabase for development 
of  covariates (Appendix E). 


Final: 


•Move data to ServCat by regional 
data management (DM) team after 
contact from Aransas NWR. 


•DM team provides ServCat ID to 
staff.  Staff updates that item in the 
GIS Metadata. 


• ServCat status set to internal. 


• Stored on ServCat indefinitely. 



https://fishnet.fws.doi.net/regions/2/nwrs/IM/WHCR/SitePages/Home.aspx
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ServCat is the USFWS’s document and geospatial repository.  Permission levels in ServCat will 


be set to Restricted.  ServCat can be accessed at: https://ecos.fws.gov/ServCat. 


 


 


Element 6: Data Analysis 
 
Analysis methods  


Prior to analyses, data should be prepared following the data preparation guidelines in the 


standard operating procedures (SOPs 4–5).  Most of the analysis will be conducted in RStudio 


(2012), an interface for Program R (Crawley 2007, R Development Core Team 2012).  Example 


R Scripts for the various analyses have been provided in Appendix C.  These scripts are intended 


to provide guidance in data analyses but should be modified according to the needs of a 


particular analysis (i.e., new landscape covariates become available allowing development of 


new models of abundance).  Once data analyses are complete, R Scripts will be saved and stored 


for future reference.  Further, the R Workspace, which is the working environment of Program R 


that includes all user-defined objects such as data frames and functions, will be saved and stored 


for future reference.  Also, the function sessionInfo() will be used to store information about 


the versions of packages and libraries used in the analysis.  For example, the version of R and all 


the attached packages used in the analysis will be stored with versions=sessionInfo().  All 


versions of packages and libraries used in the analysis will be stored in the saved R Workspace. 


 


Other analyses such as conventional distance sampling in Program Distance (Thomas et al. 2010) 


may be warranted.  Save and store Distance projects as “zip archive files” using the export 


project option in Program Distance.  Also, Program TRENDS (Gerrodette 1987, 1991, 1993) 


stores the results of power analyses in a file named “TRENDS.OUT.” 


 


Sampling Objectives 1–4: 


Data will be pooled for the surveys conducted during the 28 November–26 December survey 


period, resulting in one estimate of abundance, HY:AHY ratio, number of adult pairs, and 


number of recruitive pairs, and one spatially-explicit model of abundance (perhaps a model 


average).  The whooping crane survey data will be analyzed using the distsamp or gdistsamp 


function of package unmarked in program R (Fiske and Chandler 2011, R Development Core 


Team 2012).  The distsamp function can only fit the multinomial-Poisson mixture model of 


Royle et al. (2004).  However, the generalized HDS model of Chandler et al. (2011), which 


allows abundance to be modeled using a negative binomial, can be fit using the gdistsamp 


function (e.g., Sillet et al. 2012).  Chandler (2011) provided an easy to follow description 


(vignette) to guide analyses of distance sampling data using package unmarked.  Following the 


vignette-style, Appendix C provides some guidelines for data analysis and R code development 


based on the distsamp function. 


 


If repeated surveys are conducted, the generalized HDS model is designed to estimate the 


availability survey objects.  This can be used to account for individuals in the sampling frame 


that are not available for detection (i.e., marine mammals that are underwater such as whales, 


fossorial animals that are underground such as prairie dogs), account for incomplete detection on 


the line (i.e., situations where detection is obscured by aircraft type), or estimate temporary 


emigration among sampling units.  However, if temporary emigration and incomplete detection 


(or availability) are both occurring, generalized HDS models cannot account for both and will 



https://ecos.fws.gov/ServCat
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result in positive bias in estimates.  Thus, it is imperative to maintain complete detection on the 


transect line.  Currently, we plan to pool all the surveys from the 28 November–26 December 


survey period and use the model configuration that ignores temporary emigration (see Appendix 


C–A note about generalized HDS). 


 
Archiving data analysis files 


Once a final comprehensive report is completed, files resulting from data analyses will be 


uploaded to ServCat by the regional data management team.  Files will include any R 


Workspaces and R Scripts generated by the final data analysis. 


 
Software  


Multiple software programs facilitate the collection, processing, storage, and analyses of the data 


collected during this monitoring effort.  Recommended software and their sources are: 


• ESRI® ArcMap™ 10.0, www.esri.com 


• ESRI® ArcCatalog™ 10.0, www.esri.com 


• ESRI® ArcGIS Desktop Service Pack 2, www.esri.com 


• Microsoft® Excel 2010, www.microsoft.com 


• Program DISTANCE, www.ruwpa.st-and.ac.uk/distance/ 


• DNR Garmin, www.dnr.state.mn.us/mis/gis/DNRGPS/DNRGPS.html 


• Geospatial Modeling Environment (GME), www.spatialecology.com 


• Program R, cran.r-project.org 


• RStudio, rstudio.org 


• R Package unmarked, cran.r-project.org/web/packages/unmarked/ 


• TRENDS, swfsc.noaa.gov/textblock.aspx?Division=PRD&ParentMenuId=228&id=4740  


 


More information regarding R Package unmarked can be obtained from: 


• Unmarked webpage, sites.google.com/site/unmarkedinfo/home 


• Unmarked Google Group, groups.google.com/forum/?fromgroups#!forum/unmarked 


 


Other potentially useful R Packages include: 


• R Package dsm, cran.r-project.org/web/packages/dsm/ 


• R Package mrds, cran.r-project.org/web/packages/mrds/ 


• R Package Distance, cran.r-project.org/web/packages/Distance/ 


• R Package Rdistance, cran.r-project.org/web/packages/Rdistance/ 


 


 


Element 7: Reporting 
 


A survey is not completed until the results have been documented in one or more reports, 


archived for future reference in the Service Catalog (https://ecos.fws.gov/ServCat/), and 


disseminated to interested parties.  The regional data management team will assist or provide the 


ServCat data entry and the ServCat ID. 


 
Reports 


Reports will be divided into three types: update, interim, and comprehensive reports.  Update 


reports will be prepared a few days after each survey and summarize survey activities but will 


not provide comprehensive results.  Interim reports will be issued at least once yearly during the 



http://www.esri.com/

http://www.esri.com/

http://www.esri.com/

http://www.microsoft.com/

http://www.ruwpa.st-and.ac.uk/distance/

http://www.dnr.state.mn.us/mis/gis/DNRGPS/DNRGPS.html

http://www.spatialecology.com/

file:///C:/A_USFWS/Whooping%20Crane%20Survey/WHCR%202012%20protocol%20development/cran.r-project.org

file:///C:/A_USFWS/Whooping%20Crane%20Survey/WHCR%202012%20protocol%20development/rstudio.org

http://cran.r-project.org/web/packages/unmarked/

http://swfsc.noaa.gov/textblock.aspx?Division=PRD&ParentMenuId=228&id=4740

file:///C:/Users/ceichhorn/Downloads/sites.google.com/site/unmarkedinfo/home

file:///C:/Users/ceichhorn/Downloads/groups.google.com/forum/%3ffromgroups%23!forum/unmarked

file:///C:/A_USFWS/Whooping%20Crane%20Survey/WHCR%202012%20protocol%20development/cran.r-project.org/web/packages/dsm/

file:///C:/A_USFWS/Whooping%20Crane%20Survey/WHCR%202012%20protocol%20development/cran.r-project.org/web/packages/mrds/

file:///C:/A_USFWS/Whooping%20Crane%20Survey/WHCR%202012%20protocol%20development/cran.r-project.org/web/packages/Distance/

file:///C:/A_USFWS/Whooping%20Crane%20Survey/WHCR%202012%20protocol%20development/cran.r-project.org/web/packages/Rdistance/

https://ecos.fws.gov/ServCat/
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overwinter period in which whooping cranes inhabit areas on and around Aransas NWR.  


Comprehensive reports will be issued every 3 to 5 years and provide comprehensive 


documentation of monitoring efforts for wintering whooping cranes.  Compilation of interim and 


comprehensive reports will be a collaborative effort among the Lead Biologist, Regional 


Biometrician, Regional Data Manager, and Whooping Crane Recovery Coordinator (see Element 


8–Roles and responsibilities).  Update reports are the responsibility of the Lead Biologist with 


assistance from other observers.  Also, we recommend periodic (i.e., every 3 to 5 years) 


publication of survey results in the peer-reviewed scientific literature. 


 


Update Reports: 


Update reports will provide brief summaries of survey activities.  These reports will describe the 


flight mission, survey conditions, aircraft used, search effort, who were the observers, and the 


number of detections.  The reports will not provide comprehensive results but are intended as a 


simple permanent record of short-term monitoring activities and survey-specific conditions.   


Appendix F is a template for update reports.  Since update reports only contain information about 


raw data and no results, we recommend not distributing update reports widely unless absolutely 


necessary.  This is because raw data from a survey where detection of whooping cranes is not 


100% can be misleading, misinterpreted, and misused. 


 


Interim Reports: 


Interim reports will be brief summaries of survey activities and results designed to update 


stakeholders and USFWS personnel.  These reports are not intended to be comprehensive but 


should provide enough information to explain number of surveys completed, search effort, 


weather conditions during surveys, and summary statistics of interest (i.e., annual winter 


abundance estimate, HY:AHY ratio, number of adult pairs, number of recruitive pairs, number of 


HY birds; see Element 7–Summary statistics of interest).  One interim report will be issued after 


the 26 November–26 December survey period (i.e., March); any additional interim reports are 


optional. 


 


Comprehensive Reports: 


Comprehensive reports will be a complete account of monitoring efforts for wintering whooping 


cranes.  These reports will only be issued every 3 to 5 years.  They will describe background 


information and survey objectives, briefly describe survey methodology, provide details of data 


analyses, report results, provide comparison with previous years and report trends, discuss 


important findings, and provide context for management and planning decisions.  Deviations 


from protocol will be described though deviations are to be avoided if possible. 


 
Summary statistics of interest  


In interim and comprehensive reports, we will report 5 summary statistics and their associated 


coefficients of variation (CV), and 95% confidence intervals (95% CI).  Those summary 


statistics are: 


1. annual winter abundance estimate within the primary sampling frame, 


2. HY:AHY ratio (index of juvenile recruitment) between 28 November–26 December 


within the primary sampling frame, 


3. estimated number of adult pairs between 28 November–26 December within the primary 


sampling frame, 
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4. estimated number of recruitive pairs (i.e., number of adult pairs with HY birds) between 


28 November–26 December within the primary sampling frame, and 


5. estimated number of HY birds between 28 November–26 December within the primary 


sampling frame. 


In addition to these 5 statistics, comprehensive reports will contain: 


6. summaries of the number of detections in SSF regions will be provided to document 


monitoring of range expansion (see Element 7– Comparison with estimates from the 


traditional technique). 


7. summaries of whooping cranes observed outside of the primary sampling frame will be 


reported separately and identified according to the source of the observation. 


 


Wildlife managers and decision makers are often interested in understanding the relationships 


between whooping crane abundance and environmental covariates.  The covariates included in a 


priori models will be listed and the a priori models described in the comprehensive reports.  The 


coefficients (i.e., slopes) and their standard errors of covariates included in the best or 


“averaged” model(s) will be summarized in the comprehensive reports. 


Documentation of analysis  


In comprehensive reports, data analyses will be described in a manner similar to typical scientific 


journal articles and provide adequate detail for a reader to duplicate it (e.g., Block et al. 2011).  


The comprehensive report will document the assumptions that were made to complete analyses 


and rationale for the analyses.  The rationale for the development of a priori model set(s) will be 


described as well.  As additional environmental covariate become available or land-classification 


systems available for use change, a priori model set(s) may need to be modified according to the 


available environmental data. 


 


Once data analyses are complete, R Scripts will be saved and stored for future reference.  


Further, the R Workspace, which is the working environment of Program R that includes all 


user-defined objects such as data frames and functions, will be saved and stored for future 


reference.  Also, the function sessionInfo() will be used to store information about the versions 


of packages and libraries used in the analysis.  Analyses conducted in other software will be 


saved as well.  These files will be archived with reports on ServCat. 


 
Implications and application 


The primary management objectives driving this monitoring effort are providing metrics for 


assessing progress towards downlisting criteria (CWS and USFWS 2007) and development of 


spatially-explicit resource use models that can facilitate land conservation through the 


delineation of important habitat and the prioritization of land protection.  These management 


objectives will be pursued through coordination with partners in Ecological Services and the 


National Wildlife Refuge Planning Division. 


Long-term trends are important for conservation planning and population management (Thomas 


et al. 2004).  Therefore, power analyses (like those demonstrated in Appendix A) will be used to 


assess the capacity of the monitoring efforts to detect trends prescribed in objective 1 and help 


elucidate limitations or improvement for future monitoring efforts.  This will be used to provide 


recommendation for continuing, discontinuing, or modifying efforts in the future.  All reports 
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should include a brief discussion of implications and recommendations that stem from these 


monitoring activities. 


 
Comparison with estimates from the traditional technique 


We recommend caution when comparing estimates from the new technique with estimates from 


the traditional technique.  The traditional technique attempted to incorporate whooping crane 


observations from outside of the sampling frame into the reported estimated.  However, 


estimates obtained with the new technique are only applicable to the primary sampling frame. 


 


Whooping cranes observed outside of the primary sampling frame will be reported separately 


and identified according to the source of the observation (e.g., Texas Whooper Watch, satellite 


transmitter, or secondary sampling frame during aerial survey efforts).  However, adding these 


reported birds to the estimate presents potential problems.  For example, we cannot ever be 


completely certain that whooping cranes observed outside the primary sampling frame on one 


day did not move to or from the primary sampling frame before the surveys were completed. 


 
Reporting schedule 


Update reports will typically be made a few days after each survey but delays due to survey 


schedules may occur.  One interim report (optionally two) will be issued each year and 


comprehensive reports will only be issued every 3 to 5 years (Figure 15). 


 


 


Figure 15.  Reporting schedule for whooping crane monitoring activities on and around Aransas 
National Wildlife Refuge, Texas, USA. 


 


Interim Reports: 


Interim reports will be issued in late-winter and optionally in late-spring of each year.  The first 


interim report will provide an update and interim analysis of the surveys conducted between 28 


November–26 December.  The optional second interim report will provide an update and interim 


analysis of the surveys conducted during the optional survey periods (i.e., January, February, and 


March).  The second interim report is relevant only if surveys are conducted during other 


periods. 


 


Comprehensive Reports: 


Comprehensive reports will be a complete account of monitoring efforts for wintering whooping 


cranes.  Therefore, those reports will only be issued on a semiannual basis (i.e., every 3 to 5 


years).  These reports will document all monitoring activities, detail methods and analyses, 


summarize annual results, and the implications and application of those results.  Also, 


comparison with previous years and trend analysis will be reported. 


Interim Report 1 
(Nov-Dec surveys): 


late-winter 


Interim Report 2 
(optional surveys): 


late-spring 


Comprehensive 
Reports: every 3 


to 5 years 
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Interim reports are considered optional given time constrains of USFWS personnel.  However, 


comprehensive reports are not optional and must be completed in a timely manner (i.e., every 3 


to 5 years). 


Report distribution  


Each interim and comprehensive report will be distributed to interested USFWS personnel and 


other partners via the Aransas NWR website (www.fws.gov/refuge/aransas/).  All reports must 


contain the following disclaimer (USFWS 2010).  “The findings and conclusions in this article 


are those of the author(s) and do not necessarily represent the views of the U.S. Fish and 


Wildlife Service.”  U.S. Fish and Wildlife Service policy requires that authors add a disclaimer 


because reports are not specifically reviewed for policy implications, and they may or may not 


represent the official views of the Service (USFWS 2010).  Also, the authors of reports should 


follow the guidelines outlined in “Information Quality Guidelines and Peer Review” (USFWS 


2012a). 


Archiving  


Data and reports will be archived in ServCat (USFWS 2012b).  Many data files are produced 


during data manipulation stages.  Appendix G lists and describes which files must be archived 


and provides a description of each field in each dataset (i.e., data dictionary).  The WHCR Aerial 


Surveys (TX Coast) SharePoint site will serve as a duplicate data site for the survey data.  When 


the final, end of season survey data is ready, Aransas NWR staff will upload this data to the 


SharePoint into the WHCR_aerial_surveys_ServCat location, and notify the regional data 


management team by email.  The regional data management team will upload the data into 


ServCat. 


 


 


Element 8: Personnel Requirements and Training 
 
Roles and responsibilities 


Two observers and one pilot are needed to conduct the survey.  The pilot must be Department of 


the Interior-Aviation Management Directorate certified.  One observer will serve as Lead 


Biologist for the monitoring effort and will be responsible for coordinating pilots, equipment, 


and personnel and initiating the flight planning and flight following procedures outlined in the 


aviation safety plan (Strobel 2011).  The Second Observer will be responsible for assisting the 


Lead Biologist with coordinating logistics.  Data analysis will be conducted by the Regional 


Biometrician or trained and qualified biologist.  Compilation of interim and comprehensive 


reports will be a collaborative effort among the Lead Biologist, Regional Biometrician, Regional 


Data Manager, and Whooping Crane Recovery Coordinator (see Element 7–Reports).  Update 


reports are the responsibility of the Lead Biologist with assistance from other observers. 


 
Qualifications 


Observers will be trained to conduct surveys.  New observers must participate as a non-observer 


in the fourth seat of the aircraft during at least 3 surveys (i.e., 3 full survey days) with 


experienced observers.  Observers must have a strong stomach; otherwise, motion sickness 


medication may be needed.  Good eyesight is required for observers.  Observers must have the 


ability to endure 5 hours or more of sitting in a cramped aircraft.  Superior knowledge of birds of 


the Texas coast is needed for observers.  At minimum, observers must be able to distinguish the 



http://www.fws.gov/refuge/aransas/
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species of white-colored birds from great distances; practice is recommended (Figure 11).  High 


confidence and ability to identify whooping cranes, sandhill cranes, American white pelicans 


(Pelecanus erythrorhynchos), great egrets (Ardea alba), snowy egrets (Egretta thula), cattle 


egret (Bubulcus ibis), and snow geese (Chen caerulescens) at great distances are required.  All 


staff involved in conducting, coordinating, and analyzing data from these surveys must conduct 


monitoring activities with scholarly and scientific integrity (USFWS 2011). 


 
Training 


Pilots and observers must have the required aviation training outlined in USFWS Service 


Manual, 330 FW 3 (www.fws.gov/policy/330fw3.html).  The training courses needed are B3-


Combination Helicopter/Airplane Safety and M3-DOI Aviation Management Training for 


Supervisors.  We also recommend observers have A312-Water Ditching and Survival.  More 


information regarding these and other aviation training courses are available at the Interagency 


Aviation Training website (https://www.iat.gov/Training/course_list.asp).  Observers need to be 


CPR/First Aid certified in case of emergencies.  At least one alternate observer should be trained 


in case one of the primary observers is not able to conduct a survey. 


 


It is important observers are familiar with all the equipment and how to operate it.  Observers 


must practice using all survey equipment prior to conducting whooping crane surveys.  We 


recommend that observers practice using the equipment from an automobile prior to conducting 


surveys each year.  Without practice, costly mistakes during monitoring activities could result in 


data loss.  Losing data because of simple, avoidable mistakes is unacceptable. 


 


 


Element 9: Operational Requirements 
 
Budget  


Annual and extended costs required for the complete implementation of this protocol (i.e., not 


objective specific) are divided into several categories (i.e., Pilot Travel, Survey Costs, 


Equipment, Staff Costs, Office Supplies; Table 4).  Costs associated with pilot travel and flight 


costs were forecast to include an annual increase of ≈10%.  Staff costs were forecast to increase 


annually by ≈3%.  The largest line item cost of the survey was staff costs, yet see Element 9–


Staff time below (Table 4).  Equipment cost were estimated to be incurred every third year to 


ensure reliable collection of data (Table 4). 


 
Staff time  


The total staff time required to complete all portions of this protocol (i.e., training, survey 


preparation, data collection, data processing, data analysis, and reporting and distribution) have 


been estimated based upon the approximate time required for completion in 2011–2012 (Table 


5).  As familiarity with methods increases total staff time required to complete the protocol may 


decrease.  Staff time is contributed by two observers (e.g., Refuge Biologists) and the Regional 


Biometrician.  The estimated Full Time Employee (FTE) equivalence to complete this survey is 


0.47. 


 
Schedule  


Field data collection will occur annually between 28 November and 31 March.  To meet 


sampling objectives 1–4, data collection will occur annually between 28 November and 26 



http://www.fws.gov/policy/330fw3.html
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December.  To ensure adequate power has been obtained to meet sampling objective 1 it is 


expected that data processing, data analysis, and reporting will be conducted as soon after the 


completion of the 28 November–26 December surveys as practical.  Similarly, data processing, 


analysis, and reporting should be conducted as soon after subsequent survey periods (e.g., 


January, February, and March survey periods) as practical (Figure 15).  However, interim reports 


will only be issued once annual (optionally twice) and comprehensive reports will only be issued 


every 3 to 5 years (Figure 15).  The interim reports are of lowest priority and are, thus, 


considered optional given time constrains of USFWS personnel.  However, comprehensive 


reports are not optional and must be completed in a timely manner (i.e., every  3 to 5 years). 


 
Table 4.  Estimated budget for monitoring whooping cranes on their wintering grounds along the 
Texas gulf coast, USA. 


Budget item FY2013 FY2014 FY2015 FY2016 FY2017 Total 


28 November–26 December Survey Period 


Pilot Travel $2,000 $2,250 $2,500 $2,750 $3,000 $12,500 


Survey Flight $7,000 $8,000 $9,000 $10,000 $11,000 $45,000 


Staff Costs $15,000 $15,500 $16,000 $17,000 $18,000 $81,500 


Survey Equipment $8,000 $0 $0 $8,000 $0 $16,000 


Office Supplies $2,500 $2,500 $2,500 $2,500 $2,500 $12,500 


Subtotal $34,500 $28,250 $30,000 $40,250 $34,500 $167,500 


Optional Survey Periods (January, February, and/or March) 


Pilot Travel $2,000 $2,250 $2,500 $2,750 $3,000 $12,500 


Survey Flight $7,000 $8,000 $9,000 $10,000 $11,000 $45,000 


Staff Costs $15,000 $15,500 $16,000 $17,000 $18,000 $81,500 


Subtotal $24,000 $25,750 $27,500 $29,750 $32,000 $139,000 


Total $58,500 $54,000 $57,500 $70,000 $66,500 $306,500 


 


 
Table 5.  Estimated staff time to complete annual monitoring of whooping cranes on their 
wintering grounds along the Texas gulf coast, USA.  Estimates based on number of times and 
duration of each activity during winter 2011–2012. 


  Number Duration (hr) Staff Total (hr) 


Training   3 16 2   32 


Survey Preparation 12   4 2   96 


Data Collection 12   8 2 192 


Data Processing 12   8 2 192 


Data Analysis   3 40 1 240 


Reporting and Distribution     3+ 40 2 240 


Total       992 


 


 
Coordination 


Monitoring of whooping cranes on their wintering grounds will be coordinated by the Lead 


Biologist.  The Lead Biologist will need to coordinate funding through the Region 2 Chief of 


Biological Sciences, data analyses through the Regional Biometrician or other qualified 


personnel, and communication with the Whooping Crane Recovery Team through the Whooping 


Crane Recovery Coordinator.  The Lead Biologist will typically be the Supervisory Biologist at 
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Aransas NWR.  Optionally, the Lead Biologist may be the Whooping Crane Recovery 


Coordinator in the absence of a Supervisory Biologist at Aransas NWR. 


 


 


Element 10: References 
 


Allen, R. P.  1952.  The whooping crane.  Research report.  National Audubon Society, New 


York, New York, USA. 


Anderson, D. R.  2001.  The need to get the basics right in wildlife field studies.  Wildlife 


Society Bulletin 29:1294−1297. 


Anderson, D. R.  2003.  Response to Engeman: index values rarely constitute reliable 


information.  Wildlife Society Bulletin 31:288–291. 


Anderson, D. R.  2008.  Model based inference in the life sciences: a primer on evidence. 


Springer, New York, USA. 


Anderson, D. R., and K. P. Burnham.  2002.  Avoiding pitfalls when using information-theoretic 


methods.  Journal of Wildlife Management 66:912–918. 


Anderson, D. R., K. P. Burnham, W. R. Gould, and S. Cherry.  2001.  Concerns about finding 


effects that are actually spurious.  Wildlife Society Bulletin 29:311–316. 


Arnold, T. W.  2010.  Uninformative parameters and model selection using Akaike’s Information 


Criterion.  Journal of Wildlife Management 74:1175–1178. 


Block, W. M., F. R. Thompson, D. Hanseder, A. Cox, and A. Knipps.  2001.  Journal of Wildlife 


Management guidelines.  The Wildlife Society, Bethesda, Maryland, USA.  


<http://joomla.wildlife.org/documents/JWMguidelines2011.pdf>.  Accessed 11 June 


2013. 


Bodie, W. L., E. O. Garton, E. R. Taylor, and M. A. McCoy.  1995.  A sightability model for 


bighorn sheep in canyon habitats.  Journal of Wildlife Management 59:832–840. 


Bonds, C. J.  2000.  Characterization of banded whooping crane winter territories from 1992–93 


to 1996–97 using GIS and remote sensing.  Thesis.  Texas A&M University, College 


Station, USA. 


Boyce, M. S.  1986.  Time-series analysis and forecasting of the Aransas/Wood Buffalo 


whooping crane population. Pages 1–9 in J. C. Lewis, editor.  Proceedings 1985 Crane 


Workshop.  Platte River Whooping Crane Maintenance Trust and U.S. Fish and Wildlife 


Service, Grand Island, Nebraska, USA. 


Boyce, M. S., and R. S. Miller.  1985.  Ten-year periodicity in whooping crane census.  Auk 


102:658–660. 







 


43 


 


Buckland, S. T., D. R. Anderson, K. P. Burnham, J. L. Laake, D. L. Borchers, and L. Thomas.  


2001.  Introduction to distance sampling: estimating abundance of biological populations.  


Oxford University Press, New York, New York, USA. 


Buckland, S. T., D. R. Anderson, K. P. Burnham, J. L. Laake, D. L. Borchers, and L. Thomas, 


editors.  2004.  Advanced distance sampling: estimating abundance of biological 


populations.  Oxford University Press, United Kingdom. 


Burnham, K. P., and D. R. Anderson.  2002.  Model selection and multimodel inference: a 


practical information-theoretic approach.  Second edition.  Springer, New York, New 


York, USA. 


Burnham, K. P., D. R. Anderson, and J. L. Laake. 1980. Estimation of density from line transect 


sampling of biological populations. Wildlife Monographs 72:1–202. 


Butler, M. J., W. B. Ballard, M. C. Wallace, S. J. DeMaso, and B. K. McGee.  2007.  Aerial 


surveys for estimating wild turkey abundance in the Texas Rolling Plains.  Journal of 


Wildlife Management 71:1639–1645. 


Butler, M. J., G. Harris, and B. N. Strobel.  2013.  Influence of whooping crane population 


dynamics on its recovery and management.  Biological Conservation 162:89–99. 


Butler, M. J., K. L. Metzger, and G. Harris.  Whooping crane demographic responses to winter 


drought focuses conservation strategies.  In preparation. 


Canadian Wildlife Service and U.S. Fish and Wildlife Service.  2007.  International recovery 


plan for the whooping crane (Grus americana).  Third revision.  Environment Canada, 


Ottawa and U.S. Fish and Wildlife Service, Albuquerque, New Mexico, USA. 


Caughley, G., R. Sinclair, and D. Scott-Kemmis.  1976.  Experiments in aerial survey.  Journal 


of Wildlife Management 40:290–300. 


Chadès, I., E. McDonald-Madden, M. A. McCarthy, B. Wintle, M. Linkie, and H. P. 


Possingham.  2008.  When to stop managing or surveying cryptic threatened species.  


Proceedings of the National Academy of Science of the United States of America 


105:13936–13940. 


Chandler, R. B.  2011.  Distance sampling analysis in unmarked. Vignette, R Foundation for 


Statistical Computing. <http://127.0.0.1:42549/help/library/unmarked/doc/distsamp.pdf>.  


Accessed 1 August 2012. 


Chandler, R. B., and D. I. King.  2011.  Habitat quality and habitat selection of golden-winged 


warblers in Costa Rica: an application of hierarchical models for open populations.  


Journal of Applied Ecology 48:1038–1047. 


Chandler, R. B., J. A. Royle, and D. I. King.  2011.  Inference about density and temporary 


emigration in unmarked populations.  Ecology 92:1429–1435. 







 


44 


 


Conroy, M. J., and J. P. Carroll.  2009.  Quantitative conservation of vertebrates.  John Wiley & 


Sons, New York, New York, USA. 


Conroy, M. J., J. T. Peterson, O. L. Bass, C. J. Fonnesbeck, J. E. Howell, C. T. Moore, and J. P. 


Runge.  2008.  Sources of variation in detection of wading birds from aerial surveys in 


the Florida Everglades.  Auk 125:731–743. 


Crawley, M. J.  2007.  The R book.  John Wiley & Sons, Hoboken, New Jersey, USA. 


Department of the Interior.  2008.  Aviation life support equipment (ALSE) handbook.  351 DM 


1 Supplement, Department of the Interior, Washington, D.C., USA.  


<www.iat.gov/docs/ALSE_2008.pdf>. 


Department of the Interior.  2011.  Integrity of scientific and scholarly activities.  Part 305, 


Chapter 3, Section 7 in Department manual.  Department of the Interior, Washington, 


D.C., USA.  <www.fws.gov/science/pdf/DOIScientificIntegrityPolicyManual.pdf>. 


Drewien, R. C., W. M. Brown, and W. L. Kendall.  1995.  Recruitment in Rocky Mountain 


greater sandhill cranes and comparison with other crane populations.  Journal of Wildlife 


Management 59:339–356. 


Elith, J., S. J. Phillips, T. Hastie, M. Dudik, Y. E. Chee, and C. J. Yates.  2011.  A statistical 


explanation of MaxEnt for ecologists.  Diversity and Distributions 17:43−57. 


Fewster, R. M., and A. R. Pople.  2008.  A comparison of mark-recapture distance-sampling 


methods applied to aerial surveys of eastern grey kangaroos.  Wildlife Research 35:320–


330. 


Fiske, I. J.,and R. B. Chandler.  2011.  Unmarked: an R package for fitting hierarchical models 


of wildlife occurrence and abundance.  Journal of Statistical Software 43:1–23. 


Gerrodette, T.  1987.  A power analysis for detecting trends.  Ecology 68:1364–1372. 


Gerrodette, T.  1991.  Models of power of detecting trends: a reply to Link and Hatfield.  


Ecology 72:1889–1892. 


Gerrodette, T.  1993.  Program TRENDS: user’s guide.  Southwest Fisheries Science Center, La 


Jolla, California, USA. 


Graham, M. H.  2003.  Confronting multicollinearity in ecological multiple regression.  Ecology 


84:2809–2015. 


Green, M. C., M. C. Luent, T. C. Michot, C. W. Jeske, and P. L. Leberg.  2008.  Comparison and 


assessment of aerial and ground estimates of waterbird colonies.  Journal of Wildlife 


Management 72:697–706. 


Guenzel, R. J.  1997.  Estimating pronghorn abundance using aerial line transect sampling.  


Wyoming Game and Fish Department, Cheyenne, USA. 







 


45 


 


Hedley, S. L., S. T. Buckland, and D. L. Borchers.  2004.  Spatial distance sampling models. 


Pages 48–70 in S. T. Buckland, D. R. Anderson, K. P. Burnham, J. L. Laake, D. L. 


Borchers, and L. Thomas, editors.  Advanced distance sampling: estimating abundance of 


biological populations.  Oxford University Press, New York, New York, USA. 


Hedley, S. L., and S. T. Buckland.  2004.  Spatial models for line transect sampling.  Journal of 


Agricultural, Biological, and Environmental Statistics 9:181−199. 


Hedley, S. L., S. T. Buckland, and D. L. Borchers.  1999.  Spatial modelling from line transect 


data.  Journal of Cetacean Research and Management 1:255–264. 


Howlin, S., C. Derby, and D. Strickland.  2008.  Whooping crane migrational habitat use in the 


central Platte River during the cooperative agreement period, 2001–2006.  Unpublished 


Report, Western EcoSystems Technology, Inc., Cheyenne, Wyoming, USA. 


Jackmann, H.  2002.  Comparison of aerial counts with ground counts for large African 


herbivores.  Journal of Applied Ecology 39:841–852. 


Jarnevich, C. S., and M. K. Laubhan.  2011.  Balancing energy development and conservation: a 


method utilizing species distribution models.  Environmental Management 47: 926–936. 


Johnsgard, P. A.  1983.  Cranes of the world.  Indiana University Press, Bloomington, USA. 


Johnson, D. S., J. L. Laake, and J. M. Ver Hoef.  2010.  A model-based approach for making 


ecological inference from distance sampling data.  Biometrics 66:310–318. 


Johnson, B. K., F. G. Lindzey, and R. J. Guenzel.  1991.  Use of aerial line transect surveys to 


estimate pronghorn populations in Wyoming.  Wildlife Society Bulletin 19:315–321. 


Johnson, F. A., K. H. Pollock, and F. Montalbano, III.  1989.  Visibility bias in aerial surveys of 


mottled ducks.  Wildlife Society Bulletin 17:222–227. 


Katsanevakis, S.  2007.  Density surface modeling with line transect sampling as a tool for 


abundance estimation of marine benthic species: the Pinna nobilis example in a marine 


lake.  Marine Biology 152:77–85. 


Kéry, M.  2008.  Estimating abundance from bird counts: binomial mixture models uncover 


complex covariate relationships.  Auk 125:336–345. 


Krebs, C. J.  1999.  Ecological methodologies. Second edition. Addison-Welsey Longman, 


Menlo Park, California, USA. 


Krementz, D. G., R. Crossett II, and S. E. Lehnen.  2014.  Nocturnal field use by fall migrating 


American woodcock in the Delta of Arkansas.  Journal of Wildlife Management 78:264–


272. 


Laake, J. L., and D. L. Borchers.  2004.  Methods for incomplete detection at distance zero.  


Pages 108−189 in S.T. Buckland, D. R. Anderson, K. P. Burnham, J. L. Laake, D. L. 







 


46 


 


Borchers, and L. Thomas, editors.  Advanced distance sampling: estimating abundance of 


biological populations.  Oxford University Press, New York, New York, USA. 


Lancia, R. A., W. L. Kendall, K. H. Pollock, and J. D. Nichols.  2005.  Estimating the number of 


animals in wildlife populations.  Pages 106–153 in C. E. Braun, editor.  Techniques for 


wildlife investigations and management.  Sixth edition.  The Wildlife Society, Bethesda, 


Maryland, USA. 


Link, W. A., and J. S. Hatfield.  1990.  Power calculations and model selection for trend 


analysis: a comment.  Ecology 71:1217–1220. 


Link, W. A., J. A. Royle, and J. S. Hatfield.  2003.  Demographic analysis from summaries of an 


age-structured population.  Biometrics 59:778–785. 


Littlefield, C. D.  2003.  Sandhill crane nesting success and productivity in relation to predator 


removal in southeastern Oregon.  Wilson Bulletin 115:263–269. 


Ludeke, K., D. German, and J. Scott.  2012.  Texas vegetation classification project: interpretive 


booklet for Phase 3.  Texas Parks and Wildlife Department and Texas Natural Resources 


Information System, Austin, USA. 


Lyons, J. E., M. C. Runge, H. P. Laskowski, and W. L. Kendall.  2008.  Monitoring in the 


context of structured decision-making and adaptive management.  Journal of Wildlife 


Management 72:1638–1692. 


MacKenzie, D. I., J. D. Nichols, G. B. Lachman, S. Droege, J. A. Royle, and C. A. Langtimm.  


2002.  Estimating site occupancy rates when detection probabilities are less than one.  


Ecology 83:2248–2255. 


Marques, F. F. C., and S. T. Buckland.  2003.  Incorporating covariates into standard line 


transect analyses.  Biometrics 59:924–935. 


Marques, F. F. C., and S. T. Buckland.  2004.  Covariate models for the detection function.  


Pages 31–47 in S. T. Buckland, D. R. Anderson, K. P. Burnham, J. L. Laake, D. L. 


Borchers, and L. Thomas, editors.  Advanced distance sampling: estimating abundance of 


biological populations.  Oxford University Press, New York, New York, USA. 


Marques, T. A., M. Andersen, S. Christensen-Dalsgaard, S. Belikov, A. Boltunov, Ø. Wiig, S. T. 


Buckland, and J. Aars.  2006.  The use of global positioning systems to record distances 


in a helicopter line-transect survey.  Wildlife Society Bulletin 34:759–763. 


Marques, T. A., L. Thomas, S. G. Fancy, and S. T. Buckland.  2007.  Improving estimates of bird 


density using multiple-covariate distance sampling.  Auk 124:1229–1243. 


McClintock, B. T., and G. C. White.  2012.  From NOREMARK to MARK: software for 


estimating demographic parameters using mark-resight methodology.  Journal of 


Ornithology 152:641–650. 







 


47 


 


McRoberts, J. T., M. J. Butler, W. B. Ballard, H. A. Whitlaw, D. A. Haukos, and M. C. Wallace.  


2011.  Detectability of lesser prairie-chicken leks: a comparison of surveys from aircraft.  


Journal of Wildlife Management 75:771−778. 


Morrison, M. L., W. M. Block, M. D. Strickland, B. A. Collier, and M. J. Peterson.  2008.  


Wildlife Study Design.  Second edition.  Sprnger, New York, New York, USA. 


Nicol, S., and I. Chadès.  2012.  Which states matter? An application of an intelligent 


discretization method to solve a continuous POMDP in conservation biology.  PLoS 


ONE 7:e28993. 


Pearse, A. T., P. D. Gerard, S. J. Dinsmore, R. M. Kaminski, and K. J. Reinecke.  2008.  


Estimation and correction of visibility bias in aerial surveys of wintering ducks.  Journal 


of Wildlife Management 72:808–813. 


Phillips, S. J., R. P. Anderson, and R. E. Schapire.  2006.  Maximum entropy modeling of 


species geographic distributions.  Ecological Modelling 190:230–259. 


Pollock, K. H., W. L. Kendall.  1987.  Visibility bias in aerial surveys: a review of estimation 


procedures.  Journal of Wildlife Management 51:502–510. 


Pugesek, B. H., M. J. Baldwin, and T. Stehn.  2013.  The relationship of blue crab abundance to 


winter mortality of whooping cranes.  The Wilson Journal of Ornithology 125:685–661. 


R Development Core Team.  2012.  R: a language and environment for statistical computing.  


Version 2.15.0, Vienna, Austria.  <http://cran.r-project.org/manuals.html>.  Accessed 14 


May 2012. 


Reynolds, J. H., W. L. Thompson, and B. Russell.  2011.  Planning for success: identifying 


effective and efficient survey designs.  Biological Conservation 144:1278–1284. 


Ridgeway, M. S.  2010.  Line transect distance sampling in aerial surveys for double-crested 


cormorants in coastal regions of Lake Huron.  Journal of Great Lakes Research 36:403–


410. 


Royle, J. A., D. K. Dawson, and S. Bates.  2004.  Modeling abundance effects in distance 


sampling.  Ecology 85:1591–1597. 


RStudio.  2012.  The RStudio integrated development environment.  Version 0.96, RStudio, Inc.  


<http://rstudio.org/>.  Accessed 26 July 2012. 


Rusk, J. P., F. Hernandez, J. A. Arredondo, F. Hernandez, F. C. Bryant, D. G. Hewitt, E. J. 


Redeker, L. A. Brennan, and R. L. Bingham.  2007.  An evaluation of survey methods for 


estimating Northern bobwhite abundance in Southern Texas.  Journal of Wildlife 


Management 71:1336−1343. 







 


48 


 


Samuel, M. D., E. O. Garton, M. W. Schlegel, and R. G. Carson.  1987.  Visibility bias during 


aerial surveys of elk in north central Idaho.  Journal of Wildlife Management 51:622–


630. 


Schmidt, J. H., K. L. Rattenbury, J. P. Lawler, and M. C. Maccluskie.  2012.  Using distance 


sampling and hierarchical models to improve estimates of Dall’s sheep abundance.  


Journal of Wildlife Management 76:317–327. 


Shupe, T. E., F. S. Guthery, and S. L. Beasom.  1987.  Use of helicopters to survey northern 


bobwhite populations on rangeland.  Wildlife Society Bulletin 15:458–462. 


Sillett, S., R. B. Chandler, J. A. Royle, M. Kéry, and S. A. Morrison.  2012.  Hierarchical 


distance sampling models to estimate population size and habitat-specific abundance of 


an island endemic.  Ecological Applications 22:1997–2006. 


Skalski, J. R., K. E. Ryding, and J. J. Millspaugh.  2005.  Wildlife demography: analysis of sex, 


age, and count data.  Elsevier Academic Press, Burlington, Massachusetts, USA. 


Smith, D. R., K. J. Reinecke, M. J. Conroy, M. W. Brown, and J. R. Nassar.  1995.  Factors 


affecting visibility rate of waterfowl surveys in the Mississippi Alluvial Valley.  Journal 


of Wildlife Management 59:515–527. 


Stehn, T. V.  1992.  Unusual movements and behaviors of color-banded whooping cranes during 


winter.  Proceedings of the North American Crane Workshop 6:95–101. 


Stehn, T.  2001.  Whooping cranes during the 2000–2001 winter.  Aransas National Wildlife 


Refuge, U.S. Fish and Wildlife Service, Austwell, Texas, USA. 


Stehn, T. V.  2009.  Whooping cranes during the 2008–2009 winter.  Aransas National Wildlife 


Refuge, U.S. Fish and Wildlife Service, Austwell, Texas, USA. 


Stehn, T. V.  2010.  Whooping cranes during the 2009–2010 winter.  Aransas National Wildlife 


Refuge, U.S. Fish and Wildlife Service, Austwell, Texas, USA. 


Stehn, T. V.  2011.  Whooping cranes during the 2010–2011 winter.  Aransas National Wildlife 


Refuge, U.S. Fish and Wildlife Service, Austwell, Texas, USA. 


Stehn, T. V., and E. F. Johnson.  1987.  Distribution of winter territories of whooping cranes on 


the Texas coast.  Pages 180–195 in J. C. Lewis, editor.  Proceedings 1985 Crane 


Workshop.  Platte River Whooping Crane Maintenance Trust and U.S. Fish and Wildlife 


Service, Grand Island, Nebraska, USA. 


Stehn, T. V., and F. Prieto.  2010.  Changes in winter whooping crane territories and range 1950–


2006.  Proceedings of the North American Crane Workshop 11:40–56. 


Stehn, T. V., and C. Strobel.  2012.  An update on mortality of fledged whooping cranes in the 


Aransas/Wood Buffalo population.  Proceedings of the North American Crane Workshop 


12:in press. 







 


49 


 


Stehn, T. V., and T. E. Taylor.  2008.  Aerial census techniques for whooping cranes on the 


Texas coast.  Proceedings of the North American Crane Workshop 10:146–151. 


Strobel, B.  2011.  Wintering whooping crane survey aviation project plan.  Aransas National 


Wildlife Refuge, U.S. Fish and Wildlife Service, Austwell, Texas, USA. 


Strobel, B. N., and M. J. Butler.  2014.  Monitoring whooping crane abundance using aerial 


surveys: influences on detectability.  Wildlife Society Bulletin 38:188–195. 


Strobel, B., M. J. Butler, and G. Harris.  2012.  Aransas-Wood Buffalo whooping crane 


abundance survey (2011–2012).   U.S. Fish and Wildlife Service, Austwell, Texas, USA.  


< http://www.fws.gov/uploadedFiles/FY12_ANWR_WWCAS_Review_01OCT12-


508.pdf>.  Accessed 2 October 2012. 


Thomas, L., S. T. Buckland, E. A. Rexstad, J. L. Laake, S. Strindberg, S. L. Hedley, J. R. B. 


Bishop, T. A. Marques, and K. P. Burnham.  2010.  Distance software: design and 


analysis of distance sampling surveys for estimating population size.  Journal of Applied 


Ecology 47:5–14. 


Thomas, L., K. P. Burnham, and S. T. Buckland.  2004.  Temporal inferences from distance 


sampling surveys.  Pages 71–107 in S. T. Buckland, D. R. Anderson, K. P. Burnham, J. 


L. Laake, D. L. Borchers, and L. Thomas, editors.  Advanced distance sampling: 


estimating abundance of biological populations.  Oxford University Press, New York, 


New York, USA. 


Thompson, W. L., G. C. White, and C. Gowan.  1998.  Monitoring vertebrate populations.  


Academic Press, San Diego, California, USA. 


Timmer, J. M., M. J. Butler, W. B. Ballard, C. W. Boal, and H. A. Whitlaw.  2014.  Spatially 


explicit modeling of lesser prairie-chicken lek density in Texas.  Journal of Wildlife 


Management 78:142–152. 


U.S. Fish and Wildlife Service.  2010.  Communicating scientific information.  Part 117, Section 


1 in Service manual.  U.S. Fish and Wildlife Service, Washington, D.C., USA. 


<www.fws.gov/policy/manuals/>.  Accessed 10 January 2013. 


U.S. Fish and Wildlife Service.  2011.  Scientific integrity of scholarly conduct.  Part 212, 


Section 7 in Service manual.  U.S. Fish and Wildlife Service, Washington, D.C., USA. 


<www.fws.gov/policy/manuals/>.  Accessed 6 November 2012. 


U.S. Fish and Wildlife Service.  2012a.  U.S. Fish and Wildlife Service information quality 


guidelines and peer review.  June 2012 revision.  U.S. Fish and Wildlife Service, 


Washington, D.C., USA.  < http://www.fws.gov/informationquality/>.  Accessed 10 


January 2013. 


U.S. Fish and Wildlife Service, 2012b.  ServCat Metadata and Dataset Guidelines.  November 


2012.  U.S. Fish and Wildlife Service, Fort Collins, Colorado, USA. 


<https://ecos.fws.gov/ServCat/Reference/Profile/8134>.   Accessed 10 April 2013. 







 


50 


 


U.S. Fish and Wildlife Service.  2013.  How to develop survey protocols: a handbook.  Version 


1.0, National Wildlife Refuge System, U.S. Fish and Wildlife Service, Natural Resource 


Program Center, Fort Collins, Colorado, USA. 


White, G. C.  1996.  NOREMARK: population estimation from mark-resighting surveys.  


Wildlife Society Bulletin 24:50–52. 


White, G. C.  2008.  Closed population estimation models and their extensions in Program 


MARK.  Environmental and Ecological Statistics 15:89–99. 


White, G. C., R. M. Bartmann, L. H. Carpenter, and R. A. Garrott.  1989.  Evaluation of aerial 


line transects for estimating mule deer densities.  Journal of Wildlife Management 


53:625–635. 


Williams, B. K., J. N. Nichols, and M. J. Conroy. 2002. Analysis and management of animal 


populations. Academic Press, San Diego, California, USA. 


Wright, G. D., M. J. Harner, and J. D. Chambers.  2014.  Unusual wintering distribution and 


migratory behavior of the whooping crane (Grus americana) in 2011–2012.  The Wilson 


Journal of Ornithology 126:115–120. 


Yackulic, C. B., R. Chandler, E. F. Zipkin, J. A. Royle, J. D. Nichols, E. H. Campbell Grant, and 


S. Veran.  2013.  Presence-only modelling using MAXENT: when can we trust the 


inferences?  Methods in Ecology and Evolution 4: 236–243. 


Zar, J. H.  1999.  Biostatistical analysis.  Fourth edition.  Prentice Hall, Upper Saddle River, New 


Jersey, USA.  







 


51 


 


Overview of the Whooping Crane Abundance Protocol 


Below we provide a table that summarizes the details of the wintering whooping crane 


abundance survey and where to find information regarding each survey activity.  The SOP or 


Appendix is noted under the item column and the action column details each activity. 


 


Item Action 


SOP 1, 


Appendix I 


Download I&M Survey folder structure from SharePoint and unzip it to a data storage 


space like a server or c:\ (completed by NWR). 


 


SOP 1, 


Appendix I 


Download WHCR geodatabase templates and unzip into the 


im_surveys\at_risk_biota\birds\survey_name_folder\data\yyyy-yyyy\RO_templates to 


the Aransas server and to the c:\temp. 


 


SOP 1 Once downloaded into RO_templates, in Windows Explorer, extract all. 


 


SOP 1 Create a new folder called pre-flight in the 


im_surveys\at_risk_biota\birds\survey_name_folder\data\yyyy-yyyy\geodata folder. 


 


SOP 1 Copy and rename the two observer geodatabases into 


im_surveys\at_risk_biota\birds\survey_name_folder\data\yyyy-yyyy\geodata\pre-


flight.  


 


SOP 1 Copy and rename the WHCR_SOP_mmddyy_template and the ServCat geodatabases 


into im_surveys\at_risk_biota\birds\survey_name_folder\data\yyyy-yyyy\geodata\. 


 


SOP 1 Before Flights, practice SOP 1 using an automobile to check that GPS and files are 


working correctly and ensure users are comfortable with SOP 1.  Observers will read 


Element 4–Field Methods prior to conducting surveys each year. 


 


SOP 1 Conduct the aerial survey.  The Primary Sampling Frame (PSF) surveyed >6 times (6 


complete surveys of all transects within the PSF) between 28 November–26 


December.  The Secondary Sampling Frame (SSF) surveyed >2 times (2 complete 


surveys of all transects within the SSF) between 28 November–26 December. 


 


SOP 2 Download survey flight data: 


Observer geodatabases: 


im_surveys\at_risk_biota\birds\WHCR_aerial_surveys\data\yyyy-yyyy\geodata.  


These geodatabases have the observers initials and were originally the _obs1 


and _obs2 geodatabases. 


Audio recording files: 


im_surveys\at_risk_biota\birds\WHCR_aerial_surveys\data\yyyy-yyyy\audio.  


Name as SurveyAudio_mmddyy_obs1.  
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Item Action 


SOP 2 Download survey flight data: 


GPS track: 


Save in the respective observer geodatabases at 


im_surveys\at_risk_biota\birds\WHCR_aerial_surveys\data\yyyy-yyyy\geodata 


Appendix F Prepare update reports within a few days after each survey (completed by NWR). 


 


SOP 2 Transcribe and attribute the survey flight data (completed by the observers) as soon as 


possible after each survey. 


 


SOP 3 Combine 1
st
 and 2


nd
 observers’ survey_mmddyy feature classes in the 


WHCR_SOP_mmddyy geodatabase located in 


im_surveys\at_risk_biota\birds\WHCR_aerial_surveys\data\yyyy-yyyy\geodata. 


 


SOP 3 Clip the flight lines to the fishnet and remove turn areas from the flown transects. 


 


SOP 3 Measure distance to whooping crane detections from transects for PSF regions. 


 


SOP 3 Identify the whooping crane detections that have Near Distance problems (Appendix 


G). 


 


SOP 3 Correctly attribute the detections with Near Distance problems. 


 


SOP 4 Create the HDS file and export as both a text file and a geodatabase table named as 


HDS_mmddyy. 


 


SOP 4 Create the CDS file and export as both a text file and a geodatabase table named as 


CDS_mmddyy. 


 


SOP 5 Format data for analyses in Program R.  Save these files in the 


im_surveys\at_risk_biota\birds\WHCR_aerial_surveys\data\yyyy-yyyy\analysis folder 


(contact Regional Biometrician to determine if RO or NWR will complete SOP 5). 


 


SOP 6 Daily archiving and backup of survey data including any SSF regions crane 


detections to the WHCR SharePoint (access restricted) in the 


WHCR_aerial_surveys_bu folder under Data.  The WHCR_SOP_mmddyy 


geodatabase will contain 7–9 feature classes.  There will be an audio file and text 


files. 


 


Appendix C Conduct data analyses. 


 


SOP 6 Combine all survey data for the flight year into the WHCR_SOP_yyyy-yyyy_ServCat 


geodatabase and upload to the WHCR SharePoint (access restricted) into the 


WHCR_aerial_surveys_ServCat folder under Data.  Also, upload data analysis files 


and reports. 
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Item Action 


SOP 6 Email regional data management team that the data is ready for ServCat. 


 


Appendix D If new areas are identified for inclusion in the SSF, generate a fishnet in ArcMap 


(data management team can do this for the NWR). 


 


Appendix E Creating the Enviornmental Covariates based on TESC data (data management team 


or Biometrician can do this for the NWR). 


 


Appendix I Downloading template geodatabases and I&M Survey folder structure from 


SharePoint (completed by NWR). 


 


Appendix J Once enough whooping crane groups are consistently detected within a SSF area, that 


SSF area will be promoted to a PSF area (data management team can do this for the 


NWR). 
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Standard Operating Procedures 


Standard Operating Procedure 1: Conducting Surveys 
  


UNDERSTANDING THIS DOCUMENT 


 Emboldened terms are commands, tools, or tasks within the referenced software 


programs (i.e., ArcMap 10, ArcCatalog 10, Microsoft Excel 2010, Program R 3.0.1, DNR 


Garmin). 


 Italicized text indicates background information, a filename, or a field name. 


 When filenames have an _mmddyy_ or an _obs1 this would be updated to reflect the date 


the survey was conducted for _mmddyy_, and _obs1 or _obs2 is the observer’s initials. 


 SOP written for a Windows 7 environment. 


  


DATA COLLECTION  


This SOP will be reviewed by the observers prior to each survey. 


 PRE-FLIGHT PREPARATION FOR DATA COLLECTION 


Ensure the I&M Surveys folder structure is on the server or data storage location 


(Appendix I). Template file geodatabases for observer1 and observer 2 are available on 


the WHCR Aerial Surveys (TX Coast) SharePoint site in Data>SOP_templates, and in 


the near future, on ServCat.  These geodatabases are located in WHCR_SOP_yyyy-


yyyy_template.zip. Users will download this zip file into the 


im_surveys\at_risk_biota\birds\survey_name_folder\data\yyyy-yyyy\RO_templates to the 


Aransas server and to the c:\temp.  Once downloaded into RO_templates, in Windows 


Explorer, Extract All.  Then, use ArcCatalog to review the five geodatabases that should 


be present:  


a. WHCR_SOP_mmddyy_template.gdb 


b. WHCR_SOP_mmddyy_template_obs1.gdb 


c. WHCR_SOP_mmddyy_template_obs2.gdb 


d. WHCR_SOP_yyyy-yyyy_template_ServCat.gdb 


e. Environmental_Covariates.gdb 


Users will copy and rename the observer geodatabases into \....\data\yyyy-


yyyy\geodata\pre-flight.  Users will also copy and rename the 


WHCR_SOP_mmddyy_template and the ServCat geodatabases into \....\data\yyyy-


yyyy\geodata. 


 


Note: The term “OBJECTID” is used when discussing geodatabases; whereas, “FID” is 


used when discussing shapefiles.  Also, a .gdb is a file geodatabase. 
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Before going to the Airport 


1. Read and familiarize yourself with Element 4. 


2. Plan surveys in advance. 


3. To ensure each region is sampled at various times of day (i.e., to avoid systematic 


bias), a randomly ordered list of the regions within the PSF will be used to 


determine the region in which each survey will begin with (i.e., the first survey 


will begin with the first region on the list, the second survey will begin with the 


second region on the list, etc.).  To create this list, simple R code can be used: 
 


sample(c("BJ","LT","MIC","WM","SJ","WF")) 
 


4. It is important observers are familiar with all the equipment and how to operate it.  


Observers must practice using all survey equipment prior to conducting whooping 


crane surveys.  For example, observers could practice using the equipment from 


an automobile prior to conducting surveys each year.  Without practice, costly 


mistakes during monitoring activities could result in data loss.  Losing data 


because of simple, avoidable mistakes is unacceptable. 


5. Ensure all electronic equipment is fully charged, has new batteries installed, or an 


auxiliary power supply (e.g., power inverter).  Charge batteries the night before a 


survey flight. 


6. Ensure all electronic devices have the correct time and date settings (e.g., digital 


voice recorder). 


7. In ArcCatalog, open the im_surveys>at_risk_biota>birds>WHCR_aerial 


surveys>data>2013-2014>geodata. 


Note: 2013-2014 is the current survey year.  Appendix I describes file directory 


structure for I&M Surveys. 


8. In the geodata folder create a new folder named pre-flight.  


9. In im_surveys>at_risk_biota>birds>WHCR_aerial surveys>data>2013-


2014>RO_templates, Right-click on the geodatabase (i.e., 


WHCR_SOP_mmddyy_template_obs1.gdb) and select Copy.  


10. Paste to the im_surveys>at_risk_biota>birds>WHCR_aerial 


surveys>data>2013-2014>geodata>pre-flight folder.   


11. Observers should rename the geodatabases by changing the date, removing 


“template”, and changing obs1 or obs2 to the observer’s initials similar to the 


following: 


Template Name: WHCR_SOP_mmddyy_template_obs1.gdb 


Renamed: WHCR_SOP_032813_dpi.gdb  


12. In the geodatabase from step 9, Rename the survey_mmddyy feature class using 


the survey date and the observer’s initials (i.e., survey_014112_dpi). 


13. Right-click on the geodatabase from step 9 and Copy.  


14. Navigate to the proper location on a portable memory device used for the aerial 


survey, and paste the renamed geodatabase. 
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15. If not already available on the portable memory device, copy imagery (e.g., 1-m 


NAIP) to the device. 


Note: Imagery can be downloaded from the USDA Data Gateway 


(http://datagateway.nrcs.usda.gov/) if it is not already available on the Aransas 


NWR server. 


Before take-off 


1. Open ArcMap on the laptop, and add the survey_mmddyy_obs1 (i.e., 


survey_011112_dpi) feature class to the dataframe. 


2. Save this ArcMap project as whcr_mmddyy_obs1.mxd using the date and observer 


initials. 


3. Right-click on the survey_mmddyy_obs1 feature class and click on 


Properties>Labels tab.  Set the Label Field to OBJECTID.  Confirm Label 


features in this layer is checked.  Click OK. 


Note: This will automatically label each point in chronological order as they are 


created.  


 
4. Add the fishnet_dissolved feature class to the dataframe (Optional step). 


5. Add the transects_ideal to the dataframe.  Following step 3 above, label the 


TRANSECT_ID, but choose a different font color. 


6. Add imagery (e.g., 1-m NAIP) to dataframe covering the sampling frame’s 


extent. 


Note: Imagery can be downloaded from the USDA Data Gateway 


(http://datagateway.nrcs.usda.gov/) if it is not already available on the Aransas 


NWR server.  Observers will use the most current imagery available. 


7. In ArcMap, set the dataframe display scale to 1:8000. 


8.  
9. In ArcMap, open the Editor toolbar by clicking on the Editor icon. 


 



http://datagateway.nrcs.usda.gov/

http://datagateway.nrcs.usda.gov/
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10. On the Editor toolbar confirm the Save Edits icon is shown. 


  
11. If the Save Edits icon is not on the Editor toolbar, then click 


Customize>Customize mode>Commands tab.  Under Categories, scroll down 


and click on Editor.  Under Commands, click and drag Save Edits to the Editor 


toolbar in ArcMap. 


  
12. Turn on the handheld GPS unit and any redundant handheld GPS units and allow 


them to search for satellites. 


13. Check that the coordinate system is set to UTM NAD83 in the handheld GPS 


units (Setup>Position Format, change Position Format to UTM UPS and Map 


Datum to NAD83). 


14. Check that the track data collection rate is set to a 1-second interval in the 


handheld GPS units (Setup>Tracks, change Record Method to Time and 


Recording Interval to 00:00:01). 


15. Ensure redundant handheld GPS is set to record its track as well.  Repeat steps 


12–14 for the redundant handheld GPS; it should have a recording interval of 1 


second. 


16. Establish communications between a GPS and the laptop computer and display 


current location in ArcMap (Appendix L). 


Note: Steps to do this will depend upon the GPS and CPU used and their 


connection type (i.e., wired, wireless).  Appendix L contains the most recent steps, 


and is updated by the Refuge Biologist.  Use Appendix L with steps 12-16.  These 


steps should be practiced and well understood prior to any survey flight. 


In-flight data collection 
1. While taxiing repeat the automated weather observation station (AWOS) data into 


the digital voice recorder.  Be sure to indicate units of measurements (i.e., if 
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temperature is Fahrenheit or Celsius).  Also make any additional and pertinent 


observations of weather conditions. 


Note: Aransas County Airport AWOS can be found at: 


http://w1.weather.gov/obhistory/KRKP.html. 


2. Both observers will record the date, each observers name and seating position, the 


pilot’s name, and the aircraft type and configuration.  For example, record 


“December 17
th


 2012” pause “Wade Harrell, front-seat observer” pause “Diana 


Iriarte, backseat observer” pause “Terry Liddick, Pilot” pause “Cessna 206” pause 


“This is Wade Harrell’s recording.” 


3. In ArcMap, be sure the dataframe display scale to is set to 1:8000. 


4. Click on Editor>Start Editing the survey_mmddyy_obs1 feature class during 


taxiing. 


At the appropriate times you will plot a point at the start and end of each transect. 


Steps 5–7 describe collecting both the point and audio file data for the start and end 


of transects being flown. Steps 8–15 describe the point and audio file data collection 


for the crane observations. 


5. To plot a point in ArcMap, click on the survey_mmddyy_obs1 in Create 


Features, and under Construction Tools, click on Point.  


 
6. Click the appropriate place on the map for either the start or end of the transect. 


7. Click Save Edits and in the Construction Tools, click on Point again to ready 


for the next point location.  If the Save Edits icon is not on the toolbar, see SOP 


1, before take-off, step 9 for instructions. 


8. Use the digital voice recorder, start an audio file to record the transect id for each 


start and end point.  Holding the microphone near your mouth record the transect 


id and whether the point is starting or ending a transect.  Speak loudly, clearly, 


and methodically following the example:  pause “Point 1” pause “Start” pause 


“Transect Blackjack 1.” 


9. Complete detection of whooping crane along the line is imperative.  Seeing 


everything close to the line is more important than seeing as many whooping 


cranes as possible across the transect width.  To facilitate 100% detection on the 



http://w1.weather.gov/obhistory/KRKP.html
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line, the front seat observer should scan ahead of the aircraft for whooping cranes.  


If the front seat observer is short and has difficulty seeing over the instrument 


panel, that observer will need to elevate their seating position (i.e., use a boat-seat 


cushion).  Also, the pilot often detects cranes along the line; it is important that 


the pilot communicate those detections to the front seat observer.  The figure 


below depicts allocation of observer search effort.  The gray area represents 


search effort by the front seat observer and the blue area represent search effort by 


the back seat observer. 


 


10. Communication among each of the observers and the pilot during the survey is 


imperative. 


11. Using the Create Features from step 5, click the appropriate place on the map to 


capture the point location of observed cranes in the survey_mmddyy_obs1 feature 


class as accurately as possible.  Pay attention to the OBJECTID of the point which 


should label on the map.  This OBJECTID is used in step 13 with the audio 


recording.  If multiple cranes are detected within 100 m of each other, plot the 


geometric center of the group. 


12. If whooping cranes are observed flying, mark the locations from which the group 


flushed.  If the spot from which the group flushed is unknown, then mark the 


location the group was first observed at and note in the comments that the group 


was observed flying. 


13. If an observer has any doubt as to the species, that detection should not be 


recorded. 
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14. Click Save Edits on the Editor toolbar, and in the Construction Tools, click on 


Point again to ready for the next point location. 


15. Use the digital recorder to start an audio file for each observation.  Holding the 


microphone near your mouth record the OBJECTID of the point as well as the 


age-class of all cranes observed.  Speak loudly clearly and methodically following 


the example:  pause “Point 23” pause “Transect Blackjack1” pause “2 White” 


pause “1 Juvenile” pause “1 Unknown” pause “4 total cranes” pause 


“Comments.” 


16. Record what you see for each detected group; do not make assumptions about 


group structure.  For example, if a group of 2 white birds and 1 unknown age-


class birds is observed do not assume the unknown bird is a juvenile record it as 


“1 Unknown.” 


17. End and Save each observation’s recording separately. 


18. After completing each survey region select Save Edits on the Editor toolbar in 


ArcMap.  Then, click Start Editing the survey_mmddyy_obs1 feature class again.  


Note: If saving can be accomplished more often, do so! 
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Standard Operating Procedure 2: Data Download and Transcription 
  


UNDERSTANDING THIS DOCUMENT 


 Emboldened terms are commands, tools, or tasks within the referenced software 


programs (i.e., ArcMap 10, ArcCatalog 10, Microsoft Excel 2010, Program R 3.0.1, DNR 


Garmin). 


 Italicized text indicates background information, a filename, or a field name. 


 When filenames have an _mmddyy_ or an _obs1 this would be updated to reflect the date 


the survey was conducted for _mmddyy_, and _obs1 or _obs2 is the observer’s initials. 


 SOP written for a Windows 7 environment. 


  


Both observers should complete the SOP 2 steps for their survey data.  Then, only 1 of the 2 


observers should complete the remaining steps for post-flight data processing and synthesis in 


SOPs 3, 4, and 6.  This SOP will be completed for both the Primary and Secondary Sampling 


Frames (see Element 3). 


 
Data download 


1. Copy observer geodatabase from the portable media used during the survey to the 


Aransas NWR server.  Store the observer geodatabases in 


\\im_surveys\at_risk_biota\birds\WHCR_aerial_surveys\data\yyyy-yyyy\geodata.   


2. Copy audio recording files to 


\\im_surveys\at_risk_biota\birds\WHCR_aerial_surveys\data\yyyy-yyyy\audio.  


Name as SurveyAudio_mmddyy_obs1.  


Note: Previous location used was 


V:\WHCR\ Survey Audio Files\2011\SurveyAudio_DDMMYY_OBS. 


Note: If primary handheld GPS failed during the survey; use the redundant 


handheld GPS for steps 3-5. 


3. Open DNR Garmin program.  Depending upon the type of GPS and the settings 


in the DNR Garmin software, a user may need use the Download command or the 


Load command to obtain the data from the GPS.  To use the load command, once 


the program is connected to the GPS select File>Load From>File. 


4. Locate the correct device and select the correct file.  Before downloading, in 


DNR Garmin Properties leave the Fields to Use set to type-symbol, altitude, 


and model. 


5. Use save as to create two copies of these data, one as a line feature class in the 


observers geodatabase (WHCR_SOP_mmddyy_obs1.gdb) and the other as a point 


text file.  Each observer should have a track log saved geospatially, and a 


redundant text file. 


a. track_mmddyy_dp1_obs1  (feature class) 


b. track_mmddyy_dpi_obs1.txt 
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Data transcription and attribution 


1. Steps 2–14 describe data transcription and attribution of whooping crane 


detections (i.e., the points feature). 


2. Open ArcMap and using the Add Data icon , add the survey_mmddyy_obs1  


feature class. 


Note: The second observer should add survey_mmddyy_obs2. 


3. Right-click on survey_mmddyy_obs1 and choose Open Attribute Table. 


 
4. To protect data integrity, copy the OBJECTID field into the ORIGINAL_ID field 


by right-clicking on the ORIGINAL_ID column heading, and choosing the Field 


Calculator. 


 
5. In the Field Calculator under Fields, double-click on OBJECTID so it appears in 


the text box.  Click OK. 


 
6. After confirming the OBJECTID was copied to the ORIGINAL_ID field, label by 


the OBJECTID field. 


7. Open the Editor toolbar by clicking on the Editor toolbar icon .  On the 


Editor toolbar, click the black arrow beside Editor>Start Editing.  Choose the 


survey_mmddyy_obs1 feature. 


Note: Observer 2 will choose the survey_mmddyy_obs2 feature. 
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8. Each observer will transcribe the data from their voice recordings into the 


corresponding fields in the feature class attribute table (i.e., WHITE, JUVEN, 


UNK).  The observer will update the WHITE, JUVEN, UNK, OBSERVER, 


TRANSECT_ID, Type, and COMMENTS fields.  After entering this information 


per point, save the edits by clicking Editor>Save Edits. 


9. While listening to the survey audio files, listen for the point number (the 


OBJECTID), whether it was the start or end of a transect, or if the point is a crane 


observation like “2 White” “1 Juvenile”, “1 Unknown.”  Enter the data into the 


appropriate fields. 


Note: If there are zero (0) whooping cranes for a particular age-class, enter “0” 


do not leave blank. 


10. Listen for and enter the transect from which each observation was made from into 


the TRANSECT_ID field of the feature class. 


Note: If the observer knows the observation was closer to an adjacent transect, 


the observer should indicate that in the NEAR_PROBLEM field. 


11. Complete the DATE_ and OBSERVER fields in the feature class using field 


calculator.  For date type enter MM/DD/YYYY.  For observer, use three letter 


initials (e.g., dpi or bns). 


12. Complete the Type field by choosing if the point was the start or end of a transect, 


cranes, cranes off-transect, or an error like an accidental click. 


Note: If cranes were detected while the aircraft was turning and not while flying 


the transect line, those detections should have the Type field as off-transect. 


13. In the COMMENTS enter additional information if necessary (e.g., SSF). 


14. When finished transcribing all of the data, perform a final Save Edits and Stop 


Editing. 


Note: Steps 15–18 describe data transcription and attribution of the survey 


conditions table.  This table contains information about the survey-specific conditions 


for each flight.   


15. Open the flight_mmddyy.dbf in ArcMap. 


16. Under the Editor tool, select Start Editing. 


17. Enter the information described in the “Survey-specific conditions data” section 


in Element 5. 


18. When completed, under the Editor tool, select Save Edits, then Stop Editing. 


  







 


64 


 


Standard Operating Procedure 3: Post-flight Data Processing and Formatting 
  


UNDERSTANDING THIS DOCUMENT 


 Emboldened terms are commands, tools, or tasks within the referenced software 


programs (i.e., ArcMap 10, ArcCatalog 10, Microsoft Excel 2010, Program R 3.0.1, DNR 


Garmin) 


 Italicized text indicates background information, a filename, or a field name. 


 When filenames have an _mmddyy_ or an _obs1 this would be updated to reflect the date 


the survey was conducted for _mmddyy_, and _obs1 or _obs2 is the observer’s initials. 


 SOP written for a Windows 7 environment. 


  


After each observer has completed SOP 2 Data Transcription and Attribution, only 1 of the 2 


observers should completed the remaining steps.  Ensure that the 


WHCR_SOP_mmddyy_template.gdb has been copied from 


\im_surveys\...\WHCR_aerial_surveys\data\yyyy-yyyy\RO_templates into 


WHCR_aerial_surveys\data\yyyy-yyyy\geodata and renamed WHCR_SOP_mmddyy. 


Exporting the whooping crane observation dataset 


1. In ArcCatalog, from the 1
st
 observer’s geodatabase (e.g., 


WHCR_SOP_mmddyy_dpi) export the obs1 point feature classes (e.g., 


survey_mmddyy_dpi) to the WHCR_SOP_mmddyy.gdb geodatabase by right 


clicking on the feature class and selecting Export>To Geodatabase (single).  


Name the exported feature class to represent the finalized survey feature class 


(e.g., survey_mmddyy). 


 
2. In ArcCatalog, go to WHCR_SOP_mmddyy.gdb, right-click on the newly 


imported feature class survey_mmddyy and select Load>Load Data.   


3. The Simple Data Loader will appear.  Click Next on the introduction screen.  In 


the Input data screen, click on the folder icon, and browse to the 2
nd


 observer’s 


geodatabase (e.g.,WHCR_SOP_mmddyy_bns), and the survey feature class (e.g., 


survey_mmddyy_bns).  A user may have to click on Folder Connections in order 


to browse to the proper location.  
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4. In the Simple Data Loader’s Input data screen, click Add to have the source data 


path appear in the text box under List of source data to load, and click Next. 


5. Confirm I do not want to load the features into a sub-type is chosen.  Click 


Next. 


6. Confirm the Target and Matching Source fields are correct and Load all of the 


source data. 


7. Repeat steps 2–6 for the primary GPS unit track log. Use only the primary GPS 


unit track lines unless the primary GPS unit failed during the survey.  Do not use 


both primary and redundant GPS track logs. 


8. In ArcMap, Add the finalized survey feature class from step 6.  This should be 


WHCR_SOP_mmddyy.gdb>survey_mmddyy. 


9. Right-click on survey_mmddyy and Open Attribute Table. 


10. Sort the attribute table by the WHITE, JUVEN, and UNK fields. 


Click on Selection>Select by Attributes and enter the following  


WHITE >= 1 OR JUVE >=1 OR UNK >=1.  


 
    


11. Export all of the selected records for which cranes were detected by right-


clicking on survey_mmddyy and choosing Data>Export Data.  The exported data 


shall be saved into WHCR_SOP_mmddyy.gdb as a feature class named 


cranes_mmddyy. 


Note: Cranes for SSF will be exported separately and named 


cranes_mmddyy_ssf.  Complete remaining steps for cranes_mmddyy_ssf  until the 


section on Measuring distance to whooping crane detections on page 69. 
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12. Examine the Comments, Type, and Near_Problems fields for detections that 


occurred “off transect.”  Delete “off transect” detections from the cranes_mmddyy 


feature class. 


Note: These are the detections usually made while the aircraft is turning to start a 


new transect.  These detections were not made during the actual transect flight.  


Users may need to complete step 12 after clipping the flight lines. 


Note: These whooping crane observations are not lost during this step since they 


are still available in the survey_mmddyy  feature. 


13. Open the attribute table, and right-click on the Total_Group_Size, and choose the 


Field Calculator. 


14. In the Field Calculator enter [WHITE] + [JUVE] + [UNK]. 


 
15. Click OK.  The Total_Group_Size is calculated.  If there are null values, change 


the <Null> values in the WHITE, JUVENILE, or UNKNOWN fields to zero, 0. 


Clipping the flight lines 


1. Open ArcMap, add the track_mmddyy feature class, right-click on it and open 


the attribute table. 


Note: These steps will be completed for both PSF and SSF transects. 


2. If the DNR Garmin fields are part of the attribute table, right-click on 


track_mmddyy>Properties>Fields. 


3. In the Choose which fields will be visible, leave only the OBJECTID, Shape, 


type, and Shape_Length fields visible.  Click OK. 


 
4. Add the fishnet_primary_dissolve feature class. If working with the SSF add 


fishnet_secondary_dissolve. 


Note: fishnet_dissolve is the term used in the SOP, but can represent either 


primary or secondary. 


5. The fishnet clip method allows for clipping the tracklog line shapefile using the 


fishnet_dissolve.  The graphic below shows the fishnet in black with the tracklog 
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in purple.  The fishnet_dissolve is the fishnet dissolved on the stratum field.  It is 


this file which will be used to clip the tracklog line shapefile. 


 
6. In ArcMap, to clip the tracklog by the fishnet, open ArcToolbox.


 
7. In ArcToolbox, click on Analysis Tools>Extract>Clip. 


8. In the Clip tool enter: 


a. Input Features = track_mmddyy 


b. Clip Features = fishnet_dissolve 


c. Output Feature Class = transects_mmddyy_clip (in the same 


geodatabase). 


d. XY tolerance = blank 


e. Click OK and the tool will process. 


 
9. The new feature class should be added to the ArcMap Table of Contents, and will 


display in the map space with a similar view to the graphic. 


 







 


68 


 


10. Right-click on the transects_mmddyy_clip, and open the attribute table.  There 


should be one record as the clipped feature is a multipart feature. 


11. Right-click on transects_mmddyy_clip layer again.  Choose Selection>Select 


All. 


12. On the Editor toolbar>Start Editing.  Choose the transects_mmddyy_clip.  


13. In the Create Features box that may appear on the right side of the screen, click 


on the transects_mmddyy_clip (if it is not listed under Create Features, build a 


template for it using the Organize Templates icon). 


  
14. Click Editor>More Editing Tools>Advanced Editing. 


15. Confirm the clipped transects are selected.  With transects selected, click Explode 


Multi-part Feature from the Advanced Editing toolbar. 


 
16. Review the clipped transects attribute table.  It should have increased from one 


record to many records. 


17. Right-click on the transects_mmddyy_clip.  Choose Selection>Make the only 


selectable layer. 


18. In the Create Features box, confirm that the clipped transects are highlighted. 


 
19. Review the clipped transects looking for turn areas.  Select those lines and press 


the Delete key on the keyboard to delete each of these lines that are not the 


surveyed transects.  Be sure to remove all of the non-transects as leaving a line 


that is not a transect will affect the Spatial Join in step 22.  If there are more 


records than the number of transects flown, then non-transects remain that need to 


be deleted. 


 
Note: In some rare cases, the split tool on the Editor toolbar may have to be used 


if the flown transects started or stopped within the fishnet due to in-flight issues. 


Indicate these instances in the metadata of this feature class. 
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Note: In some rare cases, the aircraft may have veered extremely far from 


transect.  Consult the RO staff on editing the transect in such cases. 


 
20. On the Editor Toolbar>Save Edits>Stop Editing. 


21. Add transects_ideal. 


Note: If this is a SSF area, these will be secondary transects. 


22. Label each transect according to the “ideal” transect labels (those found in the 


transects_ideal feature class) using the Spatial Join in ArcToolbox.  Open 


ArcToolbox>Analysis Tools>Overlay>Spatial Join.  Set the following 


parameters: 


a. Target Features = transects_mmddyy_clip 


b. Join Features = transects_ideal 


c. Output Feature Class = set to the working geodatabase 


(WHCR_SOP_mmddyy) and name transects_mmddyy 


d. Join Operation = Join One to One 


e. Check “Keep All Target Features” 


f. Match Option = Intersect 


g. Search Radius = 50 m 


23. Open the transects_mmddyy attribute table, confirm that the transects received 


the proper transect_id.  Does it compare to the transcribed transect? 


24. If there any null transect_ids in the attribute table, highlight each of those records, 


and determine if a non-transect line was not deleted back in Step 19.  If that is the 


case, delete them. 


Note: For all SSF files, proceed to SOP 6. 


Measuring distance to whooping crane detections 


For PSF areas, the perpendicular distance between observer and the observed whooping 


crane(s) is necessary for distance sampling analysis.  Usually cranes are detected from 


the transect they are nearest to (i.e., <500 m from the transect).  However, occasionally 


survey conditions allow for increased visibility and whooping cranes are detected when 


they are nearer to an adjacent transect (i.e., >500 m from the transect).  Comparing the 


OBJECTID of each observation to the plotted locations at the end of each transect will 


correctly identify which transect each observation was made from. 


1. In ArcToolbox, click Analysis Tools>Proximity>Near 


i. Input features = cranes_mmddyy 
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ii. Near features = transects_mmddyy (confirm it is that survey date’s 


transects, not the ideal_transects). 


iii. Search Radius = 1000 meters 


iv. Leave Location and Angle unchecked. 


2. Open the attribute table of cranes_mmddyy.   


3. Add a text field called concate.  Set the field length to 25. 


4. Right-click on the concate field and click the Field Calculator. 


5. In the Field Calculator enter [TRANSECT_ID] & " " & [NEAR_FID]. 


 
6. Open the transect_mmddyy attribute table. 


7. Add a text field called concate.  Set the field length to 25. 


8. Right-click on the concate field, and click the Field Calculator. 


9. In the Field Calculator enter [TransectID] & " " & [OBJECTID]. 
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10. Right-click on cranes_mmddyy>Joins and Relates>Join. 


11. In the join attributes from a table screen, join the cranes_mmddyy to the 


transects_mmddyy based on the concate field.  Keep all records, and choose No 


when asked to Create Index. 


 
12. In the cranes_mmddyy attribute table, scroll over to the joined concate field 


(most likely the last column). 


13. Sort Ascending the joined concate field.  Do any NULLs appear?  The NULLs 


will be where the closest, but incorrect transect was used by the Near tool in step 


1 to assign the TRANSECT_ID to the crane locations. 


Note: These are the NEAR_PROBLEM observations. If there are not any NULLs 


SOP3 is complete, go to SOP4. 


Attributing the near distance problems 


1. Select the NULLs in the joined concate field. 


2. Set the attribute table to show only the selected records for the cranes_mmddyy. 


   
a. Start editing the cranes_mmddyy, and use the drop-down choice for the 


Near_Problem field.  This standardizes the text in the Near_Problem field. 
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b. Save Edits. 


c. Stop Editing. 


d. Open the cranes_mmddyy attribute table, and select “Near Other 


Transects” records in the Near_Problem field. 


e. Set the attribute table to Show selected records again before proceeding. 


f. Confirm that it is only the cranes_mmddyy that has selected records. 


3. Open ArcToolbox>Analysis>Proximity>Generate Near Table.  


a. Input Features = cranes_mmddyy (selected records only) 


b. Near Features = transects_mmddyy (no records should be selected) 


c. Name the output table gen_near_tbl_mmddyy. 


d. Uncheck “Find only closest feature (optional)” 


e. Change 0 to 2 for the “Maximum number of closest matches (optional)” 


Note: Changing 0 to 2 is very important! 
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4. The gen_near_tbl_mmddyy table is showing the closest two transects to a crane 


point.  After the table is created it will appear in the ArcMap table of contents. 


Open the gen_near_tbl_mmddyy table and hide the Object_ID field.  In this table, 


the IN_FID is the OBJECTID from cranes_mmddyy.  The Near_FID is the 


OBJECTID from transects_mmddyy, and the NEAR_DIST is the distance to the 


crane point from the transect in the NEAR_FID.   


5. Remove the join. 


6. Build a concate2 field in both the cranes_mmddyy and gen_near_tbl_mmddyy as 


text, and field length 25. 


7. Calculate the concate2 field as: 


a. In cranes_mmddyy: [OBJECTID] & “ “& [NEAR_FID] 


  
b. In gen_near_tbl_mmddyy: [IN_FID] & “ “ & [NEAR_FID]  
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8. Click on the gen_near_tbl_mmddyy, and join the cranes_mmddyy to it based on 


the concate2.  Keep only matching records. 


Note: The resulting table contains only matching records.  These matching 


records are the ones that need to be deleted (see step 9) because the non-


matching records contain the correct distance measurements. 


9. Start Editing, Select all the records in the gen_near_tbl_mmddyy, and delete the 


records that match from gen_near_tbl_mmddyy.  Save Edits, and Stop Editing. 


Note: This step does not remove all the records from the gen_near_tbl_mmddyy 


as it appears because the join in step 9 is based only on matching records. 


10. Remove the join, and show all the records remaining in gen_near_tbl_mmddyy. 


11. Right-click on the cranes_mmddy, and Join the gen_near_tbl_mmddyy to the 


cranes_mmddyy based on the crane OBJECTID and gen_near_tbl_mmddyy’s IN-


FID, Keep only matching records. 


 
12. Use the field calculator in the cranes_mmddyy to add in the correct NEAR_DIST 


and NEAR_FID. 
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12. Remove the join. 


13. Add a text field called processing_comments to cranes_mmddyy.  Set the field 


length to 50. 


14. Select for the Near Problems. 


15. Update the processing_comments field using the field calculator to reflect the 


corrections to distance measurements made above (i.e., “Updated NEAR_FID & 


NEAR_DIST”). 
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Standard Operating Procedure 4: Creating Text Files for Analyses 
  


UNDERSTANDING THIS DOCUMENT 


 Emboldened terms are commands, tools, or tasks within the referenced software 


programs (i.e., ArcMap 10, ArcCatalog 10, Microsoft Excel 2010, Program R 3.0.1, DNR 


Garmin). 


 Italicized text indicates background information, a filename, or a field name. 


 When filenames have an _mmddyy_ or an _obs1 this would be updated to reflect the date 


the survey was conducted for _mmddyy_, and _obs1 or _obs2 is the observer’s initials. 


 SOP written for a Windows 7 environment. 


  


Once the corrections to the near distance have been made, create two files for export.  These 


files will be for hierarchical distance sampling (HDS_mmddyy) in Program R and conventional 


distance sampling analysis (CDS_mmddyy) in Program Distance. 


Creating the HDS file 


1. Open ArcToolbox>Analysis Tools>Overlay>Intersect. 


a. Input Features = transects_mmddyy and fishnet 


b. Output Feature Class = transects_fishnet_intersect_mmddyy 


c. JoinAttributes = All 


d. XY Tolerance = (Blank) 


e. Output Type = Input 


2. Right-click on transects_fishnet_intersect_mmddyy once it is added to ArcMap, 


click on Properties>Fields tab.  Make only the following fields visible: 


OBJECTID, Shape, TransectID, Stratum, and cell_id. 


3. Add a new field to transects_fishnet_intersect_mmddyy named Length_HDS as 


Double. 


4. Right-click on Length_HDS, and Calculate Geometry set to meters and property 


set to length.  Steps 1–4 results in a linear feature class with cell ids and length of 


transect in each cell. 


5. To create a file with all of the fishnet cells attributed with whooping crane 


detections, Open ArcToolbox>Analysis>Overlay>Spatial Join. 


6. In the Spatial Join Tool: 


a. Target Features = fishnet  


b. Join Features = cranes_mmddyy 


c. Output Feature Class = sj_fishnet_cranes_HDS1_mmddyy 


d. Join Operation = JOIN_ONE_TO_MANY 


e. Keep All Target Features 


f. Match Option = Intersect 
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7. Open the attribute table of the sj_fishnet_cranes_HDS1_mmddyy. 


8. Join the transects_fishnet_intersect_mmddyy to the 


sj_fishnet_cranes_HDS1_mmddyy based on the Cell_ID field. 


 
9. The resulting table should still have the same number of records.  Use the 


Join_Count field to determine which records should have crane values (1) or no 


crane values (0).  Check the cell_ids that should have two or more records; this 


will help you confirm the join was done correctly. 


 
10. Right-click on sj_fishnet_cranes_HDS_mmddyy>Properties>Fields. 
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11. In the Choose which fields will be visible, leave only the Cell_ID, WHITE, 


JUVENILE, UNKNOWN, COMMENTS, Transect_ID, OBSERVER, DATE_, 


Total_Group_Size, NEAR_FID, NEAR_DIST, and Length_HDS fields visible.  


Click OK. 


Note: There will be 2 Cell_ID fields; they contain duplicate data so choose the 


first one. 


12. Export the attribute table created by the spatial join in steps 6–9 as both a 


geodatabase table and a text file.  Both of these will be named HDS_mmddyy.  


The text file will be stored in the Data>Spreadsheets folder, and the geodatabase 


table in the WHCR_SOP_mmddyy.gdb.  Be sure to include .txt in file name when 


saving the text file. 


 


Creating the CDS file 


1. Open the attribute table for transects_mmddyy. 


2. Add a new field named Length_CDS as Double. 


3. Right-click on Length_CDS, and Calculate Geometry set to meters. 


4. Join the transects_fishnet_intersect_mmddyy to fishnet based on the Cell_ID 


field. 


 
5. Open ArcToolbox>Data Management Tools>Generalization>Dissolve: 
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a. Input Features = fishnet 


b. Output Feature Class = fishnet_DisTransects_mmddyy 


c. Dissolve_field(s) = TransectID 


 
6. To create a file with all of the transects attributed with whooping crane detections, 


Open ArcToolbox>Analysis>Overlay>Spatial Join. 


7. In the Spatial Join Tool: 


a. Target Features = fishnet_DisTransects_mmddyy 


b. Join Features = cranes_mmddyy 


c. Output Feature Class = sj_fishnet_cranes_CDS1_mmddyy 


d. Join Operation = JOIN_ONE_TO_MANY 


e. Keep All Target Features 


f. Match Option = Intersect 


8. Open the attribute table of the sj_fishnet_cranes_CDS1_mmddyy. 


9. Join the transects_mmddyy to the sj_fishnet_cranes_CDS1_mmddyy based on the 


TransectID field. 
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10. Right-click on sj_fishnet_cranes_CDS1_mmddyy >Properties>Fields. 


11. In the Choose which fields will be visible, leave only the WHITE, JUVE, UNK, 


COMMENTS, OBSERVER, DATE_, TransectID, Total_Group_Size, NEAR_FID, 


NEAR_DIST, and Length_CDS fields visible.  Click OK. 


Note: Be sure that the TransectID not the Transect_ID field is selected. 


12. Export the attribute table created in step 11 as both a geodatabase table and a text 


file.  Both of these will be named CDS_mmddyy.  The text file will be stored in 


the Data>Spreadsheets folder.  Be sure to include .txt in file name when saving 


the text file. 


  







 


81 


 


Standard Operating Procedure 5: Data Preparation for Hierarchical Distance 
Sampling Analyses using Unmarked 
  


UNDERSTANDING THIS DOCUMENT 


 Emboldened terms are commands, tools, or tasks within the referenced software 


programs (i.e., ArcMap 10, ArcCatalog 10, Microsoft Excel 2010, Program R 3.0.1, DNR 


Garmin). 


 Italicized text indicates background information, a filename, a field name, or a R 


dataframe. 


 Text in Lucidia Console font indicates it is a function, package, library, or a directly 


executable command line (i.e., can be copied and paste into the command prompt in the 


software) in Program R. 


 SOP written for a Windows 7 environment. 


  


Consult Regional Biometrician to determine if the Refuge staff will complete this SOP, or if the 


Regional Office I&M staff will complete this SOP.  Regardless, NWR staff will complete SOP6 


for data archiving. 


Formatting data for hierarchical analysis in Program R 


 SEVEN DATAFRAMES ARE NEEDED TO CONDUCT HIERARCHICAL DISTANCE SAMPLING (HDS) 


ANALYSES USING PACKAGE unmarked 


1. Distance dataframe (DIST): describes the distances to each detected group of 


whooping cranes each fishnet cell surveyed in the primary sampling frame. 


2. Transect lengths dataframe (LENGTHS): contains the total length of transects 


surveyed for each fishnet cell in the primary sampling frame. 


3. Covariate dataframe (COVS): contains descriptive covariates for each fishnet cell 


surveyed in the primary sampling frame. 


4. Planning dataframe (PLANNING): contains descriptive covariates for each fishnet 


cell of a large-scale prediction grid for planning activities. 


5. Group Size by Distance dataframe (DISTGROUP): links the size of each detected 


whooping crane group in the primary sampling frame with the distance at which it 


was detected. 


6. Recruitment dataframe (JUVS): describes whether a group in the primary 


sampling frame contained an adult pair or juvenile(s). 


7. Group Size dataframe (GROUP): contains data about group structure (i.e., 


number of juveniles and adults) for each detected group in the primary sampling 


frame. 


 IMPORTING THE HDS_MMDDYY.TXT FILES INTO PROGRAM R 


1. Copy each HDS_mmddyy.txt file for a survey winter (i.e., winter 2012–2013) into 


a working directory (i.e., c:\...\ 2012-2013\analysis\). 


2. Open Program R using the RStudio interface. 
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3. Set the working directory (optional): 
 
setwd("C:/folder/folder/winter_2012_2013") 


 


4. Load each survey’s data file (i.e., HDS_mmddyy.txt) and name them sequentially 


(e.g., HDS1 through HDS6). 
 
HDS1=read.delim("HDS_121412.txt",header=T,sep=",",na.strings="") 


HDS2=read.delim("HDS_121512.txt",header=T,sep=",",na.strings="") 


HDS3=read.delim("HDS_121712.txt",header=T,sep=",",na.strings="") 


HDS4=read.delim("HDS_121812.txt",header=T,sep=",",na.strings="") 


HDS5=read.delim("HDS_121912.txt",header=T,sep=",",na.strings="") 


HDS6=read.delim("HDS_122212.txt",header=T,sep=",",na.strings="") 


 


5. The date is not populated for each data row in ArcMap.  Use the following code 


to populate each row with the survey date.  Do this for each survey’s dataframe. 
 
HDS1$DATE_=(na.omit(HDS1$DATE_))[1] 


HDS2$DATE_=(na.omit(HDS2$DATE_))[1] 


HDS3$DATE_=(na.omit(HDS3$DATE_))[1] 


HDS4$DATE_=(na.omit(HDS4$DATE_))[1] 


HDS5$DATE_=(na.omit(HDS5$DATE_))[1] 


HDS6$DATE_=(na.omit(HDS6$DATE_))[1] 


 


6. Combine all surveys into one dataframe in Program R. 
 
HDS=rbind(HDS1,HDS2,HDS3,HDS4,HDS5,HDS6) 


 


7. Null-values in numeric fields (i.e., JUVE) are inadvertently converted to zeros by 


ArcMap during the table export (SOP 4).  To correct these values, use the 


following code. 
 
HDS$WHITE[is.na(HDS$TRANSECT_ID)]=NA 


HDS$JUVE[is.na(HDS$TRANSECT_ID)]=NA 


HDS$UNK[is.na(HDS$TRANSECT_ID)]=NA 


HDS$Total_Group_Size[is.na(HDS$TRANSECT_ID)]=NA 


HDS$NEAR_FID[is.na(HDS$TRANSECT_ID)]=NA 


HDS$NEAR_DIST[is.na(HDS$TRANSECT_ID)]=NA 


Note: We are currently using the distsamp function for analyses (see Appendix C–A note 


about generalized HDS).  Therefore, all surveys conducted between 28 November–26 


December will be pooled for analysis. 


 BUILDING THE DATAFRAMES NEEDED FOR DATA ANALYSIS IN PROGRAM R 


1. Create the distance (DIST) dataframe using the following code: 
 
DIST=cbind(HDS$Cell_ID,HDS$NEAR_DIST) 


colnames(DIST)=c("FNID","Dist") 
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DIST=as.data.frame(DIST) 


# Sort DIST dataframe by fishnet id. 


DIST=DIST[with(DIST,order(FNID)),] 


 


Note: Fishnet ID needs to be sorted ascending correctly.  If cell_ids are formated 


as “numeric” sorting will be correct but if cell_ids are formatted as a “factor” 


when they are called into Program R they will not sort correctly (see column E). 


  
2. Create the transect lengths (LENGTHS) dataframe using the following code: 


 
# Get the needed columns from the combined HDS dataframe. 


LENGTHS=cbind(HDS$DATE_,HDS$Cell_ID,HDS$Length_HDS) 


colnames(LENGTHS)=c("occ","FNID","Length") 


LENGTHS=as.data.frame(LENGTHS) 


# Remove duplicate cells for a given survey occasion. 


LENGTHS=unique(LENGTHS) 


# Remove the occasion field. 


LENGTHS=as.data.frame(cbind(LENGTHS$FNID,LENGTHS$Length)) 


colnames(LENGTHS)=c("FNID","Length") 


# Aggregate (sum) transect lengths for each fishnet cell. 


LENGTHS=aggregate(LENGTHS,by=list(LENGTHS$FNID),sum) 


LENGTHS=as.data.frame(cbind(LENGTHS$Group.1,LENGTHS$Length)) 


colnames(LENGTHS)=c("FNID","Length") 


# Sort the LENGTHS dataframe by fishnet id. 


LENGTHS=LENGTHS[with(LENGTHS,order(FNID)),] 


 


3. Import the covariates (COVS) dataframe using the following code (see Appendix 


E for creation of COVS.txt): 
 
COVS=read.delim("COVS.txt",header=T,sep=",", 


  colClasses=c(rep("numeric",3),"factor",rep("numeric",6))) 


COVS=COVS[,c(2,4:10)] 


# Rename the columns of the dataframe. 


names(COVS)=c("FNID","BLOCK","OPENWATER","SALTMARSH", 


  "SALTMARSHSHRUB","UPLAND","URBAN","WETLAND") 


# Sort the COVS dataframe by fishnet id. 


COVS=COVS[with(COVS,order(FNID)),] 


# Make openwater quadratic. 


COVS$OPENWATER2=COVS$OPENWATER^2 


 


4. Import the planning covariates (PLANNING) dataframe using the following code 


(see Appendix E for creation of planning.txt): 
 


Column A Column B Column C Column D Column E


YES YES YES YES NO


1 001 a a01 1


2 002 b a02 10


3 003 c b01 100


4 004 d b02 101
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PLANNING=read.delim("planning.txt",header=T,sep=",", 


  colClasses=c(rep("numeric",7))) 


PLANNING=PLANNING[,c(2,4:9)] 


# Rename the columns of the dataframe. 


names(PLANNING)=c("FNID","OPENWATER","SALTMARSH", 


  "SALTMARSHSHRUB","UPLAND","URBAN","WETLAND") 


# Sort the PLANNING dataframe by fishnet id. 


PLANNING=PLANNING[with(PLANNING,order(FNID)),] 


# Make openwater quadratic. 


PLANNING$OPENWATER2=PLANNING$OPENWATER^2 


 


5. Create the group size by distance (DISTGROUP) dataframe using the following 


code: 
 
DISTGROUP=cbind(HDS$Total_Group_Size,HDS$NEAR_DIST) 


colnames(DISTGROUP)=c("Size","Dist") 


DISTGROUP=as.data.frame(DISTGROUP) 


# Remove NAs from the dataframe. 


DISTGROUP=na.omit(DISTGROUP) 


# Remove observation beyond 500 m from transects. 


DISTGROUP=DISTGROUP[DISTGROUP$Dist<500,] 


 


Note: Only observations made within 500 m of transects will be used to draw 


inference about the whooping crane population.  Therefore, all detections made 


beyond 500 m will be removed from the DISTGROUP dataframe. 


6. Create the recruitment (JUVS) dataframe using the following code: 
 
JUVS=cbind(HDS$WHITE,HDS$JUVE,HDS$NEAR_DIST) 


# Remove NAs from the dataframe. 


JUVS=na.omit(JUVS) 


colnames(JUVS)=c("WHITE","JUVE","Dist") 


JUVS=as.data.frame(JUVS) 


# Remove observation beyond 500 m from transects. 


JUVS=JUVS[JUVS$Dist<500,] 


Juv=JUVS$JUVE>0 


Pair=JUVS$WHITE>1 


Pair=(Juv+Pair)>0 


JUVS=as.data.frame(cbind(Juv,Pair)*1) 


colnames(JUVS)=c("Juv","Pair") 


 


Note: This creates an object where the “Juv” column indicates if the group 


contained a juvenile whooping crane and the “Pair” column indicates if the 


group contained a pair of adult whooping cranes. 


7. Create the group size (GROUP) dataframe using the following code: 
 
GROUP=cbind(HDS$DATE_,HDS$WHITE,HDS$JUVE,HDS$NEAR_DIST) 


colnames(GROUP)=c("occ","AHY","HY","Dist") 
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# Remove NAs from the dataframe. 


GROUP=as.data.frame(na.omit(GROUP)) 


# Remove observation beyond 500 m from transects. 


GROUP=GROUP[GROUP$Dist<500,] 


GROUP=GROUP[,1:3] 


 


8. Load package unmarked. 
 
library("unmarked") 
 


9. Use the function sessionInfo() to store information about the versions of 


packages and libraries used in the analysis. 
 
versions=sessionInfo() 
 


10. Using the function formatDistData, organize the distance data into the 


multinomial format used by hierarchical distance sampling models and package 


unmarked.  At this point the analyst must decide on appropriate distance interval 


cut-points for binning the distance data.  A close examination of a histogram of 


the distance data (hist(DIST$Dist)) will help suggest appropriate cut-points; 


Buckland et al. (2001) also provides recommendations (i.e., binning to help 


reduce spiking around the centerline and to reduce heaping).  All detections 


beyond 500 m will be truncated from the analysis since they are either outside of 


the sampling frame or the plot. 
 
yDat=formatDistData(DIST,distCol="Dist",transectNameCol="FNID", 


  dist.breaks=c(0,100,225,350,500)) 


 


Note: The desired cut-points for the distance bins are specified with dist.breaks. 


11. Once the data is formatted into the multinomial format using the formatDistData 


function, the distance data, covariate data, and transect lengths must be combined 


into one dataframe compatible with package unmarked using the unmarkedFrameDS 


or unmarkedFrameGDS function.  Since we are currently limiting analysis to the 


distsamp function, only the unmarkedFrameDS function will be needed. 
 
umf=unmarkedFrameDS(y=as.matrix(yDat),siteCovs=COVS,survey="line", 


  dist.breaks=c(0,100,225,350,500),tlength=LENGTHS$Length, 


  unitsIn="m") 


# Take a quick look at the umf. 


summary(umf) 


# Check to see if number of detections is correct. 


sum(na.omit(DIST$Dist<=500))==sum(yDat) 


# View first few rows of data. 


umf[1:20] 


# Plot the distance data. 


hist(umf,xlab="distance (m)",main="",cex.lab=0.8,cex.axis=0.8) 
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Note: Sometimes the data may be overdispersed requiring abundance to be 


modeling using the negative binomial distribution.  In order to fit the negative 


binomial, the gdistsamp function must be used and data complied using the 


unmarkedFrameGDS function. 
 
# Make the unmarked dataframe for gdistsamp. 


umfg=unmarkedFrameGDS(y=as.matrix(yDat),siteCovs=COVS, 


  survey="line",dist.breaks=c(0,100,225,350,500), 


  tlength=LENGTHS$Length,numPrimary=1,unitsIn="m") 


 


12. Save the R workspace as HDS_dataframes_yyyy-yyyy.Rdata (e.g., 


HDS_dataframes_2012-2013.Rdata) to the analysis folder. 


 
13. Save the R script as HDS_datascript_yyyy-yyyy.R (e.g., HDS_ datascript_2012-


2013.R) to the analysis folder. 


 
14. More details concerning modeling strategies and data analyses are provided in 


Appendix C. 
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Standard Operating Procedure 6: Data Archiving 
  


UNDERSTANDING THIS DOCUMENT 


 Emboldened terms are commands, tools, or tasks within the referenced software 


programs (i.e., ArcMap 10, ArcCatalog 10, Microsoft Excel 2010, Program R 3.0.1, DNR 


Garmin, SharePoint). 


 Italicized text indicates background information, a filename, or a field name. 


 When filenames have an _mmddyy_ or an _obs1 this would be updated to reflect the date 


the survey was conducted for _mmddyy_, and _obs1 or _obs2 is the observer’s initials. 


 SOP written for a Windows 7 environment. 


  
Daily archiving and backup of survey data 


Once SOPs 1–4 are completed for the daily surveys, the data will be copied over to the 


WHCR Aerial Surveys (TX Coast) SharePoint site to provide an off-site data storage 


location in case a catastrophic event occurs such as server failure or hard-drive failure 


(see Apppendix G for full file structure).  For surveys that included SSF areas those files 


shall be included as well. 


1. For each flight the following files will be saved by date to the primary 


geodatabase, WHCR_SOP_mmddyy.gdb, the spreadsheets or audio folders. 


Observer geodatabases shall be included in the daily back-up.  If SSF areas were 


surveyed those files should be included in the daily back-up.  Intermediate feature 


classes and tables will be included in the WHCR_SOP_mmddyy.gdb for back-up 


as well. 


a. gen_near_tbl_mmddyy (gdb). 


b. survey_mmddyy (gdb). 


c. cranes_mmddyy (gdb). 


d. transects_mmddyy (gdb). 


e. track_mmddyy (gdb). 


f. track_mmddyy.txt (spreadsheets). 


g. CDS_mmddyy (gdb). 


h. HDS_mmddyy (gdb). 


i. CDS_mmddyy.txt (spreadsheets). 


j. HDS_mmddyy.txt (spreadsheets). 


k. SurveyAudio_mmddyy_obs1 (audio). 


l. SurveyAudio_mmddyy_obs2 (audio). 


m. Flight_mmddyy (gdb). 


2. In ArcCatalog, right-click on the WHCR_SOP_mmddyy.gdb>Copy. 


3. Paste the copy, and rename to WHCR_SOP_mmddyy_bu.gdb. 
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4. Repeat steps 2 and 3 for both of the observer geodatabases, renaming these 


geodatabases as WHCR_SOP_mmddyy_obs1_bu.gdb and 


WHCR_SOP_mmddyy_obs2_bu.gdb.  Close ArcCatalog. 


5. In Windows Explorer, browse to WHCR_SOP_mmddyy_bu.gdb, select it and the 


two observer geodatabase back-ups. 


6. Right-click on it and select Send to>Compressed (zipped) file. 


7. All three geodatabases should save into one zip file with the 


WHCR_SOP_mmddyy_bu.gdb.zip name and in the same location. 


8. Browse to the WHCR Aerial Surveys (TX Coast) SharePoint site: 


https://fishnet.fws.doi.net/regions/2/nwrs/IM/WHCR/SitePages/Home.aspx 


9. Under Libraries>Data>WHCR_aerial_surveys_bu, choose the survey year 


folder. 


10. Click on the geodata_bu folder, click the Add document . 


11. Browse to the zipped file in the Upload Document screen. 


 
12. Click OK on the Upload Document screen. 


13. Complete steps 8–10 for the audio files, and spreadsheets as well. 


End of season data archiving 
The end of season archiving will pull all of the features classes and tables into 1 final 


geodatabase, WHCR_SOP_yyyy-yyyy_ServCat.gdb, for upload to SharePoint and 


ServCat. 


1. In ArcCatalog, right-click on WHCR_SOP_yyyy-yyyy_template_ServCat.gdb. 


2. Click Rename. 


3. Rename the geodatabase to the survey year and delete the word “template.”  The 


final name should look similar to WHCR_SOP_2013-2014_ServCat.gdb. 


4. Right-click on the renamed geodatabase from step 3, and choose 


Import>Feature Class (multiple). 


5. In the Feature Class to Geodatabase (multiple) screen for the input features.  


Browse to the multiple WHCR_SOP_mmddyy geodatabases, and choose the 


feature classes (cranes_mmddyy, survey_mmddyy, transects_mmddyy, and 


track_mmddyy).  When choosing multiple feature classes in a geodatabase, click 



https://fishnet.fws.doi.net/regions/2/nwrs/IM/WHCR/SitePages/Home.aspx
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on the first feature class to import, then press the Control key while clicking on 


the remaining feature classes. 


 
6. With the feature classes selected, click Add in the Input Features screen. 


7. To add the other WHCR_SOP_mmddyy geodatabases and their feature classes, 


click on the folder icon beside the Input Features text box in the Feature Class to 


Geodatabase (multiple) screen.  Each of the feature classes and their geodatabase 


will appear in the large box below Input Features. 


 
8. After adding all of the features classes for each survey date, click OK.  The tool 


will take several minutes to process. 


9. Once the tool has completed, review the WHCR_SOP_yyyy-yyyy_ServCat 


geodatabase.  Are all of the feature classes from step 8 included?  The illustration 


provides an idea of how the end product should appear.  Ensure SSF cranes files 


are included for dates when SSF areas were surveyed. 


 
10. Right-click on the WHCR_SOP_yyyy-yyyy_ServCat.gdb>Import>Table 


(multiple). 


11. In the Table to Geodatabase (multiple) screen, add in all of the 


gen_near_tbl_mmddyytables for each survey date. 


12. Once all of the tables have been added, click OK to run the tool. 
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13. Merge flight_mmddyy.dbf  tables from each survey into one flight.dbf table in the 


WHCR_SOP_yyyy-yyyy_ServCat.gdb. 


14. Confirm all the tables where imported into the WHCR_SOP_yyyy-yyyy_ServCat 


geodatabase. 


 Note: If the Refuge created new fishnets/sampling frame this should also be 


included in the ServCat geodatabase.  The Refuge would have contacted the 


Biometrician to confirm a change in the survey design was warranted. 


15. In Windows Explorer, browse to the WHCR_SOP_yyyy-yyyy_ServCat.gdb folder.   


16. Right-click on WHCR_SOP_yyyy-yyyy_ServCat>Send to>Compressed (zipped) 


folder. 


Note: If an error message about permission is received, close ArcCatalog and 


ArcMap, and try step 15 again. 


17. It will appear in the same directory and named similar to WHCR_SOP_yyyy-


yyyy_ServCat.gdb.zip. 


18. On the WHCR Aerial Surveys (TX Coast) SharePoint site under Libraries, click 


on Data>WHCR_aerial_surveys_ServCat. 


19. Click on the survey year folder (e.g., 2013–2014). 


20. Click on the geodata folder. 


21. Click on Add document. 


22. Browse to the zipped geodatabase from step 16, and upload it to the SharePoint. 


23. Click on the audio folder and upload the audio files. 


24. Click on the spreadsheets folder and upload the text files created in SOP 4. 


25. Click on the analysis folder and upload the R Workspace and R Script files 


(upload responsibility depends on who generates these associated files). 


26. Click on the reports folder and upload the update, interim, and comprehensive 


reports (upload responsibility depends on who generates the reports). 


27. After all files have been uploaded to SharePoint, send an email to the I&M 


Regional Data Manager and the I&M Zone Data Manager.  The subject line of 


“WHCR E-O-S SharePoint Upload Complete.”  Include a courtesy copy “cc” to 


the I&M Coordinator, I&M Biometrician, Aransas NWR Supervisory Biologist, 


and the Aransas NWR Refuge Manager.
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Appendix A: Power Analysis of Aerial Whooping Crane 
Abundance Surveys 


Effort and precision 
The following equation was used to determine the number of surveys ( ) needed to achieve a 


target precision for the annual winter abundance estimate (Buckland et al. 2001) 


 


  (
  {  ( ̂)}


 


{   ( ̂)}
 )  ⁄  


 


where    is the total line length flown during the pilot survey,   is the total line length in the 


sample frame,   ( ̂) is the coefficient of variation of the abundance estimate from the pilot 


survey, and    ( ̂) is the target coefficient of variation desired from future survey efforts 


(Buckland et al. 2001). 


 


We used the surveys conducted during January 2012 as our pilot survey effort and estimated the 


number of surveys need to obtain a target    (Table A1). 


 
Table A1.  The number of surveys that need to be conducted in the Primary Sampling Frame to 


obtain a target coefficient of variation for the abundance estimate (   ( ̂)).  Based on data 


collected during winter 2011–2012. 
Number of Surveys ( )


a
    ( ̂) 


1–2 0.200 
2 0.150 
3 0.125 
4–5 0.100 
5–6 0.090 
6–7 0.080 
8–10 0.070 
10–13 0.060 
15–18 0.050 
a
 The number surveys is shown as a range because analysis of the data using hierarchical distance sampling 


models will results in greater precision than analysis with conventional distance sampling.  Therefore, more 
surveys are required with conventional distance sampling to achieve similar precision as hierarchical distance 
sampling. 


 


 


Power: 2-sample z-test 
To compare 2 estimates of abundance obtained from distance sampling-based surveys, a simple 


z-test can be performed (Buckland et al. 2001) 


 


  
( ̂   ̂ )  (      


√   ̂( ̂   ̂ )


  (     


 


where  ̂  and  ̂  are abundance estimates and    ̂( ̂   ̂ ) is the variance of the difference.  


The variance of the difference is easily computed as 
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   ̂( ̂   ̂ )     ̂( ̂ )     ̂( ̂ ) 


 


provided abundances were independently estimated.  Typical output from distance sampling 


software provide coefficients of variation which are 


 


  ( ̂)  
  ( ̂ 


 ̂
 


 


and variance of the abundance estimate is simply estimated as 


 


   ̂( ̂)     ( ̂ 
 
. 


 


We developed an R function to estimate the statistical power (   ) of this z-test (see example 


R Code below; Crawley 2007, R Development Core Team 2012).  We developed 3 power 


analyses to demonstrate the relationships among   ( ̂), percent change in abundance, power, 


and alpha (α; Figures A1–A3). 


 


 


Figure A1.  Power curves for determining the coefficient of variation of abundance estimates 


required to detect a given decline in abundance; based on 1-tailed z-test (       .  The solid line 
represents a 20% decline, the dashed line is a 15% decline, the dot-dashed line is a 10% decline, 
and the dotted line is a 5% decline. 
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Figure A2.  Power curves for determining the coefficient of variation of abundance estimates 
required to detect a given decline in abundance; based on 1-tailed z-test (      .  The solid line 
represents a 20% decline, the dashed line is a 15% decline, the dot-dashed line is a 10% decline, 
and the dotted line is a 5% decline. 


 


Figure A3.  Power curves for determining the coefficient of variation of abundance estimates 


required to detect a given decline in abundance; based on 1-tailed z-test (       .  The solid line 
represents a 20% decline, the dashed line is a 15% decline, the dot-dashed line is a 10% decline, 
and the dotted line is a 5% decline. 
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Power: trends 
Though changes in abundance over 2-year periods do occur, wildlife managers are typically 


more interested in determining population trends.  A simple change from one year to the next is 


part of normal population dynamics, but longer-term trends are more important for conservation 


planning and population management (Thomas et al. 2004).  We used program TRENDS 


(Gerrodette 1987, 1991, 1993; Link and Hatfield 1990) to estimate the   ( ̂) needed to detect a 


population change given          and       (based on a 1-tailed t-test; Table A2). 


 
Table A2.  Estimated precision of abundance estimates (  ( ̂)) required to detect a population 


trend from distance sampling-based aerial surveys for whooping cranes along the Texas gulf 
coast, USA. 


Decline per year 
Annual   ( ̂) required during the period 


3 years 4 years 5 years 6 years 7 years 8 years 9 years 10 years 


  3% 0.01 0.03 0.04 0.06 0.07 0.09 0.12 0.14 


  5% 0.02 0.04 0.07 0.10 0.13 0.17 0.21 0.26 


10% 0.04 0.09 0.16 0.23 0.31 0.41 0.52 0.65 


15% 0.06 0.15 0.26 0.39 0.54 0.70   


20% 0.08 0.22 0.38 0.58 0.72    


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 







 


95 


 


 


Example R code for power analysis of z-test of differences in abundances 
estimated using distance sampling: 
 
# A function to estimate power to detect a change between two abundance estimates 
# using a 1-tailed z-test (Buckland et al. 2001). Where N1 and N2 are the two 
# abundance estimates, change is the desired percent change, CV is the coefficient of 
# variation of the abundance estimates, and alpha is the desired alpha-level. 
 
ZPOWER.1tailed = function(change,N1,CV,alpha){ 


N2=N1+(N1*change) 
SD1=N1*CV 
SD2=N2*CV 
VAR=(SD1^2)+(SD2^2) 
if(change>0) q=qnorm(alpha) 
if(change<0) q=qnorm(1-alpha) 
z=(N1-N2)/sqrt(VAR) 
if(change>0) power=pnorm(q-z) 
if(change<0) power=1-pnorm(q-z) 
cbind(N1,N2,change,CV,SD1,SD2,VAR,q,z,alpha,power)} 


 
changes=seq(-0.2,-0.05,by=0.05) 
N=300 
CVs=seq(0.001,0.15,by=0.001) 
a=0.1 
length1=length(changes) 
length2=length(CVs) 
power.z.1tailed=matrix(,(length1*length2),11) 
colnames(power.z.1tailed)=c("N1","N2","change","CV","SD1","SD2","VAR","q","z","alpha", 


"power") 
for (i in 1:length1) { 


for (j in 1:length2) { 
power.z.1tailed[j+((i-1)*length2),]=ZPOWER.1tailed(changes[i],N,CVs[j],a) 
} 


} 
 
power.z.1tailed=as.data.frame(power.z.1tailed) 
 
# Plot the power curves. 
 
par(cex.lab=1.4) 
par(font.lab=2) 
par(cex.main=1.6) 
par(font.main=2) 
par(cex.axis=1.2) 
par(lwd=3) 
 
plot(power.z.1tailed$CV[power.z.1tailed$change==-0.05], 


power.z.1tailed$power[power.z.1tailed$change==-0.05], 
type="l",lty=3,xlab="CV",ylab="Power",yaxp=c(0,1,10),xaxp=c(0,0.15,15)) 


abline(h=c(seq(0,1,0.1)),lwd=0.1,col="gray") 
abline(v=c(seq(0,0.15,0.01)),lwd=0.1,col="gray") 
lines(power.z.1tailed$CV[power.z.1tailed$change==-0.05], 


power.z.1tailed$power[power.z.1tailed$change==-0.05],lty=3) 
lines(power.z.1tailed$CV[power.z.1tailed$change==power.z.1tailed$change[171]], 


power.z.1tailed$power[power.z.1tailed$change==power.z.1tailed$change[171]], 
lty=2) 


lines(power.z.1tailed$CV[power.z.1tailed$change==-0.1], 
power.z.1tailed$power[power.z.1tailed$change==-0.1],lty=4) 


lines(power.z.1tailed$CV[power.z.1tailed$change==-0.2], 
power.z.1tailed$power[power.z.1tailed$change==-0.2],lty=1) 


 







 


96 


 


Appendix B: Indexing Annual Recruitment of Whooping 
Cranes 


Multiple samples with replacement ratio estimator 
Recruitment of hatch-year (HY) whooping cranes into the wintering population will be indexed 


as the observed ratio of HY to after-hatch-year (AHY) birds from survey flights conducted 


between 28 November–26 December.  Since multiple surveys will be conducted for estimating 


annual abundance on the wintering grounds, the most appropriate estimator of HY:AHY ratio is 


the multiple samples with replacement ratio estimator where each survey represents a sample 


(Skalski et al. 2005). 
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where 


 


 ̂  ⁄  is juvenile:adult ratio (HY:AHY ratio), 


   is the number of juveniles observed during the ith survey (i = 1,…,k), and 


   is the number of adults observed during the ith survey (i = 1,…,k). 


 


The variance of  ̂  ⁄  is estimated as (Skalski et al. 2005:61) 
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where 


 


  ̅ is the average number of adults observed across surveys and 


   is the number of surveys. 


 


The standard error and confidence intervals are estimated as 
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Skalski et al. (2005) noted several assumptions of this estimator.  Assumptions of primary 


concern are equal probability of detection of each age group and the survey period is short 


enough that both age groups have equal probability of survival during the survey period. 


 







 


97 


 


We currently have no evidence suggesting juvenile and adults have differential detection 


probabilities.  Though juveniles are tawny-colored, they are rarely unassociated with adults.  


However, group size-biased detection could skew age-ratios but assuming any differential 


detection remains constant among years, the above estimator is a relative index of the HY:AHY 


ratio and juvenile recruitment into the winter flock. 


 


Single sample ratio estimator 
Only one survey may be completed during optional survey periods during January, February, and 


March.  If only one survey is conducted on the wintering grounds during one of the periods, the 


most appropriate estimator of HY:AHY ratio is the single sample ratio estimator (Skalski et al. 


2005). 
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where 


 


  is the number of juveniles observed during the survey and 


  is the number of adults observed during the survey. 


 


The variance of  ̂  ⁄  is estimated as (Skalski et al. 2005:56) 


 


   ̂( ̂  ⁄ )  
 ̂  ⁄ (   ̂  ⁄ )


 


 
 


  


  
 


 


where  


 


  is the number of whooping cranes observed during the survey. 


 


The standard error and confidence intervals are estimated as above. 
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Appendix C: Data Analysis Using Hierarchical Distance 
Sampling 


Rationale 
Whooping crane monitoring data from the wintering grounds will be analyzed using spatially-


explicit models of abundance which allow wildlife managers and biologists to relate landscape or 


habitat features with whooping crane abundance (Royle et al. 2004, Chandler et al. 2011, Sillet et 


al. 2012).  Though many spatially-explicit models exist (e.g., MacKenzie et al. 2002, Hedley and 


Buckland 2004, Royle et al. 2004, Phillips et al. 2006, Chandler and King 2011, Jarnevich and 


Laubhan 2011), the hierarchical distance sampling (HDS) model of Royle et al. (2004) or the 


generalized HDS model of Chandler et al. (2011) is most appropriate for these survey data. 


 


During the historic survey effort (1950–2010), flight-lines were not recorded nor were 


information regarding which areas were surveyed (Stehn and Taylor 2008).  This oversight by 


previous observers has limited the potential use of spatially-explicit modeling of whooping crane 


occurrence on the landscape.  Though techniques such as maximum entropy modeling (MaxEnt) 


can be used with the historic data to provide spatially-explicit models of historic whooping crane 


occurrence, the convenience-based sampling design (Stehn and Taylor 2008) employed during 


the historic surveys can produce misleading results due to sampling bias (Elith et al. 2011, 


Yackulic et al. 2013). 


 


Further, the use of a convenience-based sampling design and the untenable assumption of 


complete detection mislead stakeholders to believe the historic survey effort was a complete 


census.  A complete census of a wildlife population is rarely, if ever possible (Lancia et al. 


2005).  However, implementation of a repeatable, randomized sampling design that incorporates 


detection probabilities into the estimation of abundance can provide a solid foundation for 


population monitoring and reduce the potential for spurious results (Anderson 2001).  Further, 


the use of advanced techniques such as hierarchical distance sampling will provide simple 


estimates of abundance while advancing our ecological understanding through descriptions of 


how abundance and detectability varies spatially (Royle et al. 2004, Chandler 2011, Chandler et 


al. 2011, Sillet et al. 2012). 


 


Distance sampling is a tractable, widespread approach used to correct for the bias that results 


from imperfect detection (Buckland et al. 2001, Buckland et al. 2004, Thomas et al. 2010).  The 


conventional distance sampling (CDS) paradigm has been limited to a focus on modeling the 


detection function (Buckland et al. 2001, Thomas et al. 2010) and has provided techniques for 


incorporating covariate effects on detection probability (Marques and Buckland 2003, Marques 


and Buckland 2004).  However, wildlife managers and biologists are most interested in 


understanding relationships between abundance and environmental covariates not variation in the 


detection process though accounting for variation in the detection process can improve precision 


of abundance estimates (Thomas et al. 2010).  Recent and concurrent advances in modeling 


techniques have provided new, robust methods for modeling spatial-abundance relationships 


(i.e., spatial distance sampling [SDS], Hedley and Buckland 2004; HDS, Royle et al. 2004). 


The SDS technique is based on an inhomogeneous Poisson point process where parameters 


estimation is often based in a generalized additive modeling (GAM) framework where the 


likelihood is conditioned on detections (Hedley et al. 1999, Hedley and Buckland 2004, Hedley 
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et al. 2004, Katsanevakis 2007).  The SDS techniques are often less tractable when complex 


abundance models are used (Hedley and Buckland 2004, Hedley et al. 2004, Royle et al. 2004).  


In contract, HDS techniques are based on the unconditional likelihood which provides a 


framework for modeling both the detection process and the intensity of abundance where site-


level abundance is the latent variable (Royle et al. 2004, Chandler et al. 2011, Sillet et al. 2012).  


For complex functions, this likelihood appears to be better-behaved (Royle et al. 2004).  Further, 


one of the greatest advantages of the hierarchical modeling framework is the ability to 


simultaneously model the abundance and detection processes.  This allows the effects of a given 


covariate, on either process, to be disentangled (Kéry 2008). 


 


Just as in CDS and SDS, HDS allows modeling of the detection process using a half-normal, 


hazard-rate, negative exponential, or uniform detection function (Chandler 2011).  However, the 


detection process is treated as a multinomial where distances are binned into intervals (Royle et 


al. 2004, Chandler 2011).  Currently, HDS models have been developed that can model 


abundance using a Poisson or negative binomial distribution (Chandler et al. 2011, Fisk and 


Chandler 2011). 


 


The whooping crane survey data will be analyzed using the distsamp or gdistsamp function of 


package unmarked in program R (Fiske and Chandler 2011, R Development Core Team 2012).  


The distsamp function can only fit the multinomial-Poisson mixture model of Royle et al. 


(2004).  However, the generalized HDS model of Chandler et al. (2011), which allows 


abundance to be modeled using a negative binomial, can be fit using the gdistsamp function 


(Sillet et al. 2012).  Chandler (2011) provided an easy to follow description (vignette) to guide 


analyses of distance sampling data using package unmarked.  Provided below are some guidelines 


for data analysis and R code development similar to the style used in the R vignettes.  Step-by-


step directions are not provided because input data requires close examination to ensure it meets 


model assumptions. 


 


Importing and formatting data 
Locate the R workspace and R script (HDS_dataframes_yyyy-yyyy.Rdata and HDS_data_yyyy-


yyyy.R) that were created using SOP 5.  Open them into Rstudio (2012).  There will be 6 


dataframes in the R workspace that are used in data analyses.  The DIST dataframe contains 2 


columns: distance to detection (Dist) and fishnet id (FNID).  The LENGTHS dataframe contains 


2 columns: transect length (Lengths) and FNID.  The COVS file contains a column for each 


covariate and FNID.  Make sure the DIST, LENGTHS, and COVS files are sorted by FNID.  


The FNID is the identity of the 1-km
2
 sampling units (i.e., fishnet cells).  The DISTGROUP 


dataframe contains 2 columns: distance to detection (Dist) and group size (Size).  The JUVS file 


contains 2 indicator variables: group contained at least one juvenile bird (Juv) and group was 


composed on a pair of white birds or contained at least one juvenile (Pair).  The GROUP 


contains 3 columns: survey occasion (occ), number of AHY birds observed (AHY), and number 


of HY birds observed (HY). 


 


To organize the distance data into the multinomial format used by HDS, use the function 


formatDistData.  At this point the analyst must decide on appropriate distance interval cutpoints 


for binning the distance data.  A close examination of a histogram of the distance data 


(hist(DIST$Dist)) will help suggest appropriate cutpoints; Buckland et al. (2001) also provides 







 


100 


 


recommendations (i.e., binning to help reduce spiking around the centerline and to reduce 


heaping).  All detections beyond 500 m will be truncated from the analysis since they are either 


outside of the sampling frame or the plot (SOP 5). 


 
 yDat=formatDistData(DIST,distCol="Dist",transectNameCol="FNID", 


  dist.breaks=c(0,100,225,350,500)) 


 


Once the data is formatted into the multinomial format, the distance data, covariate data, and 


transect lengths must be combined into a data frame compatible with package unmarked using the 


unmarkedFrameDS or unmarkedFrameGDS function (SOP 5). 


 
umf=unmarkedFrameDS(y=as.matrix(yDat),siteCovs=COVS,survey="line", 


  dist.breaks=c(0,100,225,350,500),tlength=LENGTHS$Length,unitsIn="m") 


# Take a quick look at the umf. 


summary(umf) 


# Check to see if number of detections is correct. 


sum(na.omit(DIST$Dist<=500))==sum(yDat) 


# View first few rows of data. 


umf[1:20] 


# Plot the distance data. 


hist(umf,xlab="distance (m)",main="",cex.lab=0.8,cex.axis=0.8) 


 


Modeling strategy 
Model and covariate selection must not be an unthinking process; think about ecologically 


meaningful relationships.  Much “hard thinking” must be conducted a priori to the analysis stage 


(Anderson and Burnham 2002, Burnham and Anderson 2002, Anderson 2008).  Though 4 key 


functions (i.e., half-normal, hazard-rate, negative exponential, or uniform) for modeling the 


detection function are available in package unmarked, Buckland et al. (2001:48) recommended 


not using the negative exponential key function unless distance data are from poorly collected 


data where the distance data are truly spiked at the centerline.  A myriad of factors could 


influence detectability at the observation level (e.g., sun angle, observer, size of the group, age of 


the animal, etc.) or site level (e.g., woody cover or other vegetative conditions).  However, the 


HDS models are only capable of including site level covariates such as habitat conditions 


(Chandler 2011).  A myriad of factors could also influence abundance (e.g., survey region, 


percent saltmarsh, time since prescribed fire, distance to anthropogenic structures, percent open 


water, interactions, etc.).  Once ecologically meaningful covariates are decided upon, 


correlations among those covariates must be examined and highly correlated covariates should 


not be included in the same model to avoid potential multicollinearity problems (Zar 1999, 


Graham 2003).  The analyst could use cor(COVS) to examine correlations; Pearson or Spearman-


rank correlations can be computed with this function.  The analyst ought to examine plots of the 


covariates as well (e.g., boxplot, hist). 


 


To select the best model(s), a two-stage approach is recommended.  First, the analyst should 


focus on modeling the detection function.  Do the “hard thinking” to develop a meaningful a 


priori model set for the detection process.  Fit each model in the a priori model set and select the 


best model(s) based on Akaike’s Information Criterion (AIC; Anderson and Burnham 2002, 


Burnham and Anderson 2002, Anderson 2008).  Models with ΔAIC ≤ 2 are typically considered 
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as competitive models (Anderson 2008), though models with uninformative parameters should 


be excluded (Anderson et al. 2001, Arnold 2010). 


 
# Fit the base detection functions and pick one to use. 


hn=distsamp(~1~1,umf,keyfun="halfnorm",output="density",unitsOut="kmsq") 


haz=distsamp(~1~1,umf,keyfun="hazard",output="density",unitsOut="kmsq") 


unif=distsamp(~1~1,umf,keyfun="uniform",output="density",unitsOut="kmsq") 


expon=distsamp(~1~1,umf,keyfun="exp",output="density",unitsOut="kmsq") 


hn.woody=distsamp(~WOODY~1,umf,keyfun="halfnorm",output="density", 


  unitsOut="kmsq") 


haz.woody=distsamp(~WOODY~1,umf,keyfun="hazard",output="density", 


  unitsOut="kmsq") 


unif.woody=distsamp(~WOODY~1,umf,keyfun="uniform",output="density", 


  unitsOut="kmsq") 


expon.woody=distsamp(~WOODY~1,umf,keyfun="exp",output="density", 


  unitsOut="kmsq") 


# Create a fitList. 


CDS_fitlist=fitList(hn,haz,unif,expon,hn.woody,haz.woody,unif.woody, 


  expon.woody) 


# Rank the models by AIC. 


ms1=modSel(CDS_fitlist) 


# Create a dataframe of the model set's statistics. 


MS1.modelstats=as(ms1,"data.frame") 


 


At this stage, it is good practice to examine detection curves and estimate detection probabilities. 


For example: 


 
# Plot the detection curve with histogram. 


hist(hn) 


# To estimate and plot detection probabilities for a model. 


plot(function(x) gxhn(x,sigma=exp(coef(hn,type="det"))),0,500, 


  xlab="distance",ylab="Detection probability",ylim=c(0,1)) 


# To estimate detection probability between 0 and 500 m. 


det.hn=integrate(gxhn,0,500,sigma=exp(coef(hn,type="det")))$value/500 


 


Once the best detection function or competitive detection functions (including key function and 


covariates) are identified, the analyst should model the abundance process.  Do the “hard 


thinking” to develop a meaningful a priori model set for abundance (include both main effects 


and appropriate interactions).  Fit each model in the a priori model set and select the best model 


based on AIC.  For example: 


 
# Fit the abundance models using the best detection model. 


hn.woody=distsamp(~WOODY~1,umf,keyfun="halfnorm",output="density", 


  unitsOut="kmsq") 


hn.woody_marsh=distsamp(~WOODY~SALTMARSH,umf,keyfun="halfnorm", 


  output="density",unitsOut="kmsq") 


hn.woody_open=distsamp(~WOODY~OPENWATER+OPENWATER2,umf,keyfun="halfnorm", 


  output="density",unitsOut="kmsq") 
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hn.woody_marsh.open=distsamp(~WOODY~SALTMARSH+OPENWATER+OPENWATER2,umf, 


  keyfun="halfnorm",output="density",unitsOut="kmsq") 


# Create a fitList. 


AICfitlist=fitList(hn.woody,hn.woody_marsh,hn.woody_open,hn.woody_marsh.open) 


# Rank the models by AIC. 


ms2=modSel(AICfitlist) 


# Create a dataframe of the model set's statistics. 


MS2.modelstats=as(ms2,"data.frame") 


 


Testing goodness of fit 
Once the best models are identified, goodness of fit for those models should be evaluated using a 


conventional parametric bootstrap procedure (paraboot; Fiske and Chandler 2011).  For 


example, the following code shows a parametric bootstrap for Freeman-Tukey fit statistic (Sillet 


et al. 2012) and Pearson’s χ
2
 (Fiske and Chandler 2011).  Allow ample time to run the goodness 


of fit bootstrap function since it can require >5 hours to complete for some datasets and models.  


If the observed fit statistic lies between the 0.05 and 0.95 percentiles of the bootstrap 


distribution, then the model adequately fits (Krementz et al. 2014). 


 
# Goodness of Fit Analysis function. 


fitstats=function(fm){ 


  observed=getY(fm@data) 


  expected=fitted(fm) 


  resids=residuals(fm) 


  sse=sum(resids^2) 


  chisq=sum(((observed-expected)^2)/expected) 


  freeTuke=sum((sqrt(observed)-sqrt(expected))^2) 


  out=c(SSE=sse,Chisq=chisq,freemanTukey=freeTuke)} 


GOF=parboot(hn.woody_marsh.open,fitstats,nsim=1000,report=2) 


 


If the best models do not fit adequately, consider using the gdistsamp function to refit the best 


models using the negative binomial distribution.  Check the goodness of fit for the best negative 


binomial model. 


 
# Make the unmarked dataframe for gdistsamp. 


umfg=unmarkedFrameGDS(y=as.matrix(yDat),siteCovs=COVS,survey="line", 


  dist.breaks=c(0,100,225,350,500),tlength=LENGTHS$Length, 


  numPrimary=1,unitsIn="m") 


# Refit the best model using gdistsamp with negative binomial specified. Note 


# that detection and abundance formulas appear in different locations in the 


# gdistsamp function than in the distsamp function. 


nb_hn.woody_marsh=gdistsamp(~SALTMARSH,~1,~WOODY,umfg,keyfun="halfnorm", 


  output="density",unitsOut="kmsq",mixture="NB") 


 


Testing for size-biased detection 
Size-biased detection occurs when larger groups have greater detection probability than smaller 


groups (Buckland et al. 2001).  Testing for size-biased detection can be accomplished by 


regressing ln(group size) against detection probability, group size against detection probability, 
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ln(group size) against distance, or group size against distance (Buckland et al. 2001).  Buckland 


et al. (2001) recommends regressing ln(group size) against detection probability. 


 
# Get the detection probabilities by distance. 


gx_hn=gxhn(DISTGROUP$Dist,exp(coef(hn,type="det"))) 


# Regress ln(group size) against detection probability. 


size.bias_hn=lm(log(DISTGROUP$Size)~gx_hn) 


summary(size.bias_hn) 


plot(log(DISTGROUP$Size)~gx_hn) 


 


If a significant (typically α = 0.15 is used) negative slope is found, this suggests larger groups 


tend to be detected at greater distance than smaller ones.  Hence, larger groups are 


overrepresented in the sample resulting in a positive bias in average group size.  If a significant 


positive slope is found, this suggests that observers are underestimating the size of detected 


groups.  Hence, average group size will be biased low if group size is underestimated.  These 


biases, if not corrected, could cause biased abundance estimates.  However, this regression 


technique can provide an unbiased estimate of average group size (Buckland et al. 2001:74). 


 
# If significant at alpha=0.15, use adjusted mean group size. 


adj.group.size_hn=exp(sum(size.bias_hn$coefficients)+ 


  ((1+(1/n)+((1-mean(DISTGROUP$Size))^2)/sum((gx_hn- 


  mean(DISTGROUP$Size))^2))*mean(size.bias_hn$residuals^2))/2) 


 


Abundance estimation 
Estimating abundance using package unmarked is accomplished with the function predict which 


estimates the state variable (i.e., the state variable is abundance or density depending on model 


specification; note, use the lambda variable for the gdistsamp function) for each site.  Remember, 


to maintain independence of detections, detections are recorded as groups of whooping cranes 


not individuals (Buckland et al. 2001).  Therefore, HDS models under this scenario are 


predicting the abundance of groups.  The number of individuals is easily estimated as the 


estimated number of groups multiplied by mean group size.  For example: 


 
# Estimate the number of groups. 


G.hat=sum(predict(hn.woody_marsh.open,type="state")$Predicted) 


# Since each plot is 1 km² and the state variable was density/km² no conversion 


# was needed.  However, if the state variable was density/ha, the predicted 


# values would need to be multiplied by 100 to give group abundance for each 


# site.  Estimate the number of individuals. 


N.hat=G.hat*mean(DISTGROUP$size) 


# If size-biased detection occurred; be sure to use the adjusted group size. 


N.hat=G.hat*adj.group.size_hn 


 


To estimate the uncertainty in abundance estimates, a conventional parametric bootstrap 


approach is used (Chandler 2011).  Allow ample time for the bootstrap function to run. 


 
# Covariate values needed for bootstrap. 


GRID=cbind(rep(1,nrow(COVS)),COVS$SALTMARSH,COVS$OPENWATER,COVS$OPENWATER2) 
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# A function to do parametric bootstrap of total number of groups. Note, if 


# model was fit with gdistsamp then replace "state" with "lambda". 


G.hat.fun=function(fm){ 


  sum(predict(fm,type="state")$Predicted)} 


# Do the bootstrap for the number of groups; it takes a while. 


G.pnb=parboot(hn.woody_marsh.open,G.hat.fun,nsim=1000,report=2) 


plot(G.pnb) 


G.boots=attr(G.pnb,"t.star") 


G.boot.SD=apply(G.boots,2,sd) 


G.boot.CV=G.boot.SD/G.hat 


# Get the 95% CIs for the G.hat. 


CI.G.boot=quantile(G.boots,probs=c(0.025,0.975)) 


 


Below we provide code for a parametric bootstrap of abundance. 


 
# A function to do parametric bootstrap of abundance. 


N.hat.fun=function(fm){ 


  sum(predict(fm,type="state")$Predicted)* 


  mean(sample(DISTGROUP$size,replace=T))} 


# Do the bootstrap for abundance; it takes a while. 


N.pnb=parboot(hn.woody_marsh.open,N.hat.fun,nsim=1000,report=2) 


plot(N.pnb) 


N.boots=attr(N.pnb,"t.star") 


N.boot.SD=apply(N.boots,2,sd) 


N.boot.CV=N.boot.SD/N.hat 


# Get the 95% CIs for the model. 


CI.N.boot=quantile(N.boots,probs=c(0.025,0.975)) 


 


If size-biased detection is found, the parametric bootstrap must be modified. 


 
# A function to do parametric bootstrap of abundance if size-biased detection 


# occurred. 


N.hat.fun=function(fm) { 


  n=length(data$Size) 


  gx=gxexp(data$Dist,exp(coef(fm,type="det"))) 


  model=lm(log(data$Size)~gx) 


  group_size=exp(sum(model$coefficients)+((1+(1/n)+ 


    ((1-mean(data$Size))^2)/sum((gx-mean(data$Size))^2))* 


    mean(model$residuals^2))/2) 


  group_size*sum(predict(fm,type="state")$Predicted)} 


 


Predictions within the sampling frame can be accomplished using the predict function in 


unmarked by providing covariate values. 


 
# Get predicted values for best model. 


Predicted=predict(hn.woody_marsh.open,type="state") 


Predicted$Block=COVS$BLOCK 


Predicted$FNID=COVS$FNID 
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write.table(Predicted,file="predict_PSF.csv",sep=",",qmethod="double") 


 


Model averaging 
Several HDS models could be competitive (i.e., <2 ΔAIC).  Therefore, multimodel inference is 


recommended (Burnham and Anderson 2002).  To model average estimates of abundance, 


simply create a fitList and use it as the object in the predict function: 


 
# Get the competitive models and put them in a fit list. 


bestfitlist=fitList(hn.woody,hn.woody_marsh.open) 


ms.best=modSel(bestfitlist) # Rank them by AIC. 


ms.best.modelstats=as(ms.best,"data.frame") 


# Estimate the number of groups. 


G.hat.Mod.Avg=sum(predict(bestfitlist,type="state"")$Predicted) 


# Estimate the number of individuals. 


N.hat.Mod.Avg=G.hat.Mod.Avg*mean(DISTGROUP$size) 


# Estimate number of individuals for each of the competitive models. 


N.hat.hn.woody=sum(predict(hn.woody, 


  type="state"")$Predicted)*mean(DISTGROUP$size) 


N.hat.hn.woody_marsh.open=sum(predict(hn.woody_marsh.open, 


  type="state"")$Predicted)*mean(DISTGROUP$size) 


 


However, providing an estimate of the variance of model averaged abundance estimates is a little 


more complex because the parboot function only accepts a fitted model, not fit lists.  Just as 


above, the parametric bootstrap approach is used for each of the competitive models.  Once 


parametric bootstrap standard deviations are obtained for model-specific estimates, the simple 


unconditional variance estimator from Burnham and Anderson (2002:162) is used: 
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where         models,  ̅ is the model averaged abundance,  ̂  is the estimated abundance 


for model  , √   ̂( ̂ ) is the bootstrap standard deviation of  ̂ , and   is the AIC weight for 


model  . 
 


# Get the model weights for the competitive models. 


AICwt.hn.woody=ms.best.modelstats$AICwt[2] 


AICwt.hn.woody_marsh.open=ms.best.modelstats$AICwt[1] 


# Do parametric bootstraps for the competitive models. 


Parametric bootstrap code is not shown here (see examples above). 


N.SD.Mod.Ave=(AICwt.hn.woody*(sqrt((N.boot.SD.hn.woody^2)+(N.hat.hn.woody- 


  N.hat.Mod.Avg))))+(AICwt.hn.woody_marsh.open* 


  (sqrt((N.boot.SD.hn.woody_marsh.open^2)+(N.hat.hn.woody_marsh.open- 


  N.hat.Mod.Avg)))) 


N.CV.Mod.Ave=N.SD.Mod.Ave/N.hat.Mod.Ave 
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More on prediction 
Predictions within and beyond the sampling frame can be accomplished using the predict 


function in unmarked by providing covariate values for other areas of interest.  However, caution 


must be used in interpreting such predictions.  Such predictions cannot be used to infer 


abundance or resource use beyond the sampling frame but they could be useful for identifying 


areas likely to be inhabited by whooping cranes in the future (assuming those areas do not 


change).  For example, conservation planning efforts could use these predictions for land 


protection planning purposes or researchers could use them for evaluation of the potential 


impacts of sea level rise.  Prediction is also useful for facilitating plotting of covariate 


relationships (Chandler 2011).  See Appendix E for information about creating a prediction grid 


(i.e., planning.txt) for planning activities. 


 
# Make large-scale predictions. 


Y=cbind(PLANNING$SALTMARSH,PLANNING$OPENWATER,PLANNING$OPENWATER2, 


  PLANNING$WETLAND) 


colnames(Y)=c("SALTMARSH","OPENWATER","OPENWATER2","WETLAND") 


Y=as.data.frame(Y) 


PREDICTED.PLANNING=predict(haz.nb_marsh_wetland_open_km,type="lambda", 


  newdata=Y,appendData=T) 


PREDICTED.PLANNING$FNID=PLANNING$FNID 


# Save the predictions to a table. 


write.table(PREDICTED.PLANNING,file="predict_planning.csv",sep=",", 


  qmethod="double") 


 


Estimating HY:AHY ratio 
Below we provide some example code for estimating the HY:AHY ratio and its variance, 


standard error, and 95% confidence intervals.  More information about formulas are available in 


Appendix B. 
 


# Code for HY:AHY ratio using the multiple samples with replacement ratio 


# estimator (Skalski et al. 2005:61). 


ratio=sum(GROUP$HY)/sum(GROUP$AHY) 


# Compute sums by survey occasion. 


group=aggregate(GROUP[,2:3],by=list(GROUP$occ),sum) 


ratio.var=(sum((group$HY-(ratio*group$AHY))^2))/((length(group$Group.1))* 


  (mean(group$AHY)^2)*(length(group$Group.1)-1)) 


ratio.se=sqrt(ratio.var) 


ratio.cv=ratio.se/ratio 


alpha=0.05 


ratio.LCL=ratio*(exp((qnorm(alpha/2))*(sqrt(ratio.var/(ratio^2))))) 


ratio.UCL=ratio*(exp((qnorm(1-(alpha/2)))*(sqrt(ratio.var/(ratio^2))))) 


 


# Code for HY:AHY ratio using the single sample ratio 


# estimator (Skalski et al. 2005:56). 


ratio=sum(GROUP$HY)/sum(GROUP$AHY) 


ratio.var=(ratio*((1+ratio)^2))/(sum(GROUP$AHY)+sum(GROUP$HY)) 


ratio.se=sqrt(ratio.var) 
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ratio.cv=ratio.se/ratio 


alpha=0.05 


ratio.LCL=ratio*(exp((qnorm(alpha/2))*(sqrt(ratio.var/(ratio^2))))) 


ratio.UCL=ratio*(exp((qnorm(1-(alpha/2)))*(sqrt(ratio.var/(ratio^2))))) 


 


Other estimates 
The International Recovery Plan for whooping cranes (CWS and USFWS 2007) identified the 


number of productive pairs as one metric in which downlisting decisions will be based.  The 


International Recovery Plan defines a productive pair as “a pair that nests regularly and has 


fledged offspring” (USFWS and CWS 2007:xii) and distinguishes productive pairs from 


breeding pairs that are defined as “a pair that breeds or is intended to breed in the future” 


(USFWS and CWS 2007:38).  Regardless of the subjective nature of such definitions, 


identification of productive pairs on the wintering grounds is impossible since some juveniles die 


on the breeding grounds or during migration.  However, the number of whooping crane pairs can 


be estimated based on the proportion of detected groups containing crane pairs.  Also, the 


number of pairs that recruited a juvenile (i.e., recruitive pairs) into the wintering population can 


be estimated based on the proportion of detected groups containing juveniles.  These proportions 


are easily estimated from the data imported from the“JUVS.txt” file. 


 
# Proportion of groups with pairs or juveniles. 


prop.pairs=sum(JUVS$Pair)/length(JUVS$Pair) 


# Number of potential pairs. 


Pairs.hat=G.hat*prop.pairs 


# Proportion of groups with juveniles. 


prop.juv=sum(JUVS$Juv)/length(JUVS$Juv) 


# Number of recruitive pairs. 


Recruit.hat=G.hat*prop.juv 


# Estimate number of HY birds.  This  


N.HY.hat=N.hat*(sum(group[,3])/(sum(group[,2])+sum(group[,3]))) 


 


The uncertainty of these estimates can be estimated using conventional parametric bootstraps 


similar to the ones above. 


 
# A function to do parametric bootstrap of number of pairs. 


Pairs.hat.fun=function(fm){ 


  sum(predict(fm,type="state")$Predicted* 


  (sum(sample(JUVS$Pair,replace=T))/length(JUVS$Pair))} 


# Do the bootstrap for the number of pairs; it takes a while. 


Pairs.pnb=parboot(hn.woody_marsh.open,Pairs.hat.fun,nsim=1000,report=2) 


plot(Pairs.pnb) 


Pairs.boots=attr(Pairs.pnb,"t.star") 


Pairs.boot.SD=apply(Pairs.boots,2,sd) 


Pairs.boot.CV=Pairs.boot.SD/Pairs.hat 


# Get the 95% CIs for the Pairs.hat. 


CI.Pairs.boot=quantile(Pairs.boots,probs=c(0.025,0.975)) 


 


# A function to do parametric bootstrap of number of recruitive pairs. 
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Recruit.hat.fun=function(fm){ 


  sum(predict(fm,type="state")$Predicted* 


  (sum(sample(JUVS$Juv,replace=T))/length(JUVS$Juv))} 


# Do the bootstrap for the number of recruitive pairs; it takes a while. 


Recruit.pnb=parboot(hn.woody_marsh.open,Recruit.hat.fun,nsim=1000,report=2) 


plot(Recruit.pnb) 


Recruit.boots=attr(Recruit.pnb,"t.star") 


Recruit.boot.SD=apply(Recruit.boots,2,sd) 


Recruit.boot.CV=Recruit.boot.SD/Recruit.hat 


# Get the 95% CIs for the Recruit.hat. 


CI.Recruit.Pairs.boot=quantile(Recruit.boots,probs=c(0.025,0.975)) 


 


# Bootstrap the proportion of the population that are HY birds. 


prop.hy=NA 


for (i in 1:1000){ 


  rows=sample(seq(1:length(group$Group.1)),replace=T) 


  prop.hy[i]=sum(group[rows,3])/(sum(group[rows,2])+sum(group[rows,3]))} 


# Bootstrap the number of HY birds. 


N.HY.boots=N.boots*prop.hy 


N.HY.boot.SD=apply(N.HY.boots,2,sd) 


N.HY.boot.CV=N.HY.boot.SD/N.HY.hat 


CI.N.HY.boot=quantile(N.HY.boots,probs=c(0.025,0.975)) 


 


Because some individuals cannot be identified to age-class during the surveys, estimates of the 


number of pairs or the number of recruitive pairs will likely be biased low.  Unfortunately, there 


is currently no way to determine the magnitude of this bias. 


 


A note about generalized HDS 
If repeated surveys are conducted, the generalized HDS model is designed to estimate the 


availability survey objects (Chandler et al. 2011).  This can be used to account for individuals in 


the sampling frame that are not available for detection (i.e., marine mammals that are underwater 


such as whales, fossorial animals that are underground such as prairie dogs), account for 


incomplete detection on the line (i.e., situations where detection is obscured by aircraft type), or 


estimate temporary emigration among sampling units.  However, if temporary emigration and 


incomplete detection (or availability) are both occurring, generalized HDS models cannot 


account for both and will result in estimates with positive bias.  Temporary emigration among 


the 1-km
2
 sampling units (i.e., fishnet cells) seems evident in this whooping crane population.  If 


detection on the line is near 100%, estimates of the number of groups from generalized HDS 


models must be adjusted to account for temporary emigration (Chandler et al. 2011) 


 


 ̂   ̂  ̂  
 


where  ̂  is the estimated number of groups for cell i,  ̂  is the predicted superpopulation that 


uses cell i, and    ̂  is the temporary emigration probability at cell i. 


 


If there is little interest in estimating the probability of temporary emigration, we recommend 


pooling data from repeated surveys and using a model configuration that ignores  ̂ .  However, 
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changes in temporary emigration across years could indicate interesting changes in 


environmental conditions on the wintering grounds or behavioral changes in the population 


which could be of interest to management and conservation of this whooping crane population. 


 


Archiving the analysis 
Once data analyses are complete, the R Script will be saved and stored for future reference (e.g., 


HDS_analysis_script_yyyy-yyyy.R).  Further, the R Workspace, which is the working 


environment of Program R that includes all user-defined objects such as data frames and 


functions, will be saved and stored for future reference (HDS_analysis_dataframes_yyyy-


yyyy.Rdata).  Also, the function sessionInfo() will be used to store information about the 


versions of packages and libraries used in the analysis.  For example, the version of R and all the 


attached packages used in the analysis will be stored with versions=sessionInfo().  All versions 


of packages and libraries used in the analysis will be stored in the saved R Workspace.  
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Appendix D: Generate a Fishnet using Transects in ArcMap 


  


UNDERSTANDING THIS DOCUMENT 


 Emboldened terms are commands, tools, or tasks within the referenced software 


programs (i.e., ArcMap 10, ArcCatalog 10, Microsoft Excel 2010, Program R 3.0.1, DNR 


Garmin, SharePoint). 


 Italicized text indicates background information, a filename, or a field name. 


 Appendix written for a Windows 7 environment 


  


When a fishnet needs to be created, and transects are available the following process will 


generate the fishnet.  These instructions were developed using ArcMap 10 in a Windows 7 


environment.  Data is in meters. 


 


Create fishnet tool 
1. In ArcMap, add the ideal_transects and imagery. 


2. Use the Selection>Select by Attributes to select a transect area like Blackjack or 


Matagorda Island North. 


 
3. Click OK. 


4. Right-click on transects_ideal>Data>Export Data. 


5. Name the output file as transects_area (e.g., transects_blackjack). 


6. Once the data has exported, add it to ArcMap. 


7. Select one of the outer transects from the transects_area. 
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8. On the Editor toolbar, click Editor>Start Editing. 


9. Click Editor>Copy Parallel. 


  
10. In the Copy Parallel screen confirm the following: 


a. Template = transects 


b. Distance = 500 


c. Side = Right or Left depending on the line direction displayed in ArcMap 


d. Corners = Mitered 


e. Place a check in “Treat selection as a single line” and “Create a new feature 


for each selected line.” 


 
11. A new line is created with the same attributes.  Open the attribute table and indicate this 


line is the fishnet in the TRANSECT_ID field, and not one of the transects. 


12. Click on the Editor icon  to open the Editor toolbar. 


13. Click Customize>Customize Mode. 


14. In the Customize screen, click on the Commands tab. 


15. In the Show commands containing: type “continue feature.” 


16. Under Commands, click on the Continue Feature and drag it to the Editor toolbar. 
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17. Editor toolbar>Editor>Start Editing. 


18. Select the fishnet line, and click the Continue Features icon added to the Editor 


toolbar in the previous step. 


19. The End vertex is red and is the direction the line can be extended.  If this is the correct 


direction to extend the line, right-click away from the highlighted line, and choose 


Change Length. 


 
Note: If the line needs to extend using the Start (green) vertex, right-click on the End 


(red) vertex and choose Flip. 


20. The Change Length will only allow a straight line extension.  Extend the line to a 


distance that will match the longest transect. 


21. Right-click and Finish Sketch.  


22. Editor toolbar>Editor>Save Edits and Stop Editing. 
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23. Open the attribute table of the transects, and add four fields: utmX, utmY, midX, and 


midY.  These should be set to field type Double. 


24. On the fishnet line, determine the Start vertex (green) and End vertex (red) of the line.  If 


traveling on the line from the Start vertex to the End vertex which side of the fishnet line 


are the transects located?  Are the transects to the Right of the fishnet line moving from 


the Start vertex to the End vertex?  If the answer is Yes, then use the Start of the line for 


the utmX and utmY in step 26.  If the answer is No, use the End of the line for the utmX 


and utmY in step 26.  Realize the fishnet will be created to the right of the start or end 


vertex of the line, then rotated based on the point calculated for the midX and midY. 


Examples are shown below. 


 


Start and End vertex example. 


 
 


Fishnet created based on the Start vertex, not the required result. 
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Fishnet created from End vertex, expected result. 


 
25. Open the transect_area attribute table and right-click on the utmX field and choose 


Calculate Geometry.  Click OK to the Calculate Geometry warning if it appears. 


 
26. In the Calculate Geometry screen for Property, click the drop-down arrow and choose 


the X Coordinate of Line End if the transects were to the right of the fishnet line traveling 


from the End vertex.  Choose the X Coordinate of Line Start if the transects were to the 


right of the fishnet line traveling from the Start vertex. 
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27. Repeat steps 25 and 26 for utmY, choosing the Y Coordinate. 


28. For the midX and midY repeat steps 25 and 26, choosing the X Coordinate of Midpoint, 


and Y Coordinate of Midpoint respectively. 


29. After calculating the geometry for the additional four fields (utmX, utmY, midX, and 


midY), go to ArcToolbox>Data Management Tools>Feature Class>Create Fishnet. 


30. The Fishnet Origin Coordinate should have the X Coordinate copied from the utmX 


field, and the Y Coordinate copied from the utmY field.  See illustration of steps 30–36 


below step 36. 


31. The Y-Axis Coordinate should have the X Coordinate copied from the midX field, and 


the Y Coordinate copied from the midY field. 


32. In this protocol the Cell Size Width and Height are set to 1,000 m. 


33. The Number of Rows is determined by rounding the length of the longest transect up to 


the nearest 1,000 m (13,967 m to 14,000 m), adding an extra 3,000 m (17,000 m) then 


setting the Number of Rows to 17. 


34. The Number of Columns is determined by the number of features in the transects feature 


class including the fishnet line created from the copy parallel step.  In this example, 8 is 


used for the Number of Columns. 


35. Uncheck the Create Label Points. 


36. Set the Geometry Type to Polygon. 


 
37. Once the proper fishnet is created, it can be edited to remove cells that may be in areas 


that will not be surveyed such as areas of open water 5 km from the shoreline. 


38. Once the fishnet has been edited per the Supervisory Biologist’s specifications, append it 


to the larger fishnet dataset. 


  







 


116 


 


Appendix E: Environmental Covariates Used in Modeling  


  


UNDERSTANDING THIS DOCUMENT 


 Emboldened terms are commands, tools, or tasks within the referenced software 


programs (i.e., ArcMap 10, ArcCatalog 10, Microsoft Excel 2010, Program R 3.0.1, DNR 


Garmin). 


 Italicized text indicates background information, a filename, or a field name. 


 Appendix written for a Windows 7 environment. 


  


Environmental covariates are currently derived from the Texas Ecological Systems 


Classification Project (http://www.tpwd.state.tx.us/gis/gallery/), Phase 3 (Ludeke et al. 2012).  


Spatially-explicit relationships between abundance and vegetative covariates in the hierarchical 


models are based on 6 generalized vegetation types: saltmarsh, open water, wetland, saltmarsh-


shrubland, upland, and urban (Table E1).  Though these covariates are only rudimentary, strong 


relationships with whooping crane abundance has been demonstrated with some of them (Strobel 


et al. 2012).  As additional maps of vegetation layers, other whooping crane resources (i.e., 


salinity, blue crab abundance, etc.), or management actions (i.e., time since prescribed burn, 


fresh water provisioning, etc.) become available and more detailed hypotheses of whooping 


crane abundance relationships are developed, additional environmental covariates will be 


derived and incorporated into the hierarchical models of abundance. 


 


Below we describe how to create the environmental covariates based on the Texas Ecological 


Systems Classification needed for analysis.  Note: Appendix D describes how to create 


prediction grid (i.e., fishnet). 


 


Downloading Texas Ecological Systems Classification (TESC) data 
1. Browse to http://www.tpwd.state.tx.us/gis/gallery/. 


2. Download TESC data (e.g., Phase 3, Phase3_EMST_Vector_20130201.gdb), and 


save to im_surveys\....\WHCR_aerial_surveys\data\yyyy-yyyy\geodata.  Use the 


yyyy-yyyy folder for the year that the environmental covariates are being created. 


3. Unzip TESC data into the covariates folder. 


4. In ArcMap, add the following data from the Phase3_EMST_Vector geodatabase 


Phase3_Central_Objects and Phase3_South_Objects; from the 


Environmental_Covariates geodatabase add big_fishnet_dissolve. 


5. Click on Geoprocessing>Clip, and clipthe Phase3_Central_Objects and the 


Phase3_South_Objects by the big_fishnet_dissolve.  Name the clips 


Phase3_Central_clip and Phase3_South_clip. 


6. Click on Geoprocessing>Merge Phase3_Central_clip and Phase3_South_clip 


and name it Environmental_Covariates.gdb>TESC_Vegetation. 



http://www.tpwd.state.tx.us/gis/gallery/

http://www.tpwd.state.tx.us/gis/gallery/
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Generalizing TESC vegetation classes 
1. TESC vegetation classes are generalized into 6 vegetation types: saltmarsh, open 


water, wetland, saltmarsh-shrubland, upland, and urban. 


2. Table F1 depicts the relationship between the 6 generalized vegetation classes and 


the TESC vegetation types. 


3. Open ArcMap, load Environmental_Covariates.gdb>TESC_Vegetation and open 


its attribute table. 


4. Add a new field named GenVeg as text.  Field length of 50. 


5. Select by Attribute and enter the following: Veg_ID = 9600. 


6. Right-click on GenVeg and select the Field Calculator and enter “open water”, 


click OK. 


7. Select by Attribute and enter the following: Veg_ID = 5600 OR Veg_ID = 5605 


OR Veg_ID = 5607 OR Veg_ID = 5617 OR Veg_ID = 6600 OR Veg_ID = 


6610. 


8. Right-click on GenVeg and select the Field Calculator and enter “saltmarsh”, 


click OK. 


9. Select by Attribute and enter the following: Veg_ID = 9410 OR Veg_ID = 


9411. 


10. Right-click on GenVeg and select the Field Calculator and enter “urban”, click 


OK. 


11. Select by Attribute and enter the following: Veg_ID = 4517 OR Veg_ID = 4617 


OR Veg_ID = 5307 OR Veg_ID = 6407 OR Veg_ID = 6507 OR Veg_ID = 


9007. 


12. Right-click on GenVeg and select the Field Calculator and enter “wetland”, 


click OK. 


13. Select by Attribute and enter the following: Veg_ID=5606 OR Veg_ID=5616. 


14. Right-click on GenVeg and select the Field Calculator and enter “saltmarsh-


shrubland”, click OK. 


15. Select by Attribute and enter the following: GenVeg IS NULL. 


16. Right-click on GenVeg and select the Field Calculator and enter “upland”, 


click OK. 


17. ArcToolbox>Data Management Tools>Generalization>Dissolve 


a. Input feature = TESC_Vegetation 


b. Output feature = Environmental_Covariates.gdb>generalized_vegetation 


c. Dissolve field = GenVeg (allowing multipart features). 


d. Click OK. 


 


Creating a large-scale prediction grid for planning activities  
1. ArcToolbox>Analysis Tools>Overlay>Union to union generalized_vegetation 


with big_fishnet and name output genveg_bigfishnet_union.  Set the XY 
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Tolerance to 1 meter as the TESC data has multiple small slivers.  Confirm there 


is a check in the Gaps Allowed. 


 
2. Open attribute table of genveg_bigfishnet_union. 


3. Select By Attribute and enter the following: FID_generalized_vegetation = -1. 


4. Click on Show Selected Records in the attribute table. 


5. Right-click on GenVeg and select the Field Calculator and enter “open water”, 


click OK.  This categorizes the areas beyond the boundaries of the vegetation 


layer (i.e., areas in the Gulf of Mexico beyond Matagorda beach) as open water. 


6. Clear Selection.  Click on Show All Records in the attribute table. 


7. Add a new field named percent_veg as double. 


8. Right-click on percent_veg and select the Field Calculator and enter 


[Shape_Area]/1000000, click OK. 


9. ArcToolbox>Data Management Tools>Table>Pivot Table 


a. Input Table = genveg_bigfishnet_union 


b. Input Field = FID_big_fishnet 


c. Pivot Field = GenVeg 


d. Value Field = percent_veg 


e. Output Table = Environmental_Covariates.gdb> 


genveg_bigfishnet_union_pivot 


f. Click OK. 


 
10. After creating the pivot table create a table that summarized on the 


FID_big_fishnet; summing each of the genveg classes.  Right-click on the 


FID_big_fishnet column, and choose Summarize. 
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11. In Summarize, under the summary statistics choose Sum for each of the six 


genveg classes (i.e., open_water, salt_marsh, urban, etc.).  Name the output table 


as pivotsum_planning. 


 
12. Compare the number of records in the summary table to the number of records in 


big_fishnet.  These should be the exact same number (i.e., the big_fishnet has 


5,994 records and the sum table should also have 5,994). 
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13. Export the attribute table created by the summarize table in step 11 as a text file 


named planning.txt and save it to the spreadsheets folder. 


 


Creating COVS file for data analysis  
1. ArcToolbox>Analysis Tools>Overlay>Union to union generalized_vegetation 


with fishnet_primary and name output genveg_fishnet_union.  Set the XY 


Tolerance to 1 meter, and confirm there is a check in Gaps Allowed. 


 
2. Open Attribute Table of genveg_fishnet_union. 


3. Select By Attribute and enter the following: FID_fishnet_primary = -1. 


4. Click on Editor>Start Editing>genveg_fishnet_union and delete selected 


records.  This removes all the vegetation polygons that did not overlay the fishnet. 


5. Click on Save Edits and then click on Stop Editing. 


6. Open Attribute Table of genveg_fishnet_union. 


7. Select By Attribute and enter the following: FID_generalized_vegetation = -1. 


8. Click on Show Selected Records in the attribute table. 


9. Right-click on GenVeg and select the Field Calculator and enter “open water”, 


click OK.  This categorizes the areas beyond the boundaries of the vegetation 


layer (i.e., areas in the Gulf of Mexico beyond Matagorda beach) as open water. 


10. Clear Selection.  Click on Show All Records in the attribute table. 


11. Add a new field named percent_veg as double. 
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12. Right-click on percent_veg and select the Field Calculator and enter 


[Shape_Area]/1000000, click OK. 


13. ArcToolbox>Data Management Tools>Table>Pivot Table 


a. Input Table = genveg_fishnet_union 


b. Input Field = Cell_ID and Stratum 


c. Pivot Field = GenVeg 


d. Value Field = percent_veg 


e. Output Table = Environmental_Covariates.gdb> 


genveg_fishnet_union_pivot 


f. Click OK. 


14. Create a summarize table by summing each of the genveg classes with the 


following steps. 


15. Right-click on the Cell_ID column, and choose Summarize. Expand each of the 


genveg classes, and check Sum.  Name this table pivotsum_covs. 


 
16. Open both the pivotsum_covs attribute table and the fishnet_primary attribute 


table.  Compare the number of records each attribute table should have the same 


number of records (i.e., fishnet_primary has 623 records, pivotsum_covs has 623). 


 
17. Export the attribute table created by the summarize table in step 15 as a text file 


named COVS.txt and save it to the spreadsheets folder.  
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Table E1. Generalization of the Texas Ecological Systems Classification scheme into 6 general 
vegetation classes for use in hierarchical distance sampling models. 


Veg_ID Texas Ecological Systems Classification Generalized Class 


9600 Open Water open water 


5600 Coastal: Tidal Flat saltmarsh 


5605 Coastal: Sea Ox-eye Daisy Flats saltmarsh 


5607 Coastal: Salt and Brackish Low Tidal Marsh saltmarsh 


5617 Coastal: Salt and Brackish High Tidal Marsh saltmarsh 


6600 South Texas: Wind Tidal Flats saltmarsh 


6610 South Texas: Algal Flats saltmarsh 


5606 Coastal: Mangrove Shrubland saltmarsh-shrubland 


5616 Coastal: Salt and Brackish High Tidal Shrub Wetland saltmarsh-shrubland 


602 Post Oak Savanna: Live Oak Motte and Woodland upland 


604 Post Oak Savanna: Post Oak Motte and Woodland upland 


605 Post Oak Savanna: Live Oak Shrubland upland 


613 Post Oak Savanna: Post Oak - Yaupon Motte and Woodland upland 


633 Post Oak Savanna: Post Oak - Live Oak Motte and Woodland upland 


2206 Gulf Coast: Salty Prairie Shrubland upland 


2207 Gulf Coast: Salty Prairie upland 


4502 Coastal Bend: Floodplain Live Oak Forest upland 


4503 Coastal Bend: Floodplain Live Oak - Hardwood Forest upland 


4504 Coastal Bend: Floodplain Hardwood Forest upland 


4505 Coastal Bend: Floodplain Evergreen Shrubland upland 


4506 Coastal Bend: Floodplain Deciduous Shrubland upland 


4507 Coastal Bend: Floodplain Grassland upland 


4602 Coastal Bend: Riparian Live Oak Forest upland 


4603 Coastal Bend: Riparian Live Oak - Hardwood Forest upland 


4604 Coastal Bend: Riparian Hardwood Forest upland 


4605 Coastal Bend: Riparian Evergreen Shrubland upland 


4606 Coastal Bend: Riparian Deciduous Shrubland upland 


4607 Coastal Bend: Riparian Grassland upland 


5207 Gulf Coast: Coastal Prairie upland 


6100 Central and Lower Coastal: Beach upland 


6200 Active Sand Dune upland 


6306 Coastal and Sandsheet: Deep Sand Shrubland upland 


6307 Coastal and Sandsheet: Deep Sand Grassland upland 


6402 Coastal and Sandsheet: Deep Sand Live Oak Forest and Woodland upland 


6403 Coastal and Sandsheet: Deep Sand Live Oak - Mesquite Woodland upland 


6405 Coastal and Sandsheet: Deep Sand Live Oak Shrubland upland 


7002 South Texas: Clayey Live Oak Motte and Woodland upland 


7004 South Texas: Clayey Mesquite Mixed Shrubland upland 


7005 South Texas: Clayey Blackbrush Mixed Shrubland upland 


7102 South Texas: Sandy Live Oak Motte and Woodland upland 


7103 South Texas: Sandy Mesquite - Evergreen Woodland upland 


 







 


123 


 


Table E1. Continued. 


Veg_ID Texas Ecological Systems Classification Generalized Class 


7104 South Texas: Sandy Mesquite Woodland and Shrubland upland 


7105 South Texas: Sandy Mesquite Dense Shrubland upland 


7107 South Texas: Sandy Mesquite Savanna Grassland upland 


7907 Coastal Plain: Terrace Sandyland Grassland upland 


9000 Barren upland 


9104 Native Invasive: Deciduous Woodland upland 


9106 Native Invasive: Mesquite Shrubland upland 


9107 Native Invasive: Common Reed upland 


9116 Native Invasive: Baccharis Shrubland upland 


9124 Native Invasive: Huisache Woodland or Shrubland upland 


9204 Non-native Invasive: Saltcedar Shrubland upland 


9214 Non-Native Invasive: Chinese Tallow Forest, Woodland, or Shrubland upland 


9307 Row Crops upland 


9505 Invasive: Evergreen Shrubland upland 


9410 Urban High Intensity urban 


9411 Urban Low Intensity urban 


4517 Coastal Bend: Floodplain Herbaceous Wetland wetland 


4617 Coastal Bend: Riparian Herbaceous Wetland wetland 


5307 Gulf Coast: Coastal Prairie Pondshore wetland 


6407 Coastal and Sandsheet: Deep Sand Live Oak Swale Marsh wetland 


6507 Coastal and Sandsheet: Deep Sand Grassland Swale Marsh wetland 


9007 Marsh wetland 
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Appendix F: Template for Update Reports 


Update reports will be prepared within a few days after each survey and are the responsibility of 


the Lead Biologist with assistance from other observers.  They will provide brief summaries of 


survey activities but will not provide comprehensive results.  These reports will describe the 


flight mission, survey conditions, aircraft used, search effort, who were the observers, and the 


number of detections.  The reports will not provide comprehensive results but are intended as a 


simple permanent record of short-term monitoring activities and survey-specific conditions.  


Since update reports only contain information about raw data and no results, we recommend not 


distributing update reports widely unless absolutely necessary.  This is because raw data from a 


survey where detection of whooping cranes is not 100% can be misleading, misinterpreted, and 


misused.  Below is a template for update reports.  CAPTIALIZED text will be replaced with 


survey-specific details. 


 


All update reports must contain the following disclaimer: 


 


“Data presented in this report are preliminary and results only reflect a summary description of 


the number of whooping cranes and their group structure observed during this survey.  These 


statistics are not to be construed as the annual winter abundance estimate since they have not 


been corrected for incomplete detection.  The findings and conclusions in this article are those of 


the author(s) and do not necessarily represent the views of the U.S. Fish and Wildlife Service.”
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Whooping Crane Survey Summary 
Aransas National Wildlife Refuge 


U.S. Fish and Wildlife Service 


 


 


Report Prepared By: 


 


NAME, TITLE 


AFFILIATION 


 


NAME, TITLE 


AFFILIATION 


 


Survey Date: DD MONTH YYYY 


 


Pilot: NAME, AFFILIATION 


 


Aircraft: MAKE, MODEL 


 


Observers: NAME, AFFILIAITON 


 NAME, AFFILIAITON 


 


Data presented in this report are preliminary and results only reflect a summary 


description of the number of whooping cranes and their group structure observed during 


this survey.  These statistics are not to be construed as the annual winter abundance 


estimate since they have not been corrected for incomplete detection.  The findings and 


conclusions in this article are those of the author(s) and do not necessarily represent the 


views of the U.S. Fish and Wildlife Service. 


 


Flight Mission: EXAMPLES:  “SURVEY ALL TRANSECTS WITHIN PRIMARY 


SAMPLING FRAMES TO ESTIMATE THE NUMBER OF CRANES 


USING THE SAMPLED AREA”, “SURVEY SECONDARY SAMPLING 


FRAMES TO DETECT AND DOCUMENT ADDITIONAL WHOOPING 


CRANE LOCATIONS”, ETC. 


 


Conditions: WIND:  SPEED, DIRECTION, GUSTY/STEADY 


 SKY:  CONDITIONS, VISIBILITY 


 TEMPERATURE 


 


Results: NOTE DIFFERENCES BETWEEN FLIGHT MISSION AND REALIZED 


SURVEY (E.G., MISSION ABORTED DUE TO WEATHER, INCLUSION 


OF ADDITIONAL SAMPLING FRAMES, ETC), DURATION OF 


SURVEY, NUMBER OF CRANES DETECTED, NUMBER OF GROUPS 


DETECTED, ETC. 
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Comments: UNIQUE OBSERVATIONS, LONG-TERM WEATHER CONDITIONS, 


EXPECTED COMPLETION DATE FOR ANALYSES, EXPECTED DATE 


OF NEXT FLIGHT, ETC. 


 


 
Table 1.  Number of whooping crane groups detected by group structure. 


Group structure Number of whooping crane groups detected 


AHY
a
 HY


b
 Primary sampling frame Secondary sampling frame 


1 0 # # 
2 0 # # 
2 1 # # 
2 2 # # 


Other # # 


Total # # 
a
 After Hatch Year whooping crane, full white plumage. 


b
 Hatch Year whooping crane, tawny plumage. 


 


 
Table 2.  Number of whooping crane groups detected by age-class. 
 Number whooping cranes detected 


Age-class Primary sampling frame Secondary sampling frame 


AHY
a
 # # 


HY
b
 # # 


Unknown # # 


Total # # 
a
 After Hatch Year whooping crane, full white plumage. 


b
 Hatch Year whooping crane, tawny plumage. 


 


 
Figure 1. Sampling frames within the whooping crane aerial survey area.  Primary sampling 
frames are denoted with red boundaries while secondary sampling frames are denoted with blue 
boundaries.
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Appendix G: Description of Archived Data Files (Data 
Dictionary) 


Initially, users will download the template geodatabases from the WHCR Aerial Surveys (TX 


Coast) SharePoint site.  These will contain template data for the survey.  They will also contain 


the fishnet (as cells), the dissolved fishnet, and the ideal transects and their endpoints. 


 


The geodatabases have two domains (i.e., drop-down lists) to allow for user selection data 


attributes: 


 


Domain Name: Near_Problem 


Domain Definition: Indicates that the point is closer to an adjacent transect other than the one 


being flown. 


Domain Values: Near Other Transect 


 


Domain Name: Type 


Domain Definition: Observer indicates if a point is an end, start, crane, or error. 


Domain Values: Crane(s), End Transect, ERROR, Start Transect, Off Transect 


 


The two domains above are used in the survey_mmddyy feature classes. 


 


 
Table G1.  The survey_mmddyy feature class has the following attributes. 


Attribute Definition 


OBJECTID Sequential unique whole numbers that are automatically generated. 


SHAPE Coordinates defining the features. 


WHITE Number of white (adult) whooping cranes. 


JUVE Number of juvenile (hatch-year) whooping cranes. 


UNK Number of unknown age whooping cranes. 


COMMENTS Observer’s comments. 


TRANSECT_ID The transect id abbreviation (see Table 1). 


OBSERVER The observer’s initials (use 3 initials). 


ORIGINAL_ID The original OBJECTID from the survey_mmddyy feature class created during the 
flight. 


DATE_ The date of the aerial survey (i.e., MM/DD/YY). 


Type The type of point identifying if the point is the start or end of a transect, an 
accidental click, a whooping crane observation, or an off-transect observation. 


Near_Problem 
 
Total_Group_Size 


Indicates that the point is closer to an adjacent transect other than the one observed 
from.  This is important for correcting the near tool results. 
Calculated from WHITE, JUVE, and UNK in protocol SOP 3. 
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Table G2.  The transects_ideal_primary and transects_ideal_secondary feature classes have the 
following attributes. 


Attribute Definition 


OBJECTID Internal feature number. 


Shape Feature geometry. 


Area Name of the sampling frame. 


Priority Primary or secondary sampling frame. 


TransectNo The number assigned to the transect. 


TransectID Identifies transect by abbreviating the survey area and adding the transect number.  An 
example is WF8 for Welder Flats, number 8 transect (see Table 1). 


Shape_Length Length of feature in internal units. 


 


 
Table G3.  The cranes_mmddyy feature class has the following attributes. 


Attribute Definition 


OBJECTID Sequential unique whole numbers that are automatically generated. 


SHAPE Coordinates defining the features. 


WHITE Number of white (adult) whooping cranes. 


JUVE Number of juvenile (hatch-year) whooping cranes. 


UNK Number of unknown age whooping cranes. 


COMMENTS Observer’s comments. 


TRANSECT_ID The transect id abbreviation (see Table 1). 


OBSERVER The observer initials (use 3 initials). 


ORIGINAL_ID The original OBJECTID from the survey_mmddyy feature class created during the flight. 


DATE_ The date of the aerial survey (i.e., MM/DD/YY). 


Type 
The type of point identifying if the point is the start or end of a transect, an accidental 
click, a whooping crane observation, or an off-transect observation. 


Near_Problem 
Indicates that the point is closer to an adjacent transect other than the one observed 
from.  This is important for correcting the near tool results. 


Total_Group_Size Calculated from WHITE, JUVE, and UNK in protocol SOP. 


NEAR_FID FID of the NEAR Feature Class used with the NEAR tool. 


NEAR_DIST Distance to the cranes from the transect or NEAR feature.   


Concate2 
Field created to help determine correct near feature for updating the near distance 
issues when crane detections are closer to an adjacent transect (SOP3). 
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Table G4.  The CDS_mmddyy file has the following attributes. 


Attribute Definition 


WHITE Number of white (adult) whooping cranes. 


JUVE Number of juvenile (hatch-year) whooping cranes. 


UNK Number of unknown age whooping cranes. 


COMMENTS Observer’s comments. 


TRANSECT_ID Name as initials and number of transect. 


OBSERVER The observer’s initials (use 3 initials). 


DATE_ The date of the aerial survey (i.e., MM/DD/YY). 


Total_Group_Size Calculated from WHITE, JUVE, and UNK in protocol SOP. 


NEAR_FID FID of the NEAR Feature Class used with the NEAR tool. 


NEAR_DIST Distance to the transect from which the detection was observed. 


Length_CDS Length of the CDS transect in meters (total length of each transect). 


   


Table G5.  The HDS_mmddyy has the following attributes. 


Attribute Definition 


Cell_ID Fishnet cell number. 


WHITE Number of white (adult) whooping cranes. 


JUVE Number of juvenile (hatch-year) whooping cranes. 


UNK Number of unknown age whooping cranes. 


COMMENTS Observer’s comments. 


TRANSECT_ID Name as initials and number of transect. 


OBSERVER The observer’s initials (use 3 initials). 


DATE_ The date of the aerial survey (i.e., MM/DD/YY). 


Total_Group_Size Calculated from WHITE, JUVE, and UNK in protocol SOP. 


NEAR_FID FID of the NEAR Feature Class used with the NEAR tool. 


NEAR_DIST Distance to the transect from which the detection was observed. 


Length_HDS Length of the HDS transects in meters (length of transect within each fishnet cell). 


   


Table G6.  The gen_near_tbl_mmddyy has the following attributes. 


Attribute Definition 


OBJECTID Sequential unique whole numbers that are automatically generated. 


IN_FID The IN features OBJECTID.  In SOP3, this is from the cranes_mmddyy. 


NEAR_FID The NEAR features OBJECTID.  In SOP3, this is from the transects_mmddyy. 


NEAR_DIST Distance calculated from a near feature. 


Concate2 Field created to help determine correct near feature for updating the near distance 
issues when crane detections are closer to an adjacent transect (SOP3). 
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Table G7.  The transects_mmddyy has the following attributes. 


Attribute Definition 


OBJECTID Sequential unique whole numbers that are automatically generated. 


SHAPE Coordinates defining the features. 


TYPE From DNR Garmin. 


IDENT From DNR Garmin. 


Transect_id The transect name as initials and number (SOP3). 


Area NWR name for stratum. 


Shape_Length Length of feature in internal units 


   


Table G8.  The flight_mmddyy file has the following attributes. 


Attribute Definition 


OBJECTID Sequential unique whole numbers that are automatically generated. 


Date The date of the aerial survey (i.e., MM/DD/YY). 


WindSpd Wind speed. 


WindDir Wind direction. 


SkyCond Sky condition. 


VisibMi Visibility in miles. 


TempF Air temperature in Fahrenheit. 


Aircraft The type of aircraft used in the survey. 


NamePilot Name of the pilot. 


NameObs1 Name of 1
st
 observer. 


NameObs2 Name of 2
nd


 observer. 


SeatObs1 Observer in seat 1. 


SeatObs2 Observer in seat 2. 


Comments User generated comments. 


   


Table G9.  The fishnet_primary and fishnet_secondary feature classes have the following 
attributes. 


Attribute Definition 


OBJECTID Sequential unique whole numbers that are automatically generated. 


SHAPE Coordinates defining the features. 


Stratum NWR name for the area. 


Cell_ID Fishnet cell number. 


Priority Primary or secondary flight area. 


Shape_Length Length of feature in internal units. 


Shape_Area Area of feature in internal units. 
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After post-processing the data, the following objects should exist within the 


WHCR_SOP_mmddyy geodatabase, spreadsheets, and audio folders: 


• survey_mmddyy (point feature class) 


• cranes_mmddyy (point feature class) 


• transects_mmddyy (line feature class) 


• gen_near_tbl_mmddyy (database table) 


• track_mmddyy (line feature class) 


• CDS_mmddyy (database table) 


• CDS_mmddyy.txt (spreadsheets) 


• HDS_mmddyy (database table) 


• HDS_mmddyy.txt (spreadsheets) 


• SurveyAudio_mmddyy_obs1 (audio) 


• track_mmddyy.txt (spreadsheets) 


 


The fishnets and ideal transects will remain in the WHCR_SOP_mmddyy geodatabase.  If the 


Refuge made changes to the fishnets or transects, the Biometrician and Regional Data Manager 


should have been consulted to account for survey design issues and archiving those datasets, 


respectively. 


 


Observer geodatabases will be backed-up to the SharePoint, but will not be included in the final 


upload to ServCat.  
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Appendix H: Permission Levels and Requests 


There are 3 digital locations discussed in this document: the Aransas NWR server, WHCR Aerial 


Surveys (TX Coast) SharePoint site, and Service Catalog (ServCat).  Aransas NWR is an Active 


Directory site, and one of the few Region 2 refuges with a server for data storage.  Given that 


most refuges in Region 2 do not have a server for data storage, past survey data is stored on 


individual computers at refuges.  In 2012, the USFWS’s Service Catalog or ServCat became 


available, and was built to “increase accessibility of natural resource inventory and monitoring 


information to managers and biologists engaged in planning, management, and decision-making” 


(USFWS 2012b).     


Given the decentralized IT environment, when I&M protocols are developed, Region 2 is 


creating survey specific SharePoint sites with unique permissions for the following reasons:  


1. Provide a duplicate site for survey data. 


2. Restrict survey data access until deemed ServCat ready by the PI or Supervisory 


Biologist of the I&M survey per the I&M protocol.   


3. Facilitate a survey data staging area where the regional data management team can 


upload the survey data to ServCat reducing the data management workload for the 


NWRs. 


4. Ensuring standardization of ServCat metadata to facilitate better search results for 


USFWS staff using ServCat. 


 


SharePoint permission levels 
For this Whooping Crane Winter Abundance Survey, a SharePoint site named “WHCR Aerial 


Surveys (TX Coast)” has been created.  The permission levels to this site are set to unique as it 


does not inherit permissions from the Region 2 I&M SharePoint site.   


Table H1.  List of groups and users with access to the WHCR Aerial Surveys SharePoint site. 


SharePoint Group/User Permission Level Who is included  


Inventory and Monitoring Owners Limited Access R2 I&M Coordinator & R2 I&M 
Regional Data Manager 


R2 Inventory and Monitoring Owners Full Control R2 I&M Coordinator & R2 I&M 
Regional Data Manager 


R2_IM_WHCR Contribute Authorized USFWS Users 


R2 Regional Data Manager Limited Access R2 I&M Regional Data Manger 


System Account (SHAREPOINT\system) Limited Access SharePoint System Administrators  


 


Requesting access to the WHCR Aerial Surveys SharePoint 
For the initial population of the R2_IM_WHCR group, which has Contribute permission to this 


site, the Aransas NWR Supervisory Biologist, Refuge Manager, or the I&M Coordinator will 


email the I&M Regional Data Manager the names of the USFWS employees who should access 


the site.  The subject line shall be “WHCR SP Access.”  The email shall be courtesy copied “cc” 


to the Aransas NWR Supervisory Biologist, Aransas NWR Refuge Manager, I&M Coordinator, 


and the I&M Regional Data Manager regardless of who sends it. 
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The WHCR Aerial Surveys SharePoint site is set-up to allow requests to join or leave the 


R2_IM_WHCR group.  SharePoint 2010 allows only one email address to be entered for sending 


the join/leave requests.  The I&M Regional Data Manager’s email address will receive the email.  


The I&M Regional Data Manager will forward the email to the Aransas NWR Supervisory 


Biologist and the I&M Coordinator for approval.  The Aransas NWR Refuge Manager will be in 


the “cc” line of the email.  For these approvals, when replying to the I&M Regional Data 


Manager the reply to all should be used.  Once the I&M Regional Data Manager receives 


confirmation of approval, the user request will be approved. 


SharePoint information for the Regional I&M Data Management Team 
Use the Site Settings>Site Permissions>R2_IM_WHCR>Settings>Group Settings to change the 


email address able to receive these permission requests from the SharePoint site. 


When an email is received from the Supervisory Biologist or the I&M Coordinator to add or 


remove users from the R2_IM_WHCR group, the Site Actions>Site Permissions should be used.  


Click on the R2_IM_WHCR group, and choose to add a new user or remove users from the 


group. 


When there is an I&M Zone Data Manager for the Texas Gulf Coast, that position will receive 


these email requests and shall follow this process and include the I&M Regional Data Manager 


on all correspondence. 


ServCat permission levels 
ServCat allows for a Sensitivity Evaluation, Proprietary Evaluation, Quality Evaluation, and Use 


Constraints.  The ServCat record for this data will be set as: 


Sensitivity Evaluation: Sensitive with the Endangered Option 


Proprietary Evaluation: Non-Proprietary 


Quality Evaluation: High 


Use Constraints: Restricted open to I&M Coordinator, Biometrician, Aransas NWR Biologist, 


WHCR Coordinator  
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Appendix I: Downloading Template Data from SharePoint 


  


UNDERSTANDING THIS DOCUMENT 


 Emboldened terms are commands, tools, or tasks within the referenced software 


programs (i.e., ArcMap 10, ArcCatalog 10, Microsoft Excel 2010, Program R 3.0.1, DNR 


Garmin, SharePoint). 


 Italicized text indicates background information, a filename, or a field name. 


 Appendix written for a Windows 7 environment 


  


End users should already have the im_surveys directory structure on their server, computer, 


and/or external drive.  If this directory structure is not present, go to the I&M SharePoint site 


and download the im_surveys zip file: 


https://fishnet.fws.doi.net/regions/2/nwrs/IM/DMGISIT/Data Management/Forms/AllItems.aspx  


1. Ensure the file directory structure for I&M Surveys called im_surveys.zip is 


unzipped, and present on the computer or server as im_surveys folder. 


 



https://fishnet.fws.doi.net/regions/2/nwrs/IM/DMGISIT/Data%20Management/Forms/AllItems.aspx
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2. In the im_surveys folder, go to at_risk_biota>birds. 


 
3. Right-click on and copy the survey_name folder. 


4. Paste it in the same directory of birds. 


5. Right-click on the copy and rename it WHCR_aerial_surveys. 


6. Click on the WHCR_aerial_surveys folder>data. 


7. Right-click on the yyyy-yyyy, copy and paste it in the same 


WHCR_aerial_surveys folder. 


8. Rename it to the current survey year (e.g., 2012-2013 or 2013-2014). 


9. Browse to the SharePoint site at: 


https://fishnet.fws.doi.net/regions/2/nwrs/IM/WHCR/SitePages/Home.aspx 


10. Click on Data>SOP_templates. 


11. Download the zip file and save to 


im_surveys>at_risk_biota>birds>WHCR_aerial_surveys>data>yyyy-


yyyy>RO_templates. 


Note: yyyy-yyyy is the current survey year. 


12. In RO_templates, extract all from the zip files.  There will be 5 geodatabase 


templates. 


13. In ArcCatalog, copy the 5 geodatabases from the RO_templates into the 


im_surveys>at_risk_biota>birds>WHCR_aerial_surveys>data>yyyy-


yyyy>geodata folder. 


14. These are now the working databases.



https://fishnet.fws.doi.net/regions/2/nwrs/IM/WHCR/SitePages/Home.aspx
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Appendix J: Promoting a Secondary Sample Frame (SSF) to 
a Primary Sample Frame (PSF) 


  


UNDERSTANDING THIS DOCUMENT 


 Emboldened terms are commands, tools, or tasks within the referenced software 


programs (i.e., ArcMap 10, ArcCatalog 10, Microsoft Excel 2010, Program R 3.0.1, DNR 


Garmin, SharePoint). 


 Italicized text indicates background information, a filename, or a field name. 


 Appendix written for a Windows 7 environment 


  


The terms “fishnet” and “sampling frame” are used interchangeably throughout this protocol as 


“fishnet” is a geospatial term and tool used to create a “sampling frame.”  When enough 


whooping crane groups are detected (see Element 3–Sampling frame–Sampling Objective 5; 


Table 2) at least twice in a SSF region between 28 November–26 December, it may be time to 


promote the SSF region to the PSF fishnet feature class, fishnet_primary.  Ideally, a protocol 


user should contact the regional data management team to complete these steps and update the 


WHCR Aerial Surveys (TX Coast) SharePoint site with the revised files, and update ServCat.  


Send an email to the Regional Data Manager and the Zone Data Manager with a subject of: 


WHCR_PROTOCOL_request.  If an end user must promote these files follow the steps below, 


and contact the regional data management team with the updated files so both the SharePoint 


site and ServCat can be updated as well. 


 


1. Make a copy of the WHCR_SOP_mmddyy_template geodatabase.  


2. From the copied geodatabase, add fishnet_primary and fishnet_secondary fishnets 


to ArcMap. 


3. Using the selection tools, select the SSF that will be promoted. 


4. Right-click on fishnet_secondary and click on Data>Export Data, name the file 


ssf_promote_mmddyy. 


5. Add ssf_promote_mmddyy to ArcMap. 


6. Open ArcToolbox>Data Management Tools>General>Append. 


 
7. The Input Dataset is ssf_promote_mmddyy. 


8. The Target Dataset is fishnet_primary. 


9. Set the Schema Type to TEST. 


10. Repeat steps 1–9 for promoting the transects as well. 
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Appendix K: Pre-flight GPS Unit Set-up 


  


UNDERSTANDING THIS DOCUMENT 


 This appendix is for use with SOP1. 


 Emboldened terms are commands, tools, or tasks within the referenced software 


programs (i.e., ArcMap 10, ArcCatalog 10, Microsoft Excel 2010, Program R 2.15.0, 


DNR Garmin, SharePoint, GPSinfo). 


 Italicized text indicates background information, a filename, or a field name. 


 Appendix written for a Windows 7 environment 


  


GPS technology rapidly changes. The Refuge may find a lighter weight GPS solution for the in-


flight survey.  Therefore, the pre-flight GPS set-up is included as an Appendix to facilitate easier 


changes to this protocol.  This appendix shall be used with SOP1 at steps 12-16. The screenshots 


and text for this Appendix were provided by Refuge Biologist, Diana Iriarte.  When the Refuge 


changes GPS solutions the Refuge Biologist will provide an update to this Appendix. In winter 


2012–2013, the Refuge used two GSAT GPS units attached to the laptops for on-screen GPS in 


ArcMap, and two Garmin GPS units are the redundant, handheld GPS units. 


 


Bluetooth Pairing of the GSAT GPS Unit 
1. The GPS device used with the inflight laptop is a Bluetooth GPS Receiver (BT-


359) made by GlobalSat.  This GPS device allows each observer to display their 


current location within ArcMap. 


2. To pair the GPS device with the computer for the first time, go to bluetooth 


settings and click on New Connection. 


 
3. Be sure to select Custom Mode so that you can select the COM port you want to 


use.  Select Next. 


 
4. The computer will search for Bluetooth devices. 
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5. Click next after the GPS device has been detected. 


 
6. The computer will connect to the GSAT GPS unit. 


 
7. Choose a service. 


 
8. Uncheck the Use default COM port. 


 
9. Click OK to the default setting warning. 
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10. Select a COM port between 1 and 10.  Some software may not allow COM ports 


greater than 10. 


 
11. The setting of the COM port will display. 


 
12. Choose a connection name or accept the default name. 


 
13. Click Finish. 
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Connecting the GSAT GPS to the Computer for Use in ArcMap 
1. Go to computer’s bluetooth manager and open bluetooth settings.  If device has 


already been paired with computer then just double click on icon for device. 


 
2. Icon changes when successful detection of bluetooth GPS device. 


 
3. Open GPSinfo software.  This software came with GPS device which is a 


Bluetooth GPS Receiver (BT-359) made by GlobalSat.  The COM port will be 


determined during initial Bluetooth Device Pairing.  If you do not remember the 


COM port then click on Scan Com Port. 


 
4. After COM port has been selected click on Start GPS. 


 
5. After GPS has been started, close out of the GPSinfo window by clicking on the 


red X.  This GPS will still be running. 
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6. In the whcr_mmddyy_obs1.mxd map go the GPS toolbar and click on GPS 


Connection Setup. 


 
7. Select the same COM port used for bluetooth device pairing in GPSinfo.  Then 


click on Detect GPS Port. 


 
8. After the GPS port has been connected, click on Test Connection. 


 
9. After successful test connection, click OK and then click OK on GPS Connection 


Setup window. 
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10. Click on the Open Connection icon on the GPS toolbar in ArcMap. 


 
11. Click OK to the warning message. 


 
12. The map should now pan to your location and show a black arrow. 
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